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Chapter 1. Getting Started Guide

Overview of Historian

Proficy Historian is a high-performance data archiving system designed to collect, store, and retrieve time-
based information at an extremely high speed. The following diagram shows an HMI or an OPC server

from which data is collected and stored in Historian.

I ' _m Plant E
X Historian

EQUIPMENT PLC/RTU/IO
QUIPMEN LC/RTU/I HMI/UCC

You can collect data from multiple SCADA systems and various applications, and store them in a central

Proficy Historian server.
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You can then use various clients to fetch and analyze this data.
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Historian contains the following main components:

- Data collectors: Collect and analyze the tag data.
- The Historian server: Stores tag data.

« Clients: Retrieve tag data from the Historian server using APlIs.

For information on how these components work in a Historian system, refer to System Architecture (on

page 8).

Data Collectors

Collectors are applications that collect data from a wide variety of applications such as iFIX,
CIMPLICITY, OPC servers, 0SI PI, and text files (.csv or .xml). This data is then stored in the

Historian server.

In addition, Historian contains the Calculation and the Server-to-Server collectors. The

Calculation collector performs calculations and analyses on Historian data and stores

the results in tags on the server. The Server-to-Server collector has the same calculation

capabilities as the Calculation collector, but it stores the results in tags on a remote server.
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Most collectors can perform first-order deadband compression, a browse-and-add

configuration, and store and forward buffering.

(L ™
Note:
Standard collectors that are included as part of the product will not consume a
client-access license (CAL). Other interfaces developed by customers or system
integrators using the Collector Toolkit or APIs will consume a CAL for each instance

or connection.
N /

Bi-Modal Collectors:

The Historian data collectors can send data to an on-premises Historian server as well as
cloud destinations such as Google Cloud, Azure loT Hub, AWS Cloud, and Predix Cloud.
Therefore, these collectors are called bi-modal collectors. The following collectors, however,

are not bi-modal collectors; they can send data only to an on-premises Historian server:

* The Calculation collector

« The File collector

» The HAB collector

- The iFIX Alarms and Events collector

» The OPC Classic Alarms and Events collector
« The OSI PI Distributor

* The Python collector

» The Server-to-Server distributor

The Historian Server

The Historian server is the central point for managing all of the client and collector

interfaces, storing data and (optionally) compressing and retrieving data.

In the Historian server, data is stored in files called data archives. These files contain all the
tag data gathered during a specific period of time (for example, time-based archives such as
daily archives). They have the .iha extension.

You can store data of various data types such as Float, Integer, String, Byte, Boolean, Scaled,
and binary large object data type (BLOB). The source of the data defines the ability of
Historian to collect specific data types. If you have the license to store the alarms and
events data, the server also manages the storage and retrieval of OPC Alarms and Events in

a SQL Server Express.
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You can further segregate your tags and archives into data stores. A data store is a logical
collection of tags used to store, organize, and manage tags according to the data source
and storage requirements. A data store can have multiple data archives, and includes logical
and physical storage definitions.

The primary use of data stores is segregating tags by data collection intervals. For example,
you can put name plate or static tags where the value rarely changes in one data store, and
put process tags in another data store. This can improve the query performance.

The Historian Data Archiver is a service that indexes all the data by tag name and
timestamp and stores the result in an .iha file. The tag name is a unique identifier for a tag
(which is a specific measurement attribute). For iFIX users, a Historian tag name normally
represents a Node.Tag.Field (NTF). Searching by the tag name and time range is a common
and convenient way to retrieve data from Historian. If you use this technique to retrieve data
from the archive files, you need not know which archive file contains the data. You can also
retrieve data using a filter tag.

Clients

Clients are applications that retrieve data from the archive files using the Historian API.
The Historian APl is a client/server programming interface that maintains connectivity to
the Historian Server and provides functions for data storage and retrieval in a distributed

network environment.

System Architecture

Standard or Stand-Alone Historian Architecture:

In this type of system, there is a single Historian server. It offers the following unique capabilities and

benefits for a sustainable competitive advantage:

« Built-in data collection
« Good read/write performance speed
 Enhanced data security

The following image shows the architecture of a stand-alone Historian system (single server):
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In addition to the capabilities of a stand-alone Historian system, a horizontally scalable one offers data
redundancy and high availability. You can have mirroring of stored data on multiple nodes to provide high

levels of data reliability. Data mirroring also involves the simultaneous action of every insert, update, and

delete operations that occur on any node. You can spread the data collection, server, administration, and

client data retrieval functions across vari

ous nodes.
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In a typical data mirroring scenario, one server acts as a primary server to which the clients connect. To
create a mirror, you must add mirror nodes and establish a data mirroring session relationship between
the server instances. All communication goes through Client Manager, and each Client Manager knows
about the others.

When a client (either a writing collector or reading client) connects to the Client Manager, it gathers
information about each Client Manager, along with all archive, tag, and collector configuration
information, from the Configuration Manager, and stores this information locally in its Windows Registry.

A relationship is then established between each remote client and a single Client Manager, which directs
read and write requests across the other mirrors. If that relationship is broken, it will establish a new
relationship with the next available Client Manager, which assumes the same responsibilities. This bond
is maintained until that Client Manager is unavailable, and then the process of establishing a relationship
with another Client Manager is repeated.

When more than one node is running, the Client Manager uses a "round robin" method between the good
nodes to balance read loads. Each read request is handled by a node as a complete request.

Writes are sent independently but nearly simultaneously to any available data archiver so that the same
tag shares a common GUID, name, timestamp, value, and quality as passed to it by the collector.
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The following diagram shows the architecture of a horizontally scalable Historian system.
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System Components

A typical Historian system contains components for the following functions:

« Data collection/migration

 Data storage

- Data management, analysis, and monitoring
« Data retrieval

All these components communicate with the Historian server through the Historian API. This topic
describes the functions performed by each component.

Data Collection/Migration Components

Data collection/migration components are used to collect data from various sources and ingest the data
into a Historian server (or to cloud). The following data collection/migration tools are used in Historian:

Data Collectors

Data collectors gather data from a data source based on a schedule or an event, process it,
and forward it to the Historian server or a web socket for archiving. The following collector
functions are common across all types of collectors (except the File collector):

- Automatically discovering available tags from a data source and presenting them to
Historian Administrator and Configuration Hub.

« Providing options to send data to an on-premises Historian server or to cloud through
a web socket connection

« Performing a first-level of data compression (collector compression).

- Responding to control requests, such as requests to pause or resume data collection.

- Maintaining a local cache of tag information to sustain collection while the server
connection is down.

« Buffering data during loss of connection to the server and forwarding it to the server
when the connection is restored.

- Optionally, automatically adjusting timestamps for synchronizing collector and
archiver timestamps.

- Supporting the timestamp of both the collector and the device, as applicable.

« Scheduling data polling for a polled collection.

For mission-critical data collection, you can set up redundant collectors. Historian includes a
mirroring option for high availability and load balancing, so the data is available all the time.
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The File Collector

A File collector imports .csv and .xml files into the Historian server. These files can contain
data, alarms, tag names, or other configuration information, and messages that you can
import with a File collector.

The Extract, Transform, and Load Tools

Transferring data from one Historian server to another is typically performed by the data
collectors. These tools provide a connected streaming data transfer mechanism (except
the calculation and file transfer collectors). In a system where a steady network connection
is not possible or not cost-effective, a periodic file-oriented data transfer is preferred. The
Historian ETL tools consist of a comprehensive set of file-oriented data extraction, transfer,

and loading tools.
Migration Tools

Migration tools are used to migrate existing Historian configuration and data and iFIX
Alarms and Events collector data to the Historian server. Tags, collection rates, and

deadbands for tags configured in Historian can be transferred by the migration tools.
The Collector Toolkit

Collector Toolkit is used to develop a customized collector. You can use Collector Toolkit
to write programs that integrate with Historian and leverage the same configuration
tools, redundancy schemes, and health monitoring as the collectors. It collects data and
messages from a data source and writes them to a data archiver. Each deployment of a
collector developed on the Collector Toolkit consumes a client access license (CAL).

Data Storage, Analysis, and Maintenance Components
Data collected by the collection/migration components is stored in the Historian server (or cloud). You
can then analyze and maintain the data using the following components:

Historian Alarms and Events

Historian Alarms and Events provides tools to collect, archive, and retrieve alarms and
events data in Historian.

Historian Administrator (on page )

Historian Administrator provides a graphical user interface for performing Historian

maintenance functions in a Windows environment including:

- Tag addition, deletion, and configuration.

- Maintaining and backing up archive files.


unique_4
unique_4
unique_4
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- Data collector configuration.

« Security configuration.

- Searching and analyzing system alerts and messages.

- Configuring the Calculation collector to create a new tag based on calculations, and
storing the result as time series data.

« Setting up your OPC Classic HDA server and OPC UA HDA server.

Historian Administrator

The Web Admin console provides a dashboard, which displays the health of the system in

one convenient location. You can view the following diagnostics details:

- Data node diagnostics: Displays the Historian servers connected to the system.
« Collector diagnostics: Displays the details of the faulty collectors.

- Client diagnostics: Displays the top five busiest clients connected to the system.

The dashboard provides interactive configuration management, which helps you configure
mirror nodes, tags, collectors, data stores, and archives. However, the functionality of the
Calculation collector and the ability to configure OPC HDA servers are not included in the

Web Admin console.
The Web Admin console uses a CAL.

The Historian Server

The Historian server performs the following tasks:

- Manages all system configuration information.

- Manages system security, audit trails, and messaging.

- Services write and read requests from distributed clients.
» Performs final data compression.

- Manages archive files.

Historian Diagnostics Manager

The Historian Diagnostics Manager monitors the health of the Historian system and
executes a few rules on the nodes, collectors, and clients, and generates the appropriate
fault record. The details of these faults are displayed in the Web Admin console.

The following are the faults and their severity level:



Getting Started Guide | 1 - Getting Started Guide | 15

Fault Type Fault Description Fault Level

Collector Status Fault Generated when the collector goes | Error
to the Unknown or Stopped state.

Collector Overrun Fault Generated when at least one over- | Warning
run occurs on a collector in last 24
hours.

Collector OutOfOrder Fault Generated when at least one OutO- | Information
fOrder occurs on a collector in last
24 hours.

Collector StoreForward Fault Generated when the collector Last | Information
Data Sample Time Stamp is de-
layed by more than an hour.

Collector ConnectDisconnect Fault | Generated when the collector is Information
Disconnected and connected at
least once in last 24 hours.

Service DiskSpace Fault Generated when a node disk space | Warning
is about to reach its free space lim-
it.

Client InActive Fault Generated when a client is not ac- | Information

tive for the last one hour.

Client BusyRead Fault Generated when the client makes | Information
relatively more number of reads
per minute.

Client BusyWrite Fault Generated when the client makes | Information
relatively more number of writes

per minute.

Client TimedOutRead Fault Generated when the client makes a | Warning

timed out read query.

Client Manager

Client Manager acts as the client connection manager and message router for the system.
It examines messages and forwards them to the correct data archiver or to Configuration
Manager. This service is deployed only for mirrored systems.
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Configuration Manager

Configuration Manager maintains and distributes the entire system configuration. There
can be multiple Historian nodes but only one Configuration Manager. This Configuration
Manager node is used to store system configuration, such as tag names, collector names,
and Historian node names. This service is deployed only for mirrored systems.

Configuration Hub
Configuration Hub allows you to manage the Historian systems and its components,

including:

- Creating a Historian system, and adding its components
« Creating mirror groups
« Creating and managing data stores

« Installing and managing collector instances

Using Configuration Hub, you can achieve high availability of servers in a Historian system.
Remote Collector Manager

Typically, collectors are distributed geographically, and so, accessing them can be
challenging and not cost-effective. To overcome this challenge, the Remote Collector
Management agent provides the ability to manage collectors remotely.

Historian Tomcat Container

An instance of Tomcat is used exclusively by Historian as an open source Java-based web
server to support the Web Admin console and Trend Client. It supports SSL and the use of
certificates for enhanced security.

Proficy Authentication Tomcat Container

An instance of Tomcat is used exclusively as an open source Java-based web server to
support external Proficy Authentication.

Proficy Historian PostgreSQL Database

An instance of PostgreSQL is used exclusively to store tag names to improve searching for
tags in the Trend tool and Web Admin console.

Proficy Authentication PostgreSQL Database
An instance of PostgreSQL is used exclusively to store Proficy Authentication details.
Reverse Proxy Service

Provides secure connection by supporting https protocol.
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Indexing Service

The indexing service speeds up search results. It periodically queries the database, creates
a tag index, and stores the information in the PostgreSQL database instance.

Excel Add-in for Historian

Excel Add-in is a very useful tool for presenting and analyzing data stored in archive files.
Using this tool, you can design custom reports of selected data, automatically process the
information, and analyze the results. You can also use it for performing tag maintenance
functions in Historian, such as adding tags, importing or exporting tags, or editing tag

parameters.
Excel Add-in for Operations Hub

The Excel Add-in for Operations Hub enables you to query historical data of objects and
object types defined in Operations Hub.

Customers purchasing Historian Standard or Enterprise licenses now receive a no-cost
license for the Operations Hub server and the Historian Analysis run-time application. The
Operations Hub server enables customers to define an asset model including tag mapping.
The Historian Analysis application is a pre-built Operations Hub HTMLS5 application that
enables users to do advanced trend analyses, including the ability to make annotations.

The OPC Classic HDA Server

The OPC Classic HDA server reads the raw data stored in Historian and sends it to the
connected OPC clients. The Historian OPC Classic HDA server complies with OPC Server
HDA 1.20 standards.

Historian SDK

The Historian Software Development Kit (SDK) is designed for writing Visual Basic (VB) or
Visual Basic for Applications (VBA) scripts. Using the SDK, you can develop your own scripts
to perform selected repetitive or complex tasks or to make your own custom user interface.
To use the SDK, create a VB/VBA project with the SDK as a project reference.

Data Retrieval Components

Data retrieval components are used to retrieve data that is stored in the Historian server. Historian
contains the following data retrieval components:

Historian Alarms and Events

Historian Alarms and Events provides tools to collect, archive, and retrieve alarms and

events data in Historian.
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Client Manager

Client Manager acts as the client connection manager and message router for the system.
The Client Manager will examine messages and forward them to the correct Data Archiver
or to the Configuration Manager. This service is deployed only for mirrored systems.

Configuration Manager

Configuration Manager maintains and distributes the entire System configuration. There
can be multiple Historian nodes but only one Configuration Manager. This Configuration
Manager node is used to store system configuration, such as tag names, collector names
and Historian Node names. This service is deployed only for mirrored systems.

Proficy Authentication Tomcat Container

An instance of Tomcat is used exclusively by Historian as an open source Java-based Web
server to support an external Proficy Authentication.

Proficy Historian PostgreSQL Database

An instance of PostgreSQL is used exclusively by Historian to store tag names to improve
searching for tags in the Trend tool and Web Admin console.

The OPC Classic HDA Server

The Historian OPC Classic HDA server reads the raw data stored in Historian and sends it
to the connected OPC Classic HDA collectors. The Historian OPC Classic HDA server is in
compliance with OPC Server HDA 1.20 standards.

The OPC UA HDA Server

The Historian OPC UA HDA server retrieves historical process data from Proficy Historian,
and sends it to OPC UA HDA clients. It dynamically updates the clients when tags are added
and/or deleted in Historian. Clients that comply with this specification can connect to the
OPC UA HDA server to retrieve data from Historian.

For information, refer to the OPC UA HDA Server section of the online documentation.
User API

The Historian User APl is intended to provide high speed read/write access to Historian data

and read access to Historian tags. There is no access to alarms, events, or messages.

Since the Historian User APl is the basic building block for connectivity, all Historian
functions, including data collection, administration, and data retrieval, use the Historian API.
You can use the Historian User API to connect to a local Historian server or a remote one (by

just providing the IP address or host name of the server).
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Use the API to develop applications in C or C++, which read and write data to the Historian
server when the Historian SDK and Historian OLE DB do not meet your project requirements
for performance or programming language.

Historian allows you to develop both 32-bit and 64-bit User API programs.

Note:

If you want to build a 32-bit User API program on a 64-bit operating system, then you

need to rename the i huapi 32. i b toi huapi . | i b and include it in your program.

REST APIs
Historian includes a REST API to connect your Java Web-based Clients with Historian data.
Historian SDK

The Software Development Kit (SDK) is designed for writing Visual Basic (VB) or Visual
Basic for Applications (VBA) Scripts. Using the SDK, you can develop your own scripts to
perform selected repetitive or complex tasks or to make your own custom user interface. To
use the SDK, create a VB/VBA project with the SDK as a project reference. Refer to the SDK
Help system for more information.

Historian Client Access API

The Historian Client Access APl is a .NET Core assembly that interacts with Historian from
any .NET Core applications. Since it works with .NET Core, it is platform-independent - you
can use it on any operating system, such as Windows, Linux, and Mac OS.

Note:

You can still use the old Client Access API, which is a .NET assembly. It is installed

when you install Client Tools.

JAVA APIs

Most open source, quick development applications rely on JAVA as their programing
language. To enable easier integration with Historian, JAVA APIs are provided. The JAVA
APls support 64-bit Windows Operating Systems.

About the Historian Server

The Historian server is the central point for managing all of the client and collector interfaces, storing data
and (optionally) compressing and retrieving data.
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In the Historian server, data is stored in files called data archives. These files contain all the tag data
gathered during a specific period of time (for example, time-based archives such as daily archives). They
have the .iha extension.

You can store data of various data types such as Float, Integer, String, Byte, Boolean, Scaled, and binary
large object data type (BLOB). The source of the data defines the ability of Historian to collect specific
data types. If you have the license to store the alarms and events data, the server also manages the
storage and retrieval of OPC Alarms and Events in a SQL Server Express.

You can further segregate your tags and archives into data stores. A data store is a logical collection of
tags used to store, organize, and manage tags according to the data source and storage requirements. A

data store can have multiple data archives, and includes logical and physical storage definitions.

The primary use of data stores is segregating tags by data collection intervals. For example, you can
put name plate or static tags where the value rarely changes in one data store, and put process tags in

another data store. This can improve the query performance.

The Historian Data Archiver is a service that indexes all the data by tag name and timestamp and stores
the result in an .iha file. The tag name is a unique identifier for a tag (which is a specific measurement
attribute). For iFIX users, a Historian tag name normally represents a Node.Tag.Field (NTF). Searching by
the tag name and time range is a common and convenient way to retrieve data from Historian. If you use
this technique to retrieve data from the archive files, you need not know which archive file contains the
data. You can also retrieve data using a filter tag.

The Historian server performs the following tasks:

» Manages all system configuration information.

» Manages system security, audit trails, and messaging.

- Services write and read requests from distributed clients.
« Performs final data compression.

» Manages archive files.

About Tags
A Historian tag is used to store data related to a property.

For example, if you want to store the pressure, temperature, and other operating conditions of a boiler, a
tag will be created for each one in Historian.

When you collect data using a collector, tags are created automatically in Historian to store these values.
These tags are mapped with the corresponding properties in the source.
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For example, suppose you want to store 0S| Pl data in Historian. You will specify the OSI Pl tags for which
you want to collect data. The OSI PI collector creates the corresponding tags in Historian, and it stores the
values in those tags.

You can also choose to create tags manually (for example, to store the result of a calculation performed

by the Calculation collector).

Prerequisites

Setting Up the Historian Environment

Identify the computers that will function as your clients, data collectors, administration workstations, and

archiver.

1. Set up each computer.
See Hardware Requirements (on page 26), and refer to the user manual that accompanies each
component for the setup information.

2. Use a login account with administrator rights so that you can install Historian later.
See Software Requirements (on page 37), and refer to the user manual that accompanies each
software product for the setup information.

3. Activate the license key on your Historian server node. Additional licenses may be required
on other nodes (such as mirroring and collector nodes) depending on your configuration
requirements. See Activate the Historian License (on page 21).

4. Disable the guest account in Windows security if you want to limit authentication to known
Windows users only.

5. Ensure that the protocols and ciphers (TLS 1.0, 1.1, and 1.2) required to install Historian are
available.

Activate the Historian License

Advantage Licensing is the software system for activating and managing product licenses. Using the
tools in licensing and our Customer Center website, you can view, activate, and manage licenses at your

site.

Using Advantage Licensing, you can:

- View current licenses for the products residing on a computer.
+ Choose a licensing method (Internet, local intranet, or file-based).
« Change licenses (Activate, Return, Refresh).
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Historian is available in three license types:

» Essentials
« Standard

* Enterprise

The Essentials edition is included as the on-board Historian with the purchase of some iFIX and
CIMPLICITY licenses, and cannot be licensed or sold outside of those packages. Essentials edition
customers who require options available in the Standard or Enterprise editions or require more than a
1000 tags must purchase either a Standard or Enterprise License with the appropriate tag count.

Historian HD is sold and licensed separately from Historian. Historian HD provides the Historian user

a standard method to move Historian tag configuration and historical archive data from a Windows
environment to a Hadoop Distributed File System (HDFS). HDFS is the primary distribution storage used
by Hadoop applications.

A component that is used only by the Historian HD license is installed with your Historian installation: the
Historian Archive Ingestion service. This service is reserved for use only with the Historian HD big data
analytics platform and is listed as Manual under Startup Type. Stopping this service does not impact the
Historian functionality. Unless you are licensed to use Historian HD, do not attempt to start or monitor this
service, as it may impact the ability to run the Historian Data Archiver service.

The following table provides information on the availability of each Historian component for each license

type. Optional indicates that the component is not available by default, but can be purchased separately.

(L ™
Note:
For a Calculation collector and a Server-to-Server collector, you can either opt for standalone use
of bi-modal collectors or add Enterprise collectors to the Standard Historian license. Using these
options, you can quickly and easily send data from one Historian server to another or directly to

Predix Timeseries. For information on the pricing, contact the Support team.
- J

Component Essentials Standard Enterprise Distributed

Server Functionality

Data modification Yes Yes Yes Yes
Client Access Licenses (CALSs) 2 2500 2500 2500
Cluster support No Yes Yes Yes
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Component Essentials Standard Enterprise | Distributed
Collector redundancy Optional Yes Yes Yes
Horizontal scalability (data mirroring) No No Yes Yes
Data stores 5 10 20 20
Data stores expansion (200) No No Optional Optional
Digital / Enumerated / Array Tags Yes Yes Yes Yes
Distributed Historian No No No Yes
Electronic signatures No Optional Optional Optional
The Extract, Transform, and Load (ETL) No No Yes Yes
tools
Fault-tolerant computer support Yes Yes Yes Yes
Maximum historical tags 1,000 50,000 20,000,000 | 20,000,000
Microsecond support No Yes Yes Yes
The OLE DB provider Yes Yes Yes Yes
The OPC Alarms and Events server No Optional Yes Yes
The OPC Classic HDA server Yes Yes Yes Yes
The OPC UA HDA server No Yes Yes Yes
The Historian server Yes Yes Yes Yes
Remote Collector Management No No Yes Yes
SCADA buffer (10000 tags, 200 days) Yes Yes Yes Yes
User-Defined multi-field tags No Yes Yes Yes
Client Functionality
The Historian Model No Yes Yes Yes
The Historian Excel Add-in Yes Yes Yes Yes
Historian Administrator Yes Yes Yes Yes
Operations Hub Freemium No Yes Yes Yes
The Web Admin console No Yes Yes Yes
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Component Essentials Standard Enterprise | Distributed

Trend Client No Yes Yes Yes
Configuration Hub Yes Yes Yes Yes
Collector Functionality
Wonderware Collector with the cloud op- No Yes Yes Yes
tion
The Calculation collector No Available Yes Yes

as a part of

the Enter-

prise Collec-

tors option
Collector Toolkit SDK No Yes Yes Yes
The CygNet collector with the cloud option No Yes Yes Yes
Expressions No No Yes Yes
The File collector No Yes Yes Yes
The HAB collector No Yes Yes Yes
The iFIX collector Yes Yes Yes Yes
The MQTT collector No Yes Yes Yes
The MQTT Sparkplug B collector No Yes Yes Yes
The ODBC collector with the cloud option No Yes Yes Yes
The OPC Classic Alarms and Events collec- No Optional Yes Yes
tor
The OPC DA collector with the cloud option Yes Yes Yes Yes
The OPC Classic HDA collector with the No Yes Yes Yes
cloud option
The OPC UA Data Access (DA) collector No Yes Yes Yes
with the cloud option
The OSI PI collector with the cloud option No Yes Yes Yes
The OSI PI distributor No Yes Yes Yes




Getting Started Guide | 1 - Getting Started Guide | 25

Component Essentials Standard Enterprise | Distributed
The Python collector No Available Yes Yes
as a part of
the Enter-
prise Collec-
tors option
The Server-to-Server collector with the No Available Yes Yes
cloud option as a part of
the Enter-
prise Collec-
tors option
The Simulation collector Yes Yes Yes Yes
The Windows Performance collector No Yes Yes Yes
g ™

Note:
* Starting Historian 7.2, SCADA buffer count is increased from 2500 to 10000. Historian
Essentials license includes 2500 buffered tags and a 200-day circular buffer if permanent
storage is less than 1000 tags (that is, if CIMPLICITY points are 1500 and below). It includes
10000 buffered tags and a 200-day circular buffer if permanent storage is 1000 tags (that is, if

CIMPLICITY points are 5000 and above).
- /

To activate the Historian license:

1. If the license is already activated on your system, access License Client, select Advanced > Clear
license information on this computer.
2. If you received an email containing an activation code, you must migrate to Advantage Licensing.

Get the latest licensing software at http://digitalsupport.ge.com.

If you did not receive an activation code, follow the instructions about M4 keys at http://

digitalsupport.ge.com.

3. Download the Historian software.
4. Install the licensing software.
5. Activate the Historian license.


http://digitalsupport.ge.com
http://digitalsupport.ge.com
http://digitalsupport.ge.com
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Hardware Requirements

Table 1. Historian Server

Hard-
L Enterprise Histori-
ware Com- Standard Historian
an, Data Mirroring
ponent
RAM 8 GB 16 GB or 32 GB (recommended)
Disk size | 80 GB free hard-drive space 250 GB (minimum)
Processor |Intel Core i3 ori5 ori7 CPU or an equivalent AMD Intel Core-i5, i7 family, or equivalent
type Phenom CPU
CPU Dual/Quad cores
CPU speed (2.4 GHz 2.8 GHz
Recom- 2.4 GHz 2.8 GHz
mended
CPU clock
Storage SAS SSD with RAID Level 0 config-
type ured
Operating » Microsoft® Windows® Serv-
system er 2022 (64-bit).
» Microsoft® Windows® Serv-
er 2019 (64-bit).
» Microsoft® Windows® Serv-
er 2016 (64-bit).
» Microsoft® Windows® 11
(64-bit).
» Microsoft® Windows® 10
(64-bit), Professional ,or En-
terprise Edition.
Tags Up to 50,000
Years of 1 year
data online
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Table 1. Historian Server (continued)

Hard- . L
L Enterprise Histori-
ware Com- Standard Historian L
an, Data Mirroring
ponent
Other re- » A DVD-ROM drive.
quirements » 100 Mbps TCP/IP-compatible network inter-
face adapter for network communication and
certain 1/0 drivers.

The size of a Historian server is determined by:

- The number of tags from which data is collected. The number of tags is an indicator of the number
of concurrent users likely to access the system. The primary factor is server memory requirements;
CPU load is a secondary factor. If the number of concurrent users is significantly different from the

suggested guidelines, adjust server memory size accordingly.

 The rate of alarms and events collection.

« The frequency of data collection.

« The amount of data you want to keep online.

The following table provides the recommended hardware components for a Historian server with the

Standard license based on the number of tags that you want to use. These recommendations may

vary based on years of data online, update rate, data compression setting, and other tag configuration

parameters.
100,000 One Million | Two Million
Hardware 10,000 to . . . .
Less Than 10,000 Tags to One Mil- | to Two Mil- | to Five Mil-
Component 50,000 Tags . . .
lion Tags lion Tags lion Tags
RAM (in GB) |8 GB/16 GB (recommended |16 or 32 16 or 32 16 or 32 32 or 64
for a single node setup)
Disk Size (in | 100 or 250 250 250 500 500
GB)
Processor Intel Core-i5, i7 family, or Intel Core-i5, |Intel Xeon (56xx, E5 family or AMD Opteron
Type equivalent i7 family, or | 42xx/62xx family)
equivalent
CPU Dual/Quad core Dual/Quad Dual/Quad 2-socket 2-socket or
core core 4-socket
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Hardware 10,000 to 100,000 One Million | Two Million
Less Than 10,000 Tags to One Mil- | to Two Mil- | to Five Mil-
Component 50,000 Tags
lion Tags lion Tags lion Tags
CPU Speed |2.8 2.8 2.8 2.6 2.6
(in GHz)
CPU clock 2.8 2.8 2.8 2.6 2.6
speed (in
GHz)
Storage Type [ SAS SSD with RAID level 0 | SAS SSD Direct-attached or shared High speed
configured with RAID storage with SAS enterprise | shared stor-
level 0 con- | class drives. Hardware RAID | age with SAS
figured controller with cache memo- | or SSD drive
ry. SAN recommended over |types. Hard-
NAS ware RAID
controller
with cache
memory.
SAN recom-
mended over
NAS.
Years of data | 1 1 1 1 1
online
g N

Note:

can each have their own drive.

compatible with the operating system.

« The Historian server runs only on 64-bit versions of Windows.

« Sustained event rate is 60-100 million samples per minute.

« Historian does not support Titanium processors.

- When possible, for performance reasons, consider using computers with multiple disk
drives so that archives and buffers can be given their own drive. Or, multiple data stores

- Historian supports Intel Core i3, i5, i7 Duo based processors as long as they are
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System performance may vary depending on the hardware specifications, operating system, and tuning
parameters. The following table provides sample hardware specifications for medium-sized and large-

sized servers.

Hardware
For a Medium-Sized Server| For a Large-Sized Server
Component
Processor type Intel Xeon 5540 Intel Xeon E5-2670 or E5-4650
CPU Dual socket Dual socket or quad-socket
CPU speed (inGHz) |[2.5 2.7
RAM (in GB) 64 256

Table 2. Collectors

Hardware Component Recommendation
RAM 8 GB
Disk size 80 GB
Historian collectors 32-bit or 64-bit

Note:

Wonderware Collector supports 64-bit only

s )

Note:

« Historian Collectors work as 32-bit applications on a 64-bit Windows operating systems
using WoW64 mode (Windows-on-Windows 64-bit). However, you can read and write data
from a 64-bit Historian Server.

* RAM and Disk Size required may vary based on the collectors available on the system.

» Recommended number of tags per collector is 20 to 30K.

« For iFIX systems, count each Node.Tag.Field (NTF) as a separate tag when you determine
the size of the system. For example, FIX.FIC101.F_CV and FIX.FIC101.B_CUALM (current
alarm) both count as tags, even though they are derived from the same iFIX tag.

o J

Microsoft Windows Server




Getting Started Guide | 1 - Getting Started Guide | 30

Many desktop-class computers are not certified to run Windows. Check the Microsoft website and your
computer hardware vendor website for possible conflicts between your hardware and Windows server.
These specifications are sufficient to meet the needs of a small pilot application. However, production
system requirements may be significantly different depending on many application-specific factors.
Please contact your product manager to review the requirements of your application.

Table 3. Microsoft Cluster Service

Hardware .
Requirement
Component
CPU speed, A 2.6 GHz clock-speed Intel Core i3 or i5 or i7 or Xeon or equivalent AMD Opteron
processor type, CPU with minimum 8 GB RAM.
and RAM
Disk size A 80 GB free hard-drive space and a 40 GB shared SCSI hard-drive (RAID preferred).

Other require-

ments

Two 100Mbit TCP/IP-compatible network interface adapters for network communi-

cation and certain I/0 drivers (One for public network, another for private network).

-~

N

Note:

The configuration of each server added to the cluster must be identical to the other servers in the

cluster.

~

J

Table 4. Data Mirroring and Redundancy Service

Hardware

Component

Requirement

Operating system

A 64-bit Windows operation system.

RAM Minimum 8 GB RAM.
Note:
If you are using single node setup, it is recommended to use 32 GB
RAM.
Processor type A dual core processor.

Ensure that you are using the same hardware requirement for the mirror node as well.

Network Speed
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For a large Configuration Hub setup, it is recommended that the network speed is 1 GBPS.

e N

Note:

- If you are using a single node setup, then it is recommended to use 32 GB RAM.

« Ensure that you are using the same hardware requirement for the mirror node as well.

 You must have a minimum of 10 GB free space available for the data archiver to start.

» Many desktop-class computers are not certified to run Windows server. Check the
Microsoft website and your computer hardware vendor website for possible conflicts
between your hardware and Windows server. These specifications are sufficient to meet
the needs of a small pilot application. However, production system requirements may be
significantly different depending on many application-specific factors. Please contact your

product manager to review the requirements of your application.

- J

Software Requirements

This topic describes the minimum software requirements for Historian.

- Operating System: Historian requires one of the following operating systems, with latest service
packs or revisions:
> Microsoft® Windows® Server 2022 (64-bit)
> Microsoft® Windows® Server 2019 (64-bit)
> Microsoft® Windows® Server 2016 (64-bit)
> Microsoft® Windows® 11 (64-bit)
> Microsoft® Windows® 10 (64-bit), Professional ,or Enterprise Edition.

( Note: )

The Historian server runs on a 64-bit Windows operating system only.

Historian 7.2 32-bit components such as Collectors, Excel Add-in 32-bit, Interactive SQL
32-bit, APIs, and Non-Web Administrator work as 32-bit application on 64-bit Windows
operating systems using WoW64 mode (Windows-on-Windows 64-bit). However, you can
read and write data from a 64-bit Historian Server.

If you use Historian 6.0 or later on Windows Server 2008 R2, you must go for a Full
Installation and not Core Installation of Windows.
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« Network Interface Software: The TCP/IP network protocol is required.
* Microsoft®.NET Core or .NET Framework: Historian requires the following .NET frameworks:To
install the framework, you must configure your proxy server for internet access.
o Microsoft®.NET Core Framework 3.1: This is required if you want to use the new Client
Access API.
> Microsoft®.NET Framework 4.8: This is required on the machine on which you will install
the Excel Add-in for Operations Hub. In addition, this is required for Historian collectors.
o Microsoft®.NET Framework 4.6.1: This is required for all the other Historian components.
You can install it manually, or you will be prompted to download and install it while installing
Historian.

o ™
Note:
If your machine is Firewall/proxy-enabled, Microsoft .NET Framework may not be installed
automatically. In that case, before installing Historian, you must install Microsoft .NET

Framework manually (if it is not available).
& J

* Microsoft® SQL Server®: Historian requires one of the following 32-bit or 64-bit Microsoft® SQL
Server® SQL server systems to configure archiving for alarms and events or to use Historian as a
linked server:

> Microsoft® SQL Server® 2022
> Microsoft® SQL Server® 2019
> Microsoft® SQL Server® 2017

- N
Note:
The collation for your alarms and events database must match the collation of your SQL
Server. This happens automatically by default unless the alarms and events database is

moved to another SQL server.
o J

- Browser: You can access the Web Admin console and Trend Client using the following browsers:
> Firefox version 46 or later
> Google Chrome version 92 or later
To access Configuration Hub, use Google Chrome only.
- Screen Resolution: You can access Configuration Hub, the Web Admin console, and Trend Client
using the following screen resolutions:
> 1280 x 1024
> 1366 x 768
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« Microsoft Excel: The Excel Add-in for Historian or the Excel Add-in for Operations Hub requires any
of the following versions of Excel:
> Microsoft® Excel® 2021 (32 & 64 bit)
> Microsoft® Excel® 2019 (32 & 64 bit)
> Microsoft® Excel® 2016 (32 & 64 bit)
> Microsoft® Excel® 2013 (32 & 64 bit)

- Web Server: The web server requires the following applications:
o Microsoft®.NET Framework 4.6.1
o Historian Client Tools 7.0 or later
o OLE DB, User API, and Historian Client Access Assembly

Compatibility with Other Products

Several other products work with Historian. The following is a general set of versions tested to work with
the Historian 2024 product.

Product Supported Version
CIMPLICITY 2022,2023
iFIX 2022, 2023, 2024 beta
Proficy Plant Applications 2023, 2024 beta
Workflow 2.6 SP2
Proficy Operations Hub 2023.1, 2024 beta
Configuration Hub 2024
Proficy Authentication 2024
Dream Reports 2023 Patch 1
Habitat 5.12

Historian REST APlIs are required to integrate between Historian and Operations Hub. Historian REST APIs

are installed automatically when you install Historian Web-based Clients (on page 94).

Supported Regional Settings, Data Types, and Date/Time Formats

Supported Regional Settings
Historian supports the following regional settings available in Control Panel:
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 Decimal symbol - one character

« Digit grouping symbol

- List separator - one character

- Time style

« Time separator

« Short date style

« Date separator

Supported Data Types

Data Type Size
Single Float | 4 bytes
Double 8 bytes
Float
Single Inte- |2 bytes
ger
Double Inte- | 4 bytes
ger
Quad Inte- | 8 bytes
ger
Unsigned 8 bytes
Quad Inte-
ger
Unsigned 2 bytes
Single Inte-
ger
Unsigned |4 bytes
Double Inte-
ger
Byte 1 byte
Boolean 1 byte
Fixed String | Configured by user.
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Data Type Size

Variable No fixed size.

String

Binary Ob- | No fixed size.

ject
Historian does not support the use of the Binary Object data type with the Data Collectors.
Refer to the SDK online Help for more information on working with BLOB data types.

Scaled 2 bytes

Supported Date Formats

Historian supports the following short date formats, some of which may not be available in certain

language versions of Windows:

« dd/mm/yy

+ dd/yy/mm

* mm/dd/yy

* mm/yy/dd

e yy/dd/mm

* yy/mm/dd

Avoid changing the time style or short date style in regional settings to values that are outside of the

standard styles provided.

Optimize Performance

You can optimize performance in the following ways:

- Optimize virtual memory: Through the use of paging files, Windows allocates space on your hard

drive for use as if it were actually memory. This space is known as virtual memory. This topic

describes how to optimize the virtual memory on the Historian archiver computer.

s

Note:

If the paging file is set to grow dynamically, your system may experience severe
performance problems during runtime. To ensure optimal performance, the Initial Size and
Maximum Size values for the paging file must be the same so that the paging file does not
grow dynamically. For more information on creation and sizing of Windows paging files,
refer to Microsoft Windows Help.




Getting Started Guide | 1 - Getting Started Guide | 36

- Optimize the server performance: If the file sharing and printer sharing options on the computer
on which you want to install Historian is set to maximize data throughput, it can lead to excessive
paging when dealing with large files, which can interfere with applications like Historian. You can
change these settings to optimize the performance.

1. To optimize virtual memory:
a. Access Control Panel, and then select System > Advanced system settings > Advanced.
b. Under Performance, select Settings > Advanced.
c. Under Virtual Memory, select Change.
d. In the Initial size and Maximum size fields, enter a value equal to three times your physical
memory.
e. Select Set, and then select OK.
2. To optimize server performance:

a. Access Control Panel.
b. Select Network and Sharing Center.

c. Select the network that you use.

The <network name> Status window appears.
d. Select File and Printer Sharing for Microsoft Networks, and select Properties.
e. Select Properties.
f. Ensure that the Maximize Data Throughput for Network Applications option is selected.

g. Select OK.

Enable Trust for Proficy Historian for a Self-signed Certificate

During Historian installation, a self-signed certificate is generated that you use with Historian web
applications. A self-signed certificate is a certificate that is signed by itself rather than signed by a trusted
authority. Therefore, a warning appears in the browser when connecting to a server that uses a self-signed
certificate until it is permanently stored in your certificate store. This topic describes how to ensure that
Google Chrome trusts the self-signed certificate.

1. Using Google Chrome, access the site to which you want to connect.

A message appears to inform you that the certificate is not trusted by the computer or browser.
2. Select Not Secure in the URL, and then select Certificate.

The Certificate window appears.
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3. Select Certification Path, select the root certificate, and then select View Certificate.
The Certificate window appears, displaying the General, Details, and Certification Path sections.
4. Select Details, and then select Copy to File.
5. Follow the on-screen instructions to save the certificate to a local file. Use the default format: DER
encoded binary X.509 (.CER).
6. Right-click the .CER file that you have exported, and select Install Certificate.
The Certificate Import Wizard window appears.
7. Select Trusted Root Certificate Authorities, and then select OK.

Note:

Do not let the wizard select the store for you.

A Security Warning window may appear. If it does, ignore the message by selecting Yes. The
certificate is installed.

8. Restart the browser, and connect to the server.

9. Open the URL authenticated by the certificate.
If error messages do not appear, the certificate is successfully imported.

VMWare Support

Historian provides support for VMware ESXi server version 5.0 and later. The virtualization capability
provided by VMware lets you run multiple virtual machines on a single physical machine, with each virtual
machine sharing the resources of that one physical computer. Please be aware that while we have tested
VMware ESXi 5.0 and above, issues with the VMware software or the virtualized environment are outside
the scope of GE Vernova's responsibility. You must use VMWare Compatibility Hardware and Software
before installing Historian 7.0 or greater Data Archiver on a Virtual Machine. For the current release, the
only supported type of Proficy licensing for use with VMware is keyless (software) licensing.

Note:

VMware Player is not supported.

Important:
Advanced features of the ESXi server (such as VMotion, High Availability, and Clustering support)
have not been tested with Historian.

For information regarding VMware compatibility and its supported software and hardware environments,

refer to http://www.vmware.com/resources/guides.html.


http://www.vmware.com/resources/guides.html
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VMWare Best Practices and Limitations

Disk Growth

To prevent disk growth during run time, make sure you pre-allocate the hard disk in your
VMware image.

Important:

If the VMware disk needs to grow at runtime because of IHA growth or creation, the
Data Archiver will be slowed. If there is not enough disk space on the host machine
to grow the VMware disk, the archiver may lose data.

Suspended Images/Power Metered Images

ESXi servers have power meter functions and options as well as the ability to suspend
images to conserve power. We do not recommend or support these functions due to the
potential effects on the Guest operating system, specifically in regards to polling I/0 and
timely updates.

I/0 Devices and Connections and VMware

There are a multitude of devices and methods of communications on the market. These
devices may be used if you can successfully connect them from the virtual machine through
the physical HOST, but we do not support the setup of that connection. Be aware that device
drivers used to write to proprietary cards for the ESXi HOSTS as part of virtual device setup

can cause issues.
USB Controller Limitations

The USB controller has these limitations when using Historian and VMware:

« Minimum virtual hardware version 7 is required.

« Only one USB controller of each type can be added to a virtual machine.

» The USB arbitrator can monitor a maximum of 15 USB controllers. If your system
includes an additional number of controllers and you connect USB devices to these
controllers, the devices are not available to be passed through to a virtual machine.

« You must add a USB controller to a virtual machine before you can add a USB device.

« You must remove all USB devices from a virtual machine before you can remove the
controller

USB Device Limitations

USB devices have these limitations when using Historian and VMware:
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« A virtual machine may have up to 20 USB devices attached to it; however, each
unique USB device can only be attached to one virtual machine at a time.
« Unsupported USB devices may not interact as expected with other ESXi features.

Additional VMware Notes

GE Vernova cannot guarantee the performance of the Historian software in a virtualized
environment due to the wide range of parameters associated with the hardware,
configuration, memory settings, third-party software installations, and the number of
virtual machines running; all of which can affect performance. Therefore, GE Vernova
cannot provide support related to the performance of the Historian software running on
a virtual machine if it is determined that the issue is related to the virtual environment.
Also, GE Vernova does not provide support or troubleshoot a customer's virtual machine
infrastructure.

It is the responsibility of you, the customer, to ensure that the performance of the Historian
software and any third-party applications (especially those not recommended by GE
Vernova) are adequate to meet the needs of your run mode environment. GE Vernova does
not support issues related to functionality that is not available as a result of running in

a virtual machine infrastructure. Examples include the functionality of card level drivers
such as those for the Genius® family of drivers, the Allen-Bradley® DH/DH+ drivers, the
Cyberlogic's MBX® Driver for the SA85 card, as well as functions requiring direct video
access. Check with the vendor of your third-party application for support statements
regarding that third-party product's ability to run in a virtualized environment.

For more detailed information regarding VMware specifications and requirements, visit the

VMware web site: http://www.vmware.com/resources/compatibility/search.php.

Installation

Historian Installation Workflow
1. Design your system architecture.

Decide what collectors to instantiate on which nodes, which computers to designate as the
Historian server and Historian Administrator, whether or not they will be web-based, and how much
memory and disk space you can assign to buffers and archives. Record the computer names of

each node.

2. Ensure that data sources are installed.
3. Set up your Historian environment (on page 21).


http://www.vmware.com/resources/compatibility/search.php
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4. On the server node, launch the installer, select Install Historian, and follow the on-page instructions
to install Historian (on page 44) on a single server on in a distributed environment.

. Activate your product license (on page 21).

. Install the collectors (on page 817).

. Restart your computer if prompted to do so.

. As needed, install Web-based Clients (on page 93).

O 00 N o O»

. Perform post install setup for MTLS features, by installing certificates. For more information, refer
to Overview of certificate-based security.
10. For the Windows-based Historian Administrator clients, start the Administrator from Historian

Startup Group.

When the home page for Historian Administrator appears, you are ready to set up archives,
collectors, and tags in the Data Store Maintenance, Collector Maintenance, and Tag Maintenance

pages.

The following table provides a list of installation options available in Historian, along with purpose of

installing each one.

Installation Option When to Install

Historian Server (on page 43) Installing the Historian server is mandatory to
work with Historian. If you want to use Web-based
Clients, you must provide the Proficy Authentica-
tion server details while installing the Historian

server.

When you install the Historian server, the following

components are installed as well:

» The RemoteCollectorConfigurator utility:
A command-line tool, which allows you to
manage collectors remotely.

« The Proficy Authentication Configuration
tool: A utility that allows you to specify the
Proficy Authentication server details to
match with the Proficy Authentication serv-
er used by Web-based Clients.

Alarms and Events (on page 79) Install Alarms and Events if you want to retrieve

and store alarms and events data from any OPC-
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Installation Option

When to Install

compliant alarms and events server using the OPC
Classic Alarms and Events collector.

Collectors (on page 81)

Installing collectors is mandatory to collect and

store data in Historian.

When you install collectors, all the collectors and
the Remote Management Agents are installed. You
must then create instances of each collector and

manage them using Configuration Hub.

When you install collectors, if iFIX/CIMPLICITY are
installed on the same machine, instances of the

following collectors are created automatically:

* The iFIX collector

 The iFIX Alarms & Events collector

» The OPC Classic Data Access collector for
CIMPLICITY

» The OPC Classic Alarms and Events collec-
tor for CIMPLICITY

Client Tools (on page 89)

Install Client Tools if you want the following com-

ponents:

« Client Tools

« Historian Administrator

» OLE DB driver and samples

» The OPC Classic HDA server
* User APl and SDK

« Historian Client Access API

« Collector Toolkit

Web-based Clients (on page 93)

Install Web-based Clients if you want to manage
Historian administrative tasks and analyze the da-
ta using components such as Configuration Hub,
the Web Admin console, Trend Client, and REST
APls.
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Installation Option

When to Install

To use Web-based Clients, you need Proficy Au-
thentication (UAA server) to handle user authenti-
cation. It provides identity-based security for appli-
cations and APIs. It supports open standards for
authentication and authorization, including Oauth2.

During the Web-based Clients installation, you can
choose to install a Proficy Authentication instance
and Configuration Hub, or you can use existing

ones.

Historian Remote Management Agents (on page
126)

Remote Management Agents (RMA) include Re-
mote Collector Manager, which is used to manage
collectors remotely.

RMA is installed automatically when you install col-
lectors. If, however, you are using RMA version 8.1,
and you want to upgrade only RMA (and not the
collectors), use this option.

Excel Add-in for Historian (on page 134)

Install Excel Add-in for Historian make bulk
changes to tag parameters using Excel, and then
import it to Historian. You can also perform math-
ematical, retrieve selected data, generate reports

and charts, and so on.

Excel Add-in for Operations Hub (on page 737)

Install Excel Add-in for Operations Hub if you want
to query historical data of objects and object types
defined in Operations Hub.

ETL Tools (on page 141)

Install the Historian Extract, Transform, and Load
(ETL) tools if you want to transfer data where there

is limited internet connectivity.

The OPC UA HDA Server (on page 130)

Install the OPC UA HDA server if you want to use
Historian as an OPC UA HDA server. You can then

connect any OPC UA HDA clients with the server.

Standalone Help (on page 144)

Install Standalone Help to access the Historian
product documentation offline.
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About Installing the Historian Server for the First Time

You can choose one of the following types of installation:

- Single server: This is for a stand-alone Historian system, which contains only one Historian server.
This type of system is suitable for a small-scale Historian setup.

« Mirror primary server and distributed/mirror node: This is for a horizontally scalable Historian
system, which contains multiple Historian servers, all of which are connected to one another. This
type of system is used to scale out the system horizontally. For example, if you have 5,00,000
tags in your Historian system, you can distribute them among the various servers to improve

performance.

In this setup, one of the nodes acts the primary server, whereas the others are the distributed/
mirror servers. Configuration Manager and the embedded web services are installed only on the
primary server, which are used by the distributed/mirror servers as well.

When the Archive Duration property is changed in a distributed environment, the changes will take
effect after 15 minutes.

The distributed environment works only for tag data; it does not work for alarms and events data.
Therefore, do not install alarm archiver in a distributed environment.

In this setup, one of the nodes acts the primary server, whereas the others are the distributed/
mirror nodes.

For all these types of installation, you can use the GUI-based installer (on page 44) or the Command
Prompt window (on page 53). You can also install the Historian server in a cluster environment (on

page 58).

This section provides the high-level steps in installing the Historian server for the first time. You can
perform the same steps to upgrade the server. If you are upgrading from either Historian 6.0 Enterprise
or previous releases of Historian 7.2 (including any of the service packs), both Client Manager and
Configuration Manager services will be removed. However, this will have no impact on your data or use of
Historian unless you intend to use a distributed system.

(L N
Note:
The number of alarms in the Historian Alarms and Eventss database, and the frequency of
new events being added during the installation, impact the time it takes to install Historian.
For example, an installation for a system with 1.5 million alarms can take up to three hours to
complete.
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Important:

You cannot use size-based archives with a Historian Mirror Primary Server and Historian

Mirror Node installation. This is because having archives of different sizes introduces archive
synchronization risks in a mirrored environment. The restriction is enforced on all Historians, even

those not using mirroring.

Important:

Be aware that you cannot close your current archive with a Historian Mirror Primary Server and
Historian Mirror Node installation. This is because closing the current archive introduces archive
synchronization risks in a mirrored environment. The restriction is enforced on all Historians, even

those not using mirroring.

Install the Historian Server Using the Installer

« set up the Historian environment.

- If you want to install web-based clients and view Historian license information on Configuration
Hub, you must provide the Configuration Hub and Proficy Authentication server details during
installation. Therefore, ensure that you have already set up Proficy Authentication in Configuration
Hub. For more information on setting up Proficy Authentication in Configuration Hub, refer to
https://www.ge.com/digital/documentation/confighub/version2023/t_authentication_setup.html.

« If you are changing the role of a Historian server that was previously a distributed/mirror server to
any other configuration (single-server or mirror primary server), you must first uninstall Historian.

« If you are installing a distributed/mirror server, use the same configuration, license key, installation

drive, Proficy Authentication instance, and domain as the primary server.

This topic describes how to install the Historian server using the installer.

You can also install it at a command prompt.

1. Log in as an administrator to the machine on which you want to install the Historian server.
2. Runthel nstal | Launcher. exe file.

3. Select Install Historian Server.

The welcome page appears.

4. Select Next.

The license agreement appears.

5. Select the Accept check box, and then select Next.

The Where do you want to install Historian? page appears.


https://www.ge.com/digital/documentation/confighub/version2023/t_authentication_setup.html
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Where do you want to install Historian?

Choose an available disk.

Previous

6. If needed, change the default installation drive of the Historian server, and then select Next.
The Override the default Historian data Path? page appears.
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Override the default Historian data Path?

Choose a location.

EEGOENE s 0 O\ Proficy Historian Data

Browse

Previous

7. If needed, change the default folder of the log files, and then select Next. If you want to include the
Historian server in a cluster, enter the path to the shared folder of the cluster.
The Register with Configuration Hub page appears.
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Register with Configuration Hub

By registering, you'll be able to work with Historian web-based clients, and you can also view Historian license
information on Configuration Hub.

B Use existing Proficy Authentication and Configuration Hub Instance

If the above box is not selected, you'll need to use the Proficy Authentication Tool from the Start
Menu after installing Proficy Authentication and Configuration Hub.

Check the "Register with Confisuration Hub” section in the Online Help for more information.

Mote: If you install Historian Web-based clients and Historian Server on one machine, you can skip
this step, and no additional steps are needed after installation.

Previous

8. Select the Use existing Proficy Authentication and Configuration Hub Instance check box, and

provide values as described in the following table.

This step is needed only in the following cases:
> The Historian Server and the Web-based clients will be on two different machines.
> You already installed Proficy Authentication and Configuration Hub, and you want to use the
Historian Web-based clients and view the Historian license information on Configuration
Hub.

If you do not select the Use existing Proficy Authentication and Configuration Hub Instance
during the installation, to use the Historian Web-based clients and view the Historian license
information on Configuration Hub, you must use the Proficy Authentication Tool from the

Start menu to register with Proficy Authentication and Configuration Hub servers.

If you do not have Proficy Authentication and Configuration Hub installed, and you intend
to use the Historian Web-based clients and view the Historian license information on

Configuration Hub, you can install them while installing the Web-based clients.
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o ™
Note:
Proficy Authentication is required for user authentication. It provides identity-based
security for applications and APIs. It supports open standards for authentication and
authorization, including Oauth2.
N /

Register with Configuration Hub

By registering, vou'll be able to work with Historian web-based clients, and you can also view Historian licensa
information on Configuration Hub.

Use existing Proficy Authentication and Configuration Hub Instance
Proficy Authentication server name:

Proficy Authentication Public https Port: §43

Proficy Authentication Admin Client Id: admin

Proficy Authentication Admin Client Secret: seseses e

Configuration Hub server name:

Configuration Hub Public https port:

with Proficy Authentication and-Capfiguration Hubis
pending; click Test

» Ensure to provide the highly privileged admin Client ID and Secret which was created while
installing Proficy Authentication Server

Cancel Previous

Field Description

Proficy Authentication server name Enter the name of the machine on which the
Proficy Authentication server is installed. If the
machine uses a fully qualified domain name
(FQDN), provide the FQDN. By default, the local

hostname is considered.

Proficy Authentication Public https port Enter the port number used by the Proficy Au-
thentication service. The default value is 443.

Ensure that this port number matches the one
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Field

Description

on the TCP Port Assignments page during
Web-based Clients installation.

Proficy Authentication Admin Client Id

The client ID to connect to the Proficy Authenti-

cation service.

Proficy Authentication Admin Client Secret

The password to connect to the Proficy Authen-

tication service.

Configuration Hub server name

The server name or the FQDN of the existing
Configuration Hub server, as displayed in the
address bar of the browser when you access
Configuration Hub from the machine where
Configuration Hub is installed.

Configuration Hub Public https port

The web server (https) port that you want to
use for Configuration Hub. By default, it is
5000.

Test Connection

Option to test the status of the connection with

external Proficy Authentication server.

-~

Note:

the Windows search bar and open it.
-

If you change the Proficy Authentication server for Web-based Clients later, you must also
change the Proficy Authentication server for the Historian server. This can be done using
the Proficy Authentication Configuration Tool located at <l nstal | Drive>:\ Program
Fil es\Proficy\Proficy Historian\x64\Server without the need to install the

Historian server again. Alternatively, you can search for the Proficy Authentication Tool in

9. Select Next.

The Historian Security Groups page appears.

Using Historian security groups provides an added layer of control over access to your Historian

system.

By default, the option to create Historian security groups is not selected.
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Historian Security Groups

B Create Historian Security Groups.

Using Historian Security groups provides an added layer of control over access to your Historian
system.

If you select to add the Historian Security groups you will need to add a valid windows user to
these groups in order to connect to and configure your server after installation.

In addition to this,if you plan to use the web-based clients without LDAP, you will need to create a

local user such as <Proficy Authentication Server name>.admin and add that user to the security
groups in order for Configuration Hub to Connect.

Previous

10. If you want the installer to create Historian security groups (on page 7195), select the
corresponding check box, and then select Next.
The Choose the type of install you want to perform page appears.
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Choose the type of install you want to perform.

Histarian Single Server

Historian Distributed/Mirror Nod

Previous

11. Select the type of the Historian server that you want to install, and then select Next.

o Historian Single Server: This is for a stand-alone Historian system, which contains only one
Historian server. This type of system is suitable for a small-scale Historian setup.

o Historian Mirror Primary Server: This is for a horizontally scalable Historian system, which
contains multiple Historian servers, all of which are connected to one another. Installing this
server will allow you to add machines and distributed/mirror servers to this system.

o Historian Distributed/Mirror Node: This is for a horizontally scalable Historian system.
Installing this server will allow you to add this node to a primary server.

The Historian Server Certificate-based Security page appears.
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Historian Server Certificate-based Security

Enable Certificate-based Security

Historian implements certificate-based security to strengthen the authentication mechanism
armong its core Historian server services. By default, this is enabled for all Historian server
installation types. You can disable by unselecting the above option.

If you are installing Historian Single Server or Mirror Primary Server, the security settings will be
automatically configured by the installer. If you are installing Historian Distributed/Mirror Node,

the security settings must be manually configured after installation.

For detailed instructions, refer the online help section: Overview of the Certificate-based Security
in Historian.

Previous

12. If you want to enable certificate-based security (MTLS-based security), leave the Enable
Certificate-based Security check box selected, and then enter Root Certificate Password.

Note:

Ensure to use the same password to create MTLS (client) certificates. For more

information on creating MTLS (client) certificates, refer to Generate MTLS certificate.

For more information on certificate-based security, refer to overview of the Certificate-based

Security in Historian (on page 145).

Warning:

If you do not select the Enable Certificate-based Security check box during the
installation, you must generate the root certificates manually, as described in the Manually
Install Certificates for Historian section. However, this is not recommended.

13. Select Next.

The You are ready to install page appears.
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14. Select Install.
The installation begins.

15. After the installation, when you are asked to reboot your system, select Yes.
The Historian server is installed on your machine in the following folder: <i nst al | ati on
drive>:\Program Fil es\Proficy\Proficy Hi storian\x64\ Server,and the
following registry path is created: HKEY LOCAL_MACHI NE\ SOFTWARE\ | nt el | uti on, I nc.

\i H storian\ Services.

In addition, the following components are installed:

> The RemoteCollectorConfigurator utility: A command-line tool, which allows you to manage
collectors remotely. By default, it is located in the C: \ Program Fi | es\ GE Di gi t al
\ NonWebCol | ect or I nstanti ati onTool folder. For instructions on using this utility,
refer to About Installing and Managing Collectors Remotely.

> The Proficy Authentication Configuration tool: A utility that allows you to specify the Proficy
Authentication server details to match with the Proficy Authentication server used by Web-
based Clients. By default, it is located in the C: \ Program Fi | es\ Profi cy\ Proficy
Hi st ori an\ x64\ Ser ver folder. For instructions on using this tool, refer to Register with

Configuration Hub (on page 76).

Install the Historian Server at a Command Prompt

« Set up the Historian environment (on page 21).

« If you want to install web-based clients and manage the Historian node in Configuration Hub, you
must provide the Configuration Hub and Proficy Authentication server details during installation.
Therefore, ensure that you have already set up Proficy Authentication in Configuration Hub. For
more information on setting up Proficy Authentication in Configuration Hub, refer to https://
www.ge.com/digital/documentation/confighub/version2023/t_authentication_setup.html.

- If you are changing the role of a Historian server that was previously a distributed/mirror server to
any other configuration (single-server or mirror primary server), you must first uninstall Historian
(on page 233).

« If you are installing a distributed/mirror server, use the same configuration, license key, installation

drive, Proficy Authentication instance, and domain as the primary server.

This topic describes how to install single-server Historian at a command prompt. You can also install the

Historian server using the installer (on page 44).

After you install Historian at a command prompt, you can choose to generate a template XML file, which
contains the installation parameters and the values that you have provided. You can use this XML file for


https://www.ge.com/digital/documentation/confighub/version2023/t_authentication_setup.html
https://www.ge.com/digital/documentation/confighub/version2023/t_authentication_setup.html
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subsequent installations. Similarly, you can use a template XML file instead of providing command-line

arguments.

1. Open Command Prompt, and navigate to the <DVD dri ve>:\ Hi st ori an folder (for example, E:
\ Hi storian).
2. Run the following command:

instal |.exe <argunent>=<val ue> <flag> Hi storianCnd=<installation type>

For example,

To install Historian Server without configuring web-based clients, run the following command:

instal |l .exe RootDrive=E:\ Enabl eCertificateSecurity=1 Server CertPassPhrase="Password"

CreateHi stori anSecurityG oups=fal se -silent Hi storianCrd=Hi storianCore

To install Historian Server and configure web-based clients, run the following command:

install.exe RootDrive=E:\ ActiveUaaBaseUr| =https://histnmachi nel23.test.com 443/ uaa Adm ndientld="adm n"
Admi nCl i ent Secret ="secret"” Confi ghubServer Name="hi st machi ne123. test. con’ Confi ghubhtt psPort="5000"
Enabl eCertificateSecurity=1 Server Cert PassPhrase="Password" CreateHi storianSecurityG oups=false -silent

Hi st ori anCmd=Hi st ori anCor e

The following table provides a list of installation types that you can enter.

Installation Type Description

St andAl one Enter this value if you want to install a stand-

alone Historian system.

Hi st ori anCor e Enter this value if you want to install a primary
server in a horizontally scalable system.

mrror Enter this value if you want to install a distrib-
uted/mirror server in a horizontally scalable

system.

The following table provides a list of arguments that you must enter.

Argument Description

Root Dri ve The drive letter where the Historian server binary files will be installed.

Dat aPat h The disk path where the Historian data files will be stored.
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Argument

Description

Hi st Admi ni strat or -

Passwor d

The password for the built-in administrator account.

Act i veUaaBaseUr |

The URL to connect to Proficy Authentication to allow Web-based
Clients to access Historian. Only if you want to use Web-based Clients,
this parameter is required for user authentication. Proficy Authentication
provides identity-based security for applications and APIs. It supports
open standards for authentication and authorization, including Oauth2.

Proficy Authentication details are required if you want to use Web-based
Clients.

By default, the local hostname and the port number of 443 are consid-
ered. If the Proficy Authentication service is on the same machine on
which you are installing the Historian server, you can accept the default
value. If, however, the Proficy Authentication service is on a different
machine or uses a different port number, replace those values in the
URL as follows:

https://<l ocal host nane>:<port nunber>/uaa

where:

o <Proficy Authentication server> is the name of the machine on
which Proficy Authentication is installed. If the machine uses a
fully qualified domain name (FQDN), provide the FQDN.

o <port number> is the one that you have specified for the public
https port in the TCP Port Assignments page during Web-based
Clients installation.

o ™\
Note:
You can install a Proficy Authentication service using Opera-
tions Hub or Historian Web-based Clients. You can provide the
URL of an existing Proficy Authentication instance. Or, if a Profi-
cy Authentication service is not available, you can install it dur-
ing Web-based Clients installation. In that case, provide the

server name where Proficy Authentication is installed.
- J

Adm nCientld

The client ID to connect to the Proficy Authentication service.
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Argument

Description

Adm nd i ent Secr et

The password to connect to the Proficy Authentication service.

Conf i ghubSer ver Nane

The server name or the FQDN of the existing Configuration Hub server,
as displayed in the address bar of the browser when you access Config-
uration Hub from the machine where Configuration Hub is installed.

Conf i ghubht t psPort

The web server (https) port that you want to use for Configuration Hub.
By default, it is 5000.

rityG oups

Creat eHi stori anSecu-

Indicates whether you want the installer to create Historian security
groups.

Using Historian security groups provides an added layer of control over
access to your Historian system.

Enter true or false. If you enter true:

> You must add a Windows user to the appropriate group (on page
217) (for example, add an administrative user to the iH Security
Admins group). Only then you can configure this server.

o If the Historian server and collectors are installed on the same
machine, you can skip this step; by default, the machine name of
the local Historian server is considered. If, however, they are in-
stalled on different machines, you must provide the credentials of
the Windows user who can access the Historian server machine.
In addition, if security groups are available, add the user to the ap-
propriate group (on page 217) (for example, add an administra-
tive user to the iH Security Admins group). Only then you can ac-
cess Web-based Clients without LDAP.

For more information, refer to Implementing Historian Security (on page
190).

Enabl eCerti fi cat eSe-

curity

Indicates whether you want the installer to enable certificate-based se-
curity (MTLS-based security).

> To enable certificate-based security, set this value to 1.

> To disable certificate-based security, set this value to 0.

For more information on the certificate-based security, refer to overview
of the Certificate-based Security in Historian (on page 145).
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Argument

Description

Server Cert PassPhrase | If you enabled certificate-based security, enter the passphrase for the
server certificate.

-~

N

Note:
Ensure to use this passphrase as the password to create MTLS

(client) certificates. For more information on creating MTLS
(client) certificates, refer to Generate MTLS certificate.

The following table provides a list of flags that you can use.

Flag

Description

[-9], [-quiet], [-s], [-silent]

Use any of these flags for a silent installation.
The installation will then happen in the back-
ground (without a Ul).

[ - passi ve]

Use this flag for a passive installation. The
progress of the installation then appears on

your screen.

/'t

Use this flag to generate the template file,
which will contain all the installation arguments
and the values that you have provided for each
of them. You can then use this file for subse-
guent installations.

By default, this file is named Tenpl at e_Hi s-
torian. xnl,anditis placed in the t enp fold-
er, defined by theu enp%environment variable.
If, however, you want to save the file in another
folder as well, enter: /t Tenpl at eQut put Di r ect o-

ry=<pat h>

/¢ Tenpl at el nput Fi | e=<pat h>

Use this flag to use a template file (instead of
providing command-line arguments). Howev-
er, if you do provide command-line arguments
as well, they take precedence over the values in
the template.
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The Historian server is installed on your machine in the following folder: <i nst al | ati on
drive>: \Program Fil es\Proficy\Proficy Historian\x64\Server, and the
following registry path is created: HKEY_LOCAL_MACHI NE\ SOFTWARE\ | nt el | uti on, Inc.
\'i Hi storian\ Services.

In addition, the following components are installed:

> The RemoteCollectorConfigurator utility: A command-line tool, which allows you to manage
collectors remotely. By default, it is located in the C: \ Program Fi | es\ GE Di gi t al
\ NonWebCol | ect or I nstanti ati onTool folder. For instructions on using this utility,
refer to Remote Collector Management.

- The Proficy Authentication Configuration tool: A utility that allows you to specify the
Proficy Authentication server and Configuration Hub server details to match with the Proficy
Authentication server used by Web-based Clients, and also register the Historian node with
Proficy Authentication server and Configuration Hub server. By default, it is located in the C:
\Program Fil es\Proficy\Proficy Historian\x64\Server folder. Alternatively,
you can search for the Proficy Authentication Tool in the Windows search bar and open it.
For instructions on using this tool, refer to Register with Configuration Hub (on page 76).

While installing the Historian server, if you have allowed the installer to create Historian security groups,
create a local Windows user with the format <Web-based Clients server name>.admin, and add the user to
the ihSecurityAdmins group (on page 217).

This user will log in to Web-based Clients.

Alternatively, you can create Proficy Authentication users in an external Proficy Authentication and map
their security groups. For information, refer to About Proficy Authentication Groups (on page 170).

Depending on whether the Historian server will use local or domain security groups, select the appropriate
option in Historian Administrator.

Set Up High Availability of the Historian Server

Historian works with Microsoft Failover Cluster Manager to ensure high availability of the server.

In a cluster environment, multiple servers are installed, which share the same data. Each of these servers
is called a node. One of them acts as the primary server, while the others are standby servers. If the

primary server is down, one of the standby servers is used. See the following figure for an example.
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( Note: )

Cluster supports only domain security.
- J

Cluster Cluster

gi Primary Server

Active Inactive

Primary Server

Client

Inactive

Shared
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o >
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I__.___I EStandby Server

1. Ensure that your network is enabled for multicast traffic.

2. Create a shared drive on your network that all the servers in the cluster can access, and create a
database folder in that drive.

3. On each node that you want to add to the cluster:
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a. Install the Failover Clustering feature.
b. Install the Historian server (on page 44). During the installation, in the Historian Data
Path field, enter the path to the folder on the shared drive that you have created.

Override the default Historian data Path?

Choose a location.

FAGOEGIE R0l O\ Proficy Historian Data

Browse

Previous

4. If you are upgrading the Historian server on a passive node, an error message may appear behind
the installer screen, stating that the Archives directory is not created. You can ignore this message,

or you can make the node active before upgrading the Historian server.

1. If you have upgraded the Historian server, on all the cluster nodes:
a. Right-click the cluster, and then select Properties > Resource Types.
b. If the user-defined resource types are not available, select Add.
c. Select<Install ation folder of the Historian server>/x64/ Server/
Hi storian. dl | astheresource DLL path with Historian and AlarmArchiver as both the
resource type names and display names.
The Historian servers are now part of the cluster, thus achieving high availability. The remaining
steps are required only for first-time installation of the Historian server (not upgrade).
2. Access the primary node of the cluster.
3. Create a failover cluster.

4. Add a storage to the failover cluster.


https://docs.microsoft.com/en-us/windows-server/failover-clustering/create-failover-cluster#install-the-failover-clustering-feature
https://docs.microsoft.com/en-us/windows-server/failover-clustering/create-failover-cluster#create-the-failover-cluster
https://docs.microsoft.com/en-us/windows-server/failover-clustering/failover-cluster-csvs
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5. Add user-defined resource types, Historian and AlarmArchiver, to the cluster. These resources are

10.

11.

created when you install the Historian server.
a. Right-click the cluster, and then select Properties > Resource Types.
b. If the user-defined resource types are not available, select Add.
c. Select<I nstall ation folder of the Historian server>/x64/ Server/
Hi storian. dl | astheresource DLL path with Historian and AlarmArchiver as both the

resource type names and display names.

. Select Roles > Create Empty Role.

A role is created.

. Add the Historian application to the cluster:

a. Select the role.
b. In the Actions section, select Add Resource > Historian.

c. Follow the on-screen instructions to add the new Historian resource to the role.

. Add a client access point to the role:

a. Select the role.
b. In the Actions section, select Add Resource > Client Access Point.
c. Follow the on-screen instructions to add a client access point to the role.

. Add a storage to the role:

a. Select the role.
b. In the Actions section, select Add Storage.
c. Follow the on-screen instructions to add the storage that you have created in step 3. You
can use a storage only once.
Add the following dependencies to the Historian resource:

a. Double-click the Historian resource.

The Historian Properties window appears.
b. Select Dependencies.

c. Select Insert, and add the following dependencies using the AND operation.
= Client access point
= IP address

= Storage
Add the Alarm Archiver resource to the cluster:
a. Select the role.

b. In the Actions section, select Add Resource > Alarm Archiver.
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c. Follow the on-screen instructions to add the alarm archiver resource to the role.

d. Double-click the Alarm Archiver resource.

The Alarm Archiver Properties window appears.
e. Select Dependencies.

f. Select Insert, and then add the Historian service as a dependency. You do not need to add
the cluster disk and IP address as dependencies.

12. Add generic services.
a. In the Summary section of the Historian role, right-click the Client Manager resource, and
then select Properties > Dependencies.
b. Add the IP address as a dependency, and then select Apply.
c. Select General, select the Use Network Name for Computer Name check box, and then
select OK.
13. Repeat the previous step for the following services:
» Configuration Manager
o Diagnostics Manager
o Historian Embedded PostgreSQL Database
o Historian Embedded Tomcat Container
o Historian Indexing Service

The services appear under the Historian role.

& Failover Cluster Manager
File Action View Help
&= 2@ BE

- T £ oo~ id ) | o
3 Nodes Name Status Type Owner Node Priority Information &3 Configure Role.
4 Storage [55 New Role (®) Running Other cluster? Medium Virtual Machines..
4 Networks P

{4] cluster Events " Create Empty Role

View

(G Refresh
H Hep
New Role
= % StartRole
v [, New Role Prfeted Ouners: UserSettings | | oo
Name Status Information @ Add File Share
Other Resources # Move
= ) New Historian (® Onie % Change Startup Priority
< 1P Address (® Oniine & Information Details
Server Name 4] Show Critical Events
= . ®
% Name: clusterabc ® orine & Addstorage
&% IP Address: (® Online B AddR
= P esource
Roles
— E3 More Actions
= [ Historian Diagnostics Manager(e64) @ Onine x
- Remove
% IP Address. (@ Online p
N [Z] Properties
Storage
- N H Hep
= & Cluster Disk 2 (@ Onine
New Volume (E)
-
¥ NTFS 455 GB fre= of 50.0 GB
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14. Select the Historian role, and then in the Actions section, select Start Role.
The Historian servers are now part of the cluster, thus achieving high availability.

Set Up a Mirror of Mirror

1. Install Historian server (on page 44) on each machine that you want to use in the mirror of
mirror setup.

2. Set up Configuration Hub (on page ) on each machine that you want to use in the mirror of
mirror setup.

3. Add a system (on page ). The server that you specify while adding the system serves as the
primary server for the system.

4. Create data stores (on page ) in the primary server in the public/IT network with the same

name as the data stores in the primary server in your organization network.

You can set up a mirror of the Historian server in a network different from that of your organization. When
you do so, any tag/data update requests to the Historian server can be routed to the public and IT network

instead of your organization's network.

Note:

For the Historian Enterprise Mirror Architecture, only "Time based" archives are supported.

Single-Node Setup: The following image shows two networks - OT and IT - with a Historian server
installed in each network. These networks communicate using port 14000.

& OT Network IT Network
Collector 1 “ » Clientl
Data
Data Data

Collector 2 Change ™  Client2
Requests
Port: 14000 - Manager 2

Collector 3 » Client3

In this setup:

1. Server 1 is the primary server in the OT network; it stores data from collectors.
2. Server 2 is the primary server in the IT network; it is connected to clients.


unique_40
unique_40
unique_40
unique_41
unique_41
unique_41
unique_42
unique_42
unique_42
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3. When a tag/data is created, updated, or deleted, Client Manager 1 communicates the same with
Client Manager 2 (installed with Server 2 in the IT network).

4. The change in the tag/data is replicated in Server 2 (that is, data is created, updated, or deleted
accordingly).

5. The latest data is retrieved from Server 2 using the clients.
Mirror Setup: The following image shows two mirrors:

« Mirror 1 includes Mirror Server 1 and Mirror Node 1, which is a backup/standby node for Mirror
Server 1; both these machines are in the OT network.

« Mirror 2 includes Mirror Server 2 and Mirror Node 2, which is a backup/standby node for Mirror
Server 2; both these machines are in the IT network.

Client Manager 1 in Mirror Server 1 communicates with Client Manager 2 in Mirror Server 2.

0T Network (Mirror 1) IT Network (Mirror 2 —
Collector 1 » Client1
T Data Mirror Server 1 Data Mirror Server 2 Data
Collector 2 Change > Client2
Requests

Manager 1 Manager 2
Collector 3 » Client3

Mirror Node 1 Mirror Node 2

Client Client
Manager M1 Manager M2

If Mirror Server 1 goes down, Client Manager M1 in Mirror Node 1 communicates with Client Manager 2 in
Mirror Server 2.
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T Network (Mirror 1) IT Network (Mirror 2)
? X
» Client1
Mirror Server 2 Data
: > Client?2
Client
Manager 1
Data » Client3
Change
Collector 1 Requests|
Mirror Node 1
Data
Collector 2 Tlent
Manager M1 Manager M2
Collector 3

Similarly, if Mirror Server 2 goes down, Client Manager 1 in Mirror Server 1 communicates with Client
Manager M2 in Mirror Node 2.

0T Network (Mirror 1) IT Network (Mirror 2
Collector 1
_‘ Mirror Server 1
Data
Collector 2 Client
Manager 2
Data
Collector 3 CHange .
Reduests » Clientl
' Mirror Node1 | MirrorNode2 |NIRIIY
Client » Client?2
Manager M1 Manager M2
Client 3

If both Mirror Server 1 and Mirror Server 2 are down, Client Managers M1 and M2 communicate with each
other.
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OT Network (Mirror 1) IT Network (Mirror 2
Mirror Server 1 Mirror Server 2
Client Client
Manager 1 Manager 2
Collector 1 » Client1
“ Data o R Data ot INOEE Data
> Change - .
Collector 2 Requests —»  Client 2
Manager M1 Manager M2
Collector 3 » Client3

If Mirror Server 1 and/or Mirror Server 2 are available, the connection is re-established using these primary

servers.
OT Network (Mirror 1) IT Network (Mirror 2)
Collector 1 > Client1
T Data Mirror Server 1 Data or Serve Data
Collector 2 Change *  Client 2
Requests
Manager 1 Manager 2

Collector 3 » C(lient3

Mirror Node 1 Mirror Node 2

Client Client
Manager M1 Manager M2

Thus, you can choose to always retrieve data from either Mirror Server 2 or Mirror Node 2. In addition, the
store-and-forward functionality is available (in case Client Managers are not yet connected).

This topic describes how to set up a mirror of mirror for the configuration described in the preceding
example. It includes the following high-level steps:
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1. Installing the Historian server on all the machines
2. Setting up mirror 1

3. Setting up mirror 2

4. Setting up a mirror of mirror

Installing the Historian server

1. On the machines designated as the mirror primary servers (Mirror Server 1 and Mirror Server 2 in
the example), install the Historian server (on page 44). During the installation, select Historian
Mirror Primary Server on the Choose the type of install you want to perform page.

Choose the type of install you want to perform.

Historian Single Server
Historian Mirror Primary

Historian Distributed/Mirror Nod

Previous

2. On the machines designated as mirror nodes (Mirror Node 1 and Mirror Node 2 in the example),
install the Historian server (on page 44). During the installation, select Historian Distributed/

Mirror Node on the Choose the type of install you want to perform page.

Set up Mirror 1:
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3. On the mirror primary server in your organization's network (Mirror Server 1 in the example), access
Configuration Hub (on page ).

4. In the NAVIGATION section, under the Configuration Hub plugin for Historian, select Systems.
A list of systems appears in the main section.

5. Expand Mirror Server 1.

A list of servers in the system appears.

6. Select + .
Systern Historian Server
Filter Filter
8 000
Machine Name STATUS Archive Compre Write Cache Hit CONSUMPTION R Read Thread Usa ‘Write Thread Us Out Of
8 @ Connected 433 0s 0.45 0 0 ]
8 @ Not Cornected NA NA NA NA NA NA

The Add Server Machine: <system name> window appears.

7. Enter the host name or IP address of the mirror node in your organization's network (Mirror Node 1
in the example), and then select Add.
The distributed server is added to the system. A distributed location is added in the server.

8. Right-click Mirror Node 1, and then select Browse Locations.

System Historian Server

Filter Filter

a .
a[Q torsc-collectorsclient tarse -coller

Wiew Systern Performance

SERVERS Setas Default Systern + §§3
Add Server
Machine Mame ~chive Compres.. | Write Cache Hit R.. | COMSUMPTION R..  Read Thread Usa.. | Write Thread Usz
tnrs-tnlla[tnrs[l\ent Browse Collectors 55 0.5 0.33 4] 4]

collectnrscllens Browse Tags o MNA RE A (R

Erowse Locations

Browse Clisnts

Erowse Madel

A list of distributed locations in the system appears.
9. Select Mirror Locations.
A list of mirror locations in the system appears.

10. In the upper-right corner of the main section, select + .


unique_43
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The Add Mirror Location window appears.

11. Provide values as described in the following table.

Field

Description

MIRROR LOCATION NAME

Enter a name for the mirror location. A value is required and

must be unique for the system.

SERVER MACHINES

Select the servers that you want to add to the mirror group (Mir-
ror Server 1 and Mirror Node 1 in this example). This box con-
tains a list of all the servers in the system. You must add mini-

mum two servers to a mirror location.

12. Select Add.
Mirror Node 1 is created.

13. Right-click the system name, and then select Add Data Store.

The Add Data Store: Mirror Node 1 window appears.

14. Enter values as described in the following table.

Field Description
DATA STORE NAME Enter a unique name for the data store. A value is required. You can
use all alphanumeric characters and special characters except / \ * ?
<>|
You must provide the same name for the mirror setup in the IT net-
work (mirror 2 in the example).
DESCRIPTION Enter a description for the data store.

Set as default data store

for the system

Select this check box if you want to set this data store as the default
one. A default data store is the one that is considered if you do not
specify a data store while adding a tag. You can set only one data

store as default.

15. Select Add.
Mirror 1 is configured.

Set up Mirror 2:
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16.

17.

18.

19.

20.

21.

22.

23.

On the mirror primary server in the IT network (Mirror Server 2 in the example), access
Configuration Hub (on page ).

In the NAVIGATION section, under the Configuration Hub plugin for Historian, select Systems.
A list of systems appears in the main section.

Expand Mirror Server 2.
A list of servers in the system appears.
Select + .
sstem Historian Server

Fifter Filter

8 000

SERVERS b

Machine MName STATLIS Archive Cornpre Write Cache Hit CONSUMPTION R Read Thread Usa ‘Write Thread Us Out Of

8 @ Connected 433 0s 0.45 0 0 ]

=] @ Not Cornected NA& NA NA Ma NA& NA

The Add Server Machine: <system name> window appears.

Enter the host name or IP address of the mirror node in your organization's network (Mirror Node 2
in the example), and then select Add.

The distributed server is added to the system. A distributed location is added in the server.

Right-click the system name, and then select Browse Locations.

System Historian Server

Filter Filter

a . .
a[g torsc-collectorsclient torsc-collectarsclient

Wiew Systern Performance

SERVERS Setas Default Systern + §§3
Add Server
Machine Mame ~chive Compres.. | Write Cache Hit R.. | COMSUMPTION R..  Read Thread Usa.. | Write Thread Usz
tnrs-tnlla[tnrs[l\ent Browse Collectors 55 0.5 0.33 4] 4]

collectnrscllens Browse Tags o MNA RE A (R

Erowse Locations

Browse Clisnts

Erowse Madel

A list of distributed locations in the system appears.
Select Mirror Locations.

A list of mirror locations in the system appears.

In the upper-right corner of the main section, select + .
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The Add Mirror Location window appears.

24. Provide values as described in the following table.

Field Description

MIRROR LOCATION NAME Enter a name for the mirror location. A value is required and
must be unique for the system.

SERVER MACHINES Select the servers that you want to add to the mirror group (Mir-
ror Server 2 and Mirror Node 2 in this example). This box con-
tains a list of all the servers in the system. You must add mini-

mum two servers to a mirror location.

25. Select Add.
Mirror Node 2 is created.

26. Right-click Mirror Node 2, and then select Add Data Store.
The Add Data Store: Mirror Node 2 window appears.

27. Enter values as described in the following table.

Field Description
DATA STORE NAME Provide the same name that you provided while setting up mirror 1.
DESCRIPTION Enter a description for the data store.

Set as default data store | Select this check box if you want to set this data store as the default
for the system one. A default data store is the one that is considered if you do not
specify a data store while adding a tag. You can set only one data

store as default.

28. Select Add.
Mirror 2 is configured.

Set up Mirror of Mirror:

29. Access Configuration Hub in the primary server in the OT network (Mirror Server 2).

30. In the NAVIGATION section, under the Configuration Hub plugin for Historian, select Systems.
A list of systems appears in the main section.

31. Expand Mirror Server 1.
A list of servers in the system appears.

32. Select +.
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The Add Server Machine: <system name> window appears.

33. Enter the host name or IP address of the mirror server in the IT network (Mirror Server 2 in the
example), select the Set as Mirror of Mirror check box, and then select Add.
The distributed server is added to the system. A distributed location is added in the server.

34. In the NAVIGATION section, under the Configuration Hub plugin for Historian, select Systems.
A list of systems appears in the main section.

35. Expand Mirror Server 1.
A list of servers in the system appears. In the example, Mirror Server 1, Mirror Node 1, and Mirror
Server 2 appear.

A mirror of mirror is configured with one primary node and one mirror node each in the OT and IT
networks. As needed, you can add more mirror nodes in each network.

Upgrade the Historian Server
If any Historian applications or components are open, close them before upgrading the Historian server.

If you are upgrading from either Historian 6.0 Enterprise or previous releases of Historian 7.2 (including
any of the service packs), both Client Manager and Configuration Manager services will be removed.
However, this will have no impact on your data or use of Historian unless you intend to use a distributed
system.

Install the Historian server (on page 43).

The Historian server is upgraded to the latest version.

About Historian Log Files

Historian creates the following types of log files:

- The .IHA files: These files contain data about archives. They are created by the Historian server
after data collection begins. By default, these files are located in the C: \ Hi st ori an Dat a
\ Ar chi ves folder.

« The .IHC files: These files contain data about Historian configuration. They are created by the

Historian server. By default, these files are located in the C: \ Hi st ori an Dat a\ Ar chi ves folder.

There are two types of .IHC files:
°*Central Config.i hc: This is the master configuration file used by Configuration
Manager.
o*confi g.i hc: Thisis used by the data archiver and is generated from

*Central Config.i hc. This is to maintain consistency between Historian versions.
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« The .LOG files: These files contain logging data (such as events, warnings, and errors). They are
created by the archiver and the collectors. By default, they are located inthe C: \ Hi st ori an
Dat a\ LogFi | es folder.

- The .SHW files: These files contain configuration data. They are created by the archiver and the
collectors. By default, they are located in the C: \ Hi st ori an Dat a\ LogFi | es folder.

FAQs on Installing Historian in a Distributed Environment

- What happens when a node that was down is up and running? Is the data written to one node
synchronized with another?

There is no automatic synchronization. If a node is down, the information to be written is buffered
by Client Manager, or if Client Manager is down, it is buffered by the collector. When the node is up
and running, data is written to the data archiver.

There is only one Configuration Manager on the primary node. Can | still configure if the primary

node is down?

No. If the Configuration Manager is not available, you can read the configuration (because this
information is stored in the collectors), but you cannot edit or modify the configuration.

Is Configuration Manager a single point of failure?

Yes. If the primary node is down, you cannot edit the configuration. However, since information
about the configuration is stored in the registry of each client, the information is still available as
read-and-write-only when the primary node is down.

If the Configuration Manager service is down, you cannot query tags and data in a horizontally
scalable system. However, you can query tags and data in the following scenarios:
> The Historian system contains only one node, which is installed as the primary mirror
Historian server.
> The Historian system contains only one mirror location, and there are no data stores in the
distributed locations.

What happens if a node crashes in the middle of a read/write request?

The operation continues to function in the same way as in prior releases. Client Manager holds
a copy of the message request; therefore, once the node is up and running, the write operation is

resumed. However, read requests will fail.

« The server where my primary node is installed is down. What is the expected behavior?
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The Web Admin console and Trend Client will not be available; you can access tag configuration
using Historian Administrator, but you will not be able to edit tag configuration. All other existing
clients continue to work as expected, with the ability to collect and store data, search for tags,
trend and report on tag information. A new user connection with default Historian server set to
primary must connect to the primary node to get information about all the nodes before it gains the
ability to automatically failover when the primary node is down.

Client Manager on the primary node is down, but the server is running. What is the expected
behavior?

The Web Admin console and Trend Client, along with all other existing clients, will work as
expected with the ability to do configuration changes, collect and store data, search for tags, trend
and report on tag information. A new user connection with default Historian server set to primary
must connect to the primary node to get information about all the mirrors before it gains the ability
to automatically failover when the primary node is down.

One of the data archivers is down, but at least one is active. What is the expected behavior?

The system should continue to function as designed. The Web Admin console, Trend Client,
Historian Administrator, as well as other clients continue to work as expected, with the ability to
collect and store data, search for tags, trend and report on tag information.

If there are calculated tags in a distributed environment, are the calculations done on all nodes?

Yes.

Are Historian tag statistics created independently? Can they be different between different nodes?

Yes. These are queries, not tags, to a specific data archiver. As writes are independent, one data
archiver may be ahead of another, so the statistics may vary slightly.

How do we ensure that the data is consistent across data archivers?

Tag information is consistent; there is only one tag. The time stamp and value are sent to all the
nodes.

Are there specific log files that | should be looking for to help diagnose issues with failure modes?
No changes were made to the logs for data archiver; however, there are new log files for Client
Manager and Configuration Manager.

* There are now two *. i hc files: *conf i g. i hc and * Cent r al Confi g. i hc. What is the difference

between the two?
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*Cent ral Confi g.i hc is the master configuration file used by Configuration Manager. The
*confi g. i hc file is used by the data archiver and is generated from *Cent r al Confi g.i hc.
This is to maintain consistency between Historian versions.

With mirroring, is Microsoft Cluster Server still supported? What is the recommended approach?
Mirroring is offered as a substitute to Microsoft Cluster Server. Mirroring provides high availability

for locations. Microsoft Cluster Server has not been tested or validated to date with Historian
systems.

Should | install SQL server in a distributed environment?

No. SQL server is only required for the Historian Alarms and Events database.

How does mirroring work with Historian Alarms and Events SQL logging?

There is still an alarm archiver; it does not go through Client Manager, so it connects with SQL as
earlier.

How does Historian Alarms and Events fit with their synching?

There is one database, so everyone talks to the same SQL database. You can cluster the database,
but that is separate from mirroring.

How does mirroring work in a workgroup environment or non-domain?

Mirroring is not supported in Workgroups.
Are there any issues when making changes in Historian Administrator and a mirrored system?
You must establish a mirror using the Historian Configuration Hub, but compatibility with all APIs

has been maintained. Therefore, you can make tag changes in either the Web Admin or the VB
Windows Admin, and those changes will show up in both Admins.

Are there any plans to add more than three mirrors?

No performance benefits have been seen beyond three mirrors.

Do redundant collectors behave differently in a distributed environment?

No.

Are there any conflicts when using port 14000 for Historian to Historian communications (for
example, Site to Corporate)?

No. Client Manager is now on port 14000, data archiver is on port 14001, and Configuration

Manager is on port 14002.
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- If load balancing uses round robin reads, does the cache need to be loaded separately on both

machines, and will it decrease performance?

It does require more memory. Client Manager decides where to send the messages, and it knows
about the configuration. There is some overhead, but it is overcome by having multiple data
archivers to service multiple requests. That is why there is a 1.5X improvement with two mirrors,
instead of 2X.

- Are there any additional considerations if a distributed system is used with other GE applications
such as Workflow or Plant Applications?
No. It still looks like one Historian to other applications.

« Is the store-and-forward feature also used in a distributed environment?
Yes. This is a feature of the collector. Once the message is sent to Client Manager, it is done. If the

Client Manager cannot reach one of the data archivers, it buffers the request until the archiver is
available.

« In a distributed environment, do existing queries and reports work the same?
Yes. Everything works the same as it did before. It sees it as a single Historian and communicates
over the same ports through the same API.

» Does the Historian OPC Classic HDA server still work in a distributed environment?

Yes.

- If data is being written to two data archivers, does this double the traffic from the collector?

No. It does not double traffic from the collector; it sends a single message to Client Manager. The

traffic is doubled between the Client Manager and the two data archivers.

Register with Configuration Hub

Ensure the following:

« Installed Web-based Clients (on page 93), specifying the details of the new Proficy
Authentication and Configuration Hub servers.

The Historian server and Web-based Clients must always point to the same Proficy Authentication server
and Configuration Hub server. Only then you can access Web-based Clients (such as Configuration Hub,
Trend Client, the Web Admin console, and REST APIs), and also view Historian license information on
Configuration Hub. Therefore, you can use the Proficy Authentication Tool in the following cases:
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- If you changed the Proficy Authentication server used by Web-based Clients, the Historian server
must point to the same Proficy Authentication and Configuration Hub servers.

« If you did not select the Use existing Proficy Authentication and Configuration Hub Instance
during the Historian Server, and now you want to register with the Proficy Authentication and
Configuration Hub servers to use the Historian Web-based clients and view Historian license

information on Configuration Hub.

This topic describes how to register the Historian Server with the Proficy Authentication server and

Configuration Hub server without the need to reinstall it.

1. Access the UAAConf i gur at i on. exe file. By default, it is located at <I nstal | Dri ve>:

\ Program Fi |l es\ Proficy\Proficy Historian\x64\Server.

Alternatively, you can search for the Proficy Authentication Tool in the Windows search bar and

open it.

The Proficy Authentication Configuration tool window appears, displaying the Proficy

Authentication server details that you specified while installing the Historian server. Also, it allows

you to specify the Configuration Hub server details.

. In Proficy Authentication Server Details, provide the following details as described in the table

below.
Field Description
Proficy Au- Enter the name of the machine on which the Proficy Authentication server is in-

thentication

server name

stalled. If the machine uses a fully qualified domain name (FQDN), provide the

FQDN. By default, the local hostname is considered.

thentication
Test Connec-

tion

Public https | Enter the port number used by the Proficy Authentication service. The default

port value is 443. Ensure that this port number matches the one on the TCP Port As-
signments page during Web-based Clients installation.

Admin Client | The client ID to connect to the Proficy Authentication service.

Id

Admin Client | The password to connect to the Proficy Authentication service.

Secret

Proficy Au- Option to test the status of the connection with external Proficy Authentication

server.
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3. In Configuration Hub Server Details, provide the following details as described in the table below.

Table 5.
Field Description
Configu- The server name or the FQDN of the existing Configuration Hub server, as dis-

ration Hub played in the address bar of the browser when you access Configuration Hub from

server name |the machine where Configuration Hub is installed.

Configu- The web server (https) port that you want to use for Configuration Hub. By default,
ration Hub it is 5000.

Public https

port

Configu- Option to test the status of the connection with an existing Configuration Hub

ration Hub server.
Test Con-

nection

4. Select Configure.
The Proficy Authentication server and Configuration Hub details are updated for the Historian
server. The changes are reflected as soon as you refresh the browser in which you have opened
any of the Web-based Clients components (such as Configuration Hub, the Web Admin console,
Trend Client).

If testing the connection fails, try these steps:

« Verify that you can ping the Proficy Authentication server. If you cannot ping the Proficy
Authentication server, add the IP address and the server name in the host s file located in C:
\ W ndows\ SystenB2\ dri vers\etc.
- Ensure that the following services are running on the Proficy Authentication server machine:
o Proficy Operations Hub Httpd Reverse Proxy
o Proficy Authentication Tomcat Web Server
o All the GE Proficy Configuration Hub services
« Verify that the Proficy Authentication server details provided during Web-based Clients installation

match the ones you have specified in the Proficy Authentication Configuration tool.

Historian Installation Limitations
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« You cannot close your current archive with a Historian Mirror Primary Server and Historian Mirror
Node installation. This is because closing the current archive introduces archive synchronization
risks in a mirrored environment. The restriction is enforced on all Historians, even those not using
mirroring.

* You cannot use size-based archives with a Historian Mirror Primary Server and Historian
Mirror Node installation. This is because having archives of different sizes introduces archive
synchronization risks in a mirrored environment. The restriction is enforced on all Historians, even

those not using mirroring.

Alarms and Events

Install Alarms and Events

* You must install Historian Alarms and Events on the same machine as the data archiver.
« If you have chosen to connect Historian to a remote SQL server, the following conditions must be
satisfied:
> The Historian Alarm Archiver service must be run on a user account that has privileges to
log in to the SQL server using Windows authentication.
> The default backup path, which you can set on the Archive page, must be a shared directory
that is accessible to both the Historian Data Archiver and the remote SQL server. It is
recommended that this shared directory be placed on the same computer as the Historian

Data Archiver service.

1. Runthe | nst al | Launcher . exe file.
2. Select Install Alarms and Events.

The Alarms and Events Archiver page appears.
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Proficy Historian Setup Maintenance X
Alarm and E vent Archiver gm
Specify SUL server database details for archiver. | - —

The Alaim and Ewvent archiver require access to SOL Server,

Server Name

Database Name AED atabase

Admin User &8 |  Password
< Back Neut > Est

3. If needed, change the values in the Server Name and Database Name fields to provide the name of
the SQL server and the name of the database where the alarms and events data is archived.

4. If you want to use the SQL server credentials, clear the Use Windows Authentication check box,
and then enter the SQL server login credentials in the Admin User and Password fields. If you want
to use Windows authentication, select the Use Windows Authentication check box. When you do
so, the Admin User and Password fields are disabled.

5. Select Next.

6. When prompted to restart your system, select Yes.

Historian Alarms and Events is installed in the following folder: <i nstal | ati on dri ve>:
\ Program Fil es\ Proficy\Proficy Hi storian\x86\ Server, and the following registry
path is created: HKEY LOCAL_MACHI NE\ SOFTWARE\ WOW6432Node\ Intel I ution, Inc.

\i H storian\Services\ Al ar mr chi ver
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7. To verify that the Alarms service has started, access the Services window, and check the status of
the Historian Alarm Archiver service.
If the Startup Type field is set to Automatic, the service is started automatically when the system is

started or restarted.

Upgrade Alarms and Events

- If Alarms and Events were installed prior to Historian 7.0, you must install them separately.

- If you want to upgrade from Historian 4.5, since the database schema are different, if you select
the same database name that is pre-populated by default, you will get an error message: Lat er
or Hi gher version of Alarns and Events database is already installed. Hence, you cannot

proceed further. You need to enter a different database name and then proceed with the upgrade.

Install Alarms and Events (on page 79).
Alarms and Events are upgraded to the latest version.

About Installing Historian Data Collectors

When you install collectors, the required binaries are downloaded. In addition, if iFIX/CIMPLICITY are
installed on the same machine as the collectors, instances of the following collectors are created:

* The iFIX collector

 The iFIX Alarms & Events collector

» The OPC Classic Data Access collector for CIMPLICITY

» The OPC Classic Alarms and Events collector for CIMPLICITY

If an iFIX collector instance created in version 9.0 exists, after you upgrade collectors, another instance of
the iFIX collector is created. Because of this, the Remote Collector Manager (RCM) will not work correctly.
Therefore, if you want to use RCM, you must delete one of the instances. If needed, you can manually

create another instance of the iFIX collector using Configuration Hub or the RemoteCollectorConfigurator

utility. This is applicable to the iFIX Alarms and Events collector as well.

(g N
Note:
If you want to upgrade collectors earlier than version 7.1, additional registries that you create
manually are deleted. Therefore, we recommend that you back them up, uninstall the collectors,

and then install the latest version.
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Install Collectors Using the Installer

After you install collectors, the following artefacts will be available:

- Executable files: These files are required to add a collector instance.
- Instances of the following collectors:
> The iFIX collector
o The iFIX Alarms & Events collector
> The OPC Classic Data Access collector for CIMPLICITY
> The OPC Classic Alarms and Events collector for CIMPLICITY
These instances will be created only if iFIX and/or CIMPLICITY are installed on the same machine
as the collectors.
- The Remote Collector Management agent: Provides the ability to manage collectors remotely.

1. Runthe I nst al | Launcher . exe file.

2. Select Install Collectors.
The welcome page appears.

3. Select Next.
The license agreement appears.

4. Select the Accept check box, and then select Next.
The default installation drive appears.
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Where to install the Historian Collector(s)?

Choose an available disk.

Previous

5. If needed, modify the installation drive, and then select Next.
The data directory page appears.
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Data Directory

DEVCHN Iyl 0\ Proficy Historian Data

Previous

6. If needed, change the folder for storing the collector log files, and then select Next.

The destination Historian server page appears.
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Historian Server Details

Provide a valid windows user of the default Historian server to which the
Remote Collector Manager will connect.

Historian Server:
User Name:
Password:

Confirm Password:

Mote: If you have created security groups or enabled strict client/eollector authentication, provide
the destination Historian credentials.
If the password changes, you must reinstall Remote Management Agents to resetthe password.

Previous

7. Provide the credentials of the Windows user account of the destination Historian server to which

you want Remote Management Agent to connect.

These details are required for Remote Collector Manager to connect to Historian to manage the
collectors remotely. If you are installing collectors on same machine as the Historian server, and

if strict collector authentication is disabled, you need not provide these details; by default, the
machine name of the local Historian server is considered. If, however, they are installed on different
machines, or if strict collector authentication is enabled, you must provide the credentials of the

Historian server user.

8. Select Next.

The You are ready to install page appears.
9. Select Install.

The installation begins.

10. When you are prompted to reboot your system, select Yes.
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The collector executable files are installed in the following folder: <i nst al | ati on dri ve>:\ Program
Files (x86)\GE Digital\<collector nane>. TheiFIX collectors are installed in the following
folder: C: \ Program Fi | es\ GE\ i FI X. The following registry paths are created:

* HKEY_LOCAL_MACHI NE\ SOFTWARE\ WOW5432Node\ GE Digital \i Hi storian\ Services
\ <col | ector type>
* HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE Di gi tal \i Hi storian\ Servi ces\<col | ector

type>

In addition, if iFIX and/or CIMPLICITY are installed on the same machine as the collectors, instances of

the following collectors are created:

* The iFIX collector

« The iFIX Alarms & Events collector

» The OPC Classic Data Access collector for CIMPLICITY

» The OPC Classic Alarms and Events collector for CIMPLICITY

Installing a Collector at a Command Prompt

After you install collectors and Remote Management Agent, the following artefacts will be available:

- Executable files: These files are required to add a collector instance.
- Instances of the following collectors:
> The iFIX collector
> The iFIX Alarms & Events collector
> The OPC Classic Data Access collector for CIMPLICITY
o The OPC Classic Alarms and Events collector for CIMPLICITY
These instances will be created only if iFIX and/or CIMPLICITY are installed on the same machine
as the collectors.

» The Remote Collector Management agent: Provides the ability to manage collectors remotely.

Using Configuration Hub, you will then add a collector instance and begin using the collector.
This topic describes how to install collectors at a command prompt. You can also install them using the

installer (on page 82).

1. Navigate to the Col | ect or s folder in the installation folder.
2. At a command prompt, enter:
Col l ectors_Install.exe -s RootDrive=<val ue> Desti nati onServer Nane=<val ue>

Dat aPat h="<val ue>" User Nanel=<val ue> Passwor d=<val ue>
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Parameter Description Default Value
RootDrive The installation drive for the C\
collectors.
DataPath The folder for storingthe col- |C:\ Proficy Historian
lector log files. Dat a
DestinationServerName The host name of the destina- |local host name

tion Historian server to which
you want collectors to send da-
ta.

This is required for Remote
Collector Manager to connect
to Historian to manage the col-
lectors remotely. If you are in-
stalling collectors on the same
machine as the Historian serv-
er, and if strict collector au-
thentication is disabled, you
need not provide the server
name; by default, the machine
name of the local Historian
server is considered. If, howev-
er, they are installed on differ-
ent machines, or if strict collec-
tor authentication is enabled,
you must provide the creden-
tials of the Historian server

user.

UserNameT The username of the Windows
user of the destination Histori-
an server. A value is required
only if the destination Histori-
an server and collectors are on

different machines.
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Parameter Description Default Value

Password The password of the Windows
user of the destination Histori-
an server. A value is required
only if the destination Histori-
an server and collectors are on

different machines.

For example: Col | ectors_Instal | .exe -s RootDrive=C:\ DestinationServer Nane=nyser ver nane
Dat aPat h="C: \ Proficy Historian Data" UserNanel=user 123 Passwor d=xyz123
3. Restart the machine. If you uninstall a collector or install another one before restarting the

machine, an error may occur.

The collector executable files are installed. In addition, if iFIX and/or CIMPLICITY are installed on the

same machine as the collectors, instances of the following collectors are created:

* The iFIX collector

« The iFIX Alarms & Events collector

» The OPC Classic Data Access collector for CIMPLICITY

» The OPC Classic Alarms and Events collector for CIMPLICITY

1. Ensure that the Windows user that you have specified while installing collectors is added to the iH
Security Admins and iH Collector Admins groups.

2. Enable trust for a client certificate for Configuration Hub.

3. Enable trust for a self-signed certificate on Chrome (on page 36).

4. Import an issuer certificate.

You are now ready to use Configuration Hub. To add and manage collector instances, you can use
Configuration Hub or Remote Collector Management. For instructions specific to setting up the iFIX
collector and the iFIX Alarms and Events collector, refer to Working with iFIX Collectors.

Upgrade Collectors

« Ensure that you are attempting to upgrade the collectors that were installed using the Historian
Installation Package. If you previously installed the collectors using the Proficy Installer, such as
the iFIX Proficy Installer, you must upgrade the collectors using the Proficy Installer only.

- If an iFIX collector instance created in version 9.0 exists, after you upgrade collectors, another
instance of the iFIX collector is created. Because of this, the Remote Collector Manager (RCM)


https://www.ge.com/digital/documentation/confighub/version2024/g_confighub_client_certificates.html
https://www.ge.com/digital/documentation/opshub/windows/windows/t_import_certificate.html
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will not work correctly. Therefore, if you want to use RCM, you must delete one of the instances. If
needed, you can manually create another instance of the iFIX collector using Configuration Hub or
the RemoteCollectorConfigurator utility. This is applicable to the iFIX Alarms and Events collector
as well.

« For collectors earlier than version 7.1, additional registries that you create manually are deleted.
Therefore, we recommend that you back up them, uninstall the collectors, and then install the latest

version.

Install the collectors (on page 817).

The collectors are upgraded to the latest version.

Client Tools

Install Client Tools

When you install Client Tools, the following components are installed by default:

« Client Tools

« Historian Administrator

« OLE DB provider (driver and samples)
 The OPC Classic HDA server

* User APl and SDK

« Historian Client Access API

« Collector Toolkit

This topic describes how to install Client Tools using the installer. You can also install it at a command

prompt (on page 92).

1. Runthe I nst al | Launcher . exe file.
2. Select Install Client Tools.
The Select Features page appears, displaying a list of components that you can install with Client

Tools.
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Select Features W

Select the features setup will install. l -

Check new components you want to install or uncheck components you want to remove.

BN Historian Excel Add-in 64 bit py| D EsEiE

-[w| Hiztarian Administratar Excel Add-in for Proficy
-8 Praficy Historian Client Tools Histarian &4 bit
—|-w|OLE DB

----- OLE DB Driver

----- OLE DE Samples
W] HDA Server

—|-[w] U zer &P

L™ User API Runtime

----- zer AP SDK h
36.56 MB of space required on the C drive
21911 .45 MB of space available on the C dive

< Back " Mext = || Cancel

By default, the check boxes for components such as Historian Administrator, HDA Server, OLE DB,
and User API and SDK are selected. If you do not want to install them at this time, clear the check

boxes. You cannot, however, clear the Proficy Historian Client Tools check box.

! Important:
If you are reinstalling, you must select all of the previously installed components. If you do

not do so, the component will be uninstalled.

By default, the Historian Excel Add-in 64-bit check box is cleared. If you want to install Excel Add-
In along with Client Tools installation, select the check box.

(L M
Note:
If using certain versions of Windows (like Windows 10 or Windows 2019), you may receive
an error message while installing Excel Add-In, stating that some of the DLL files are not

registered. You can ignore these messages.
N /

The Historian Server Security page appears.
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Proficy Historian Setup Maintenance -

Hiztonian Server Security

Pravide the uzer account that should be granted access to administer Higtarian,

.«

Praficy Hiztarian implements uger authaonization to control access to data, configuration and adminiztration,

By default, all local accountz on this server and any domain accounts [if part of a domain] have full,
adrinistrator-level access to the Historian server.

R efer to the “"Hiztarian Security Groups' tapic in the Historian Electronic Books for documentation on contralling
access to the Historian server.

(™) Al Uzers

() Specific Uszer

All local [and domain] user accounts will have full, administrator access of the
Historian server If necessam, securty groups can be configured after inztall to
control access.

Orly the following uzer will have full, administrative access of the Hiztorian server.
Dther users may be granted restricted or administrator access post install,

< Back MHext = Cancel

3. Select the user account that should be granted the access to administer Historian.

You are provided with the following options:

Option

Description

All Users

If you select this option, all local, including do-
main user accounts will have the administra-
tor access of the Historian server. If needed,
to control access, you can configure security
groups after installation.

Specific User

If you select this option, the user that you select
will have the administrator access of the Histo-
rian server. If needed, you can grant a restricted
or administrator access to other users after in-
stallation.
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4. Select Next.
5. When you are asked to reboot your system, select Yes.

Client Tools, along with the selected components, are installed in the following folder: <i nst al | ati on
drive> \Program Fil es\ Proficy\Proficy Historian\x86\<tool nane>.Ifyouhave
selected HDA Server, Microsoft .NET Framework 4.5 and the OPC Core Components 3.00 redistributable

are installed as well.

Install Client Tools at a Command Prompt

1. If you want to install Excel Add-In for Historian, install one of the following 32-bit or 64-bit
Microsoft® Excel® applications:
> Microsoft® Excel® 2019
> Microsoft® Excel® 2016
> Microsoft® Excel® 2013
> Microsoft® Excel® 2010
2. Install Client Tools using the installer (on page 89) on a machine. When you do so, a template
file named set up. i ss is created at C: \ W ndows. This file stores the installation options that
you have provided. You can then use this template to install Client Tools at a command prompt on

other machines.
When you install Client Tools, the following components are installed by default:

« Client Tools

* Historian Administrator

» OLE DB driver and samples
 The OPC Classic HDA server
« User APl and SDK

« Historian Client Access API

« Collector Toolkit

1. Copy the set up. i ss file to the machine on which you want to install Client Tools at a command
prompt.
2. In the folder in which you have copied the file, run the following command: set up. exe /s /sns

The installer runs through the installation steps.
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(L N
Note:
If using certain versions of Windows (like Windows 10 or Windows 2019), you may receive
an error message, stating that some of the DLL files are not registered. You can ignore

these messages.
N /

3. When prompted to reboot your system, select Yes.

Client Tools are installed.

If you have installed Excel Add-in, activate it (on page 136).

About Installing Web-based Clients

Using Web-based Clients, you can configure and manage Historian systems and their components using a

browser.

When you install Web-based Clients, you can install the following components:

- Configuration Hub: Allows you to manage Historian systems and its components. You can set up
stand-alone as well as horizontally scalable systems. You can also add collector instances and
manage them.

« Trend Client: Provides access to process and equipment data, allowing you to quickly troubleshoot
and make improvements, leading to time and cost savings through the use of trend charts and
current value tables.

- The Web Admin console: Allows you to monitor, supervise, archive, retrieve, and control data
gathered from Historian systems.

« The Proficy Authentication service (optional): Provides identity-based security for applications
and APIs. It supports open standards for authentication and authorization, including Oauth2.
You can install Proficy Authentication and Configuration Hub, or you can point to existing Proficy
Authentication and Configuration Hub instances.

« Rest APIs: Allow you to query data from a Historian server.

You can install Web-based Clients using a GUI-based installer (on page 94) or at a command prompt

(on page 110).

! Important:
When you install Web-based Clients:
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- If you want to reinstall the same version of Web-based Clients, you must uninstall and then
install Web-based Clients.

« If, even after installing Web-based Clients, you cannot access a web component, start the
Proficy Operations Hub Httpd Reverse Proxy and the Data Archiver services.

Install Web-based Clients Using the Installer

1. Install the Historian server (on page 44). During the installation, in the Register with
Configuration Hub page, select the Use existing Proficy Authentication and Configuration Hub
Instance check box, and the provide the Proficy Authentication server and Configuration Hub server
details.

- ™
Note:
This step is needed only in the following cases:
> The Historian Server and the Web-based clients will be on two different machines.
> You already installed Proficy Authentication and Configuration Hub, and you want
use the Historian Web-based clients and view the Historian license information on
Configuration Hub.

If you do not select the Use existing Proficy Authentication and Configuration Hub
Instance during the installation, to use the Historian Web-based clients and view
the Historian license information on Configuration Hub, you must use the Proficy
Authentication Tool (on page 76) to register with Proficy Authentication and
Configuration Hub servers.

If you do not have Proficy Authentication and Configuration Hub installed, and
you intend to use the Historian Web-based clients and view the Historian license
information on Configuration Hub, you can install them while installing the Web-
based clients.
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Register with Configuration Hub

By registering, you'll be able to work with Historian web-based clients, and you can also view Historian license
information on Configuration Hub.

B Use existing Proficy Authentication and Configuration Hub Instance

If the above box is not selected, you'll need to use the Proficy Authentication Tool from the Start
Menu after installing Proficy Authentication and Configuration Hub.

Check the "Register with Confisuration Hub” section in the Online Help for more information.

Mote: If you install Historian Web-based clients and Historian Server on one machine, you can skip
this step, and no additional steps are needed after installation.

Previous

2. If you want to use Web-based Clients in a cluster environment, ensure that your network is enabled

for multicast traffic, and set up high availability on each node in the cluster.

This topic describes how to install Web-based Clients using a GUI-based installer.
You can also install Web-based Clients using the command line.

During the installation, you can choose to use Web-based Clients in a cluster environment, thus ensuring

high availability of connection to the Historian server using the client applications.

1. Runthe I nst al | Launcher . exe file.
2. Select Install Web-based Clients.
The welcome page appears.
3. Select Next.
The license agreement appears.
4. Select the Accept check box, and then select Next.

The TCP port assignments page appears.


https://www.ge.com/digital/documentation/historian/version2024/t_set_up_high_availability_of_wc.html
https://www.ge.com/digital/documentation/historian/version2024/c_installing_web-based_clients_using_the_command_line.html
https://www.ge.com/digital/documentation/historian/version2024/c_installing_web-based_clients_using_the_command_line.html
https://www.ge.com/digital/documentation/historian/version2024/c_installing_web-based_clients_using_the_command_line.html
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TCP port assignments

Public https port:

Proficy Authentication http port:
Proficy Authentication database port:
Historian http port:

Historian database port:

Previous

5. As needed, change the values for TCP port assignments as described in the following table, and
then select Next.

Field Description

Public https | Port for https protocol communication used by Web-based Clients (through a fire-
port wall). The default value is 443. Ensure that this port number matches the one you
specify while installing the Historian server. In addition:
o If you will install Operations Hub later on the same machine, the value that
you provide in this field is populated while installing Operations Hub.
o If you have already installed Operations Hub on the same machine, this
field is disabled and populated with the value you have provided while in-

stalling Operations Hub.

Proficy Au- | Port for http protocol communication used by the Proficy Authentication service.
thentication | The default value is 9480.
http port
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Field Description

Proficy Au- | Port for the Proficy Authentication database. The default value is 9432.
thentication
database

port

Historian Port for the http protocol communication used by Web-based Clients. The default

http port value is 8070.

Historian Port for the PostgreSQL Historian database. The default value is 8432.

database

port

The Fully Qualified Domain Name(s) page appears.
o If you will install Operations Hub later on the same machine, the value that you provide in the
FQDNs field is populated while installing Operations Hub.
o If you have already installed Operations Hub on the same machine, the FQDNs field is

disabled and populated with the value you have provided while installing Operations Hub.

Fully Qualified Domain Name(s).

To dllow users to access Historian web applications remotely using fully
qualified domain names (FQDN), please list one or more here, separated
by commas. Otherwise, you may leave this blank.

Previous
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6. In the FDQNs field, enter the fully qualified domain names, and then select Next.
This enables you to access Historian web applications remotely. You can use it to access the Web
Admin console using alias names. Enter the values separated by commas.
To access the Web Admin console using any of the following URLSs, enter
Test. abc. ge. com | ocal host, 127. 0. 0. 1, al i asNane
o https:// Test.abc.ge.com /historian-visualization/hwa
o https:// 127.0.0.1 /historian-visualization/hwa
o https:// aliasName /historian-visualization/hwa

o https:// localhost /historian-visualization/hwa

! Important:
> Do not enter a space between the values.
> You must add the IP address and alias name in the host s file located at C:
\ W ndows\ Syst enB2\ dri ver s\ et c. The IP address that you add must be a
static or fixed IP address.

Format: <I P address> <al i as nane>

Example: 1. 2. 3. 4 nyserver nanme

> FQDN is not supported for Configuration Hub.

The Cluster Configuration page appears.


https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
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Cluster Configuration

Want to configure this as Cluster Node?

Mote: Select above check box if you want to install Web-based Clients in a cluster environment for
achieving high availability.

Previous

If, however, you are upgrading Web-based Clients, this page does not appear. In that case, skip the
next step.
7. If you want high availability of Web-based Clients, select the Cluster Node check box, and enter

values as described in the following table.

Field Description

Historian Database Folder Provide the database folder in the shared dri-
ve that you have created. The default value is
C: \ Progr anDat a\ GE\ Oper at i onsHub. You
must change this value.

Cluster FQDN Enter the client access point of the role for
which you have added the resources while set-
ting up high availability (on page 121).

Multicast Address If needed, modify the common IP address that
all the nodes in the cluster can use. Enter a val-
ue between 224.0.0.0 and 239.255.255.255
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Field Description

(or a hostname whose IP address falls in this
range).The default value is 228.0.0.4.

Historian Cluster Membership Port If needed, modify the common port number
that all the nodes in the cluster can use. The de-
fault value is 45564. This port number, in con-
junction with the multicast address, is used to

create the cluster.

Historian Cluster Receiver Port If needed, modify the multicast port number
that you want to use for incoming Historian da-
ta. The default value is 4000.

8. Select Next.
The Proficy Authentication page appears, allowing you to choose whether you want to install
Proficy Authentication along with Web-based Clients installation or use an existing Proficy

Authentication.

Proficy Authentication

Use Existing Proficy Authentication: |l

Re-enter Secret:

Mote: The default Client ID is <adminz. As the admin Client is highly privileged, choose a strong
secret and safekeep it

Mote: The username to login to Historian web-based clients is < .adminz. This is case-

Previous
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o If you want to install Proficy Authentication, clear the Use Existing Proficy Authentication
check box. If you want to include Proficy Authentication in the cluster, you must install
Proficy Authentication locally on each cluster node.

o If you want to use an existing Proficy Authentication server, select the Use Existing Proficy
Authentication check box. Proficy Authentication is detected if you installed it using a
unified installer or Operations Hub, or if Historian uses Proficy Authentication installed
remotely from an earlier version.

9. If you want to install Proficy Authentication, enter the Admin client secret, re-enter the secret, and
then select Next.
The admin client secret must satisfy the following conditions:
o Must not contain only numbers.
> Must not begin or end with a special character.

> Must not contain curly braces.

o I
Note:
The format of username for Historian Web-based Clients is <host name>.admin, where
<host name> is the machine on which Web-based Clients are installed. And, the default

client ID is admin. Both the host name and client ID are case-sensitive.

If, however, the Proficy Authentication server hostname is long, resulting in a username
longer than 20 characters, Windows does not allow you to create the user. In that case, you
can create a Proficy Authentication user, and then create the corresponding Windows user,
using the uaa_config_tool utility.

- J

10. Alternatively, if you want to use an existing Proficy Authentication service (that is, a Proficy
Authentication instance already installed by an external application such as Operations Hub):

a. Select the Use Existing Proficy Authentication check box.
The fields for the existing Proficy Authentication service appear.



https://www.ge.com/digital/documentation/historian/version2024/t_hgs_using_the_uaa_config_tool.html
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Proficy Authentication

Use Existing Proficy Authentication:

Proficy Authentication Base URL:

Admin Client ID:

Admin client Secret:
| ith E Te

pending;

Note: Ensure to provide the highly privileged admin Client 1D which was created while installing
Proficy Authentication Server.

MNote: The username to login to Historian web-based clients is = t.adminz. This is case-
sensitive.

Previous

b. Enter values as described in the following table.

Field

Description

Profi-
cy Au-
thenti-
cation
Base
URL

Enter the URL of the external Proficy Authentication server in the following for-
mat: https://<Proficy Authentication server name>:<port number>, where <Proficy
Authentication server name> is the FQDN or hostname of the machine on which
Proficy Authentication is installed. By default, the port number is 443.

Note:

Do not enter a trailing slash character.

Admin
Client
ID

Enter the client name that you provided while installing the external Proficy Au-

thentication. The default value is admin.

Admin
Client
Secret

Enter the client secret that you provided while installing the external Proficy Au-

thentication.
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c. Select Test Connection.
The results of the connection test appear. You cannot proceed until the connection is

successful.

11. Select Next.
The Configuration Hub Installation page appears, allowing you to choose whether you want to

install Configuration Hub along with Web-based Clients or use an existing Configuration Hub.

Configuration Hub Installation

Use Existing Configuration Hub: [l

Install Location: C:\Program Files (x361\GE\

Plugin-Mame: Historian_

Server Port:
Container Port:
ConfigHub Admin Port:

Client 1Dz

Client Secret:

Re-enter Secret:

Mote: Credentials used here are needed for registering other products with this Configuration
Hub. Make sure to save these credentials for future registrations and upgrades to Configuration
Hub,

Cancel Previous

Configuration Hub allows you to add and manage a collector instance remotely. For more
information, refer to About Configuration Hub.

If, however, an earlier version of Configuration Hub is available on the same machine, you will be
prompted to enter the details of the existing Configuration Hub, and it will be upgraded to the latest
version. If that happens, skip the next step.


https://www.ge.com/digital/documentation/historian/version2024/c_about_enterprise_historian.html
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Important:

By default, Configuration Hub points to the same Proficy Authentication server as the

one you provided during the Historian server installation. If you want to install Web-based

Clients in a cluster environment, ensure that:

> Configuration Hub does not use the same Proficy Authentication server as that used

by the cluster.

> The Proficy Authentication and Configuration Hub details must be the same for all

cluster nodes.

12. If you want to install Configuration Hub, ensure that the Use Existing Configuration Hub check box

is cleared, and then provide values as described in the following table.

Field

Description

Install Location

If needed, modify the installation folder for Con-
figuration Hub.

Plugin Name

If needed, modify the name of the Configuration
Hub plugin for Historian. The default value is in
the following format: Historian_<host name>. If,
however, you are installing Web-based Clients
in a cluster environment, the default value is
Historian_<cluster name>. You can modify this
value, but provide the same value for all the
nodes in the cluster.

Server Port

If needed, modify the port number that you
want to use for the web server. The default val-
ue is 5000. If you want to install Web-based
Clients in a cluster environment, provide the
same value for all the nodes in the cluster.

Container Port

If needed, modify the port number for the Con-
figuration Hub container. The default value is
4890.

ConfigHub Admin Port

This is the port number of the Configuration
Hub admin. The default value is 4890. If need-

ed, you can change the port number.
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Field

Description

Client ID

Enter the username to connect to Configuration
Hub. The default value is admin. The value that
you enter can contain:
o All English alphanumeric charac-
ters (ABCDEFGHIJKLMNOPQRSTU-
VXYZ abcdefghijkimnopgrstuvwxyz_-
0123456789)
> The following special characters: ><:~!
@#$%"&*?|

Client Secret

Enter the password to connect to Configuration
Hub. The value that you enter can contain:
o Must contain at least eight characters.
o All English alphanumeric charac-
ters (ABCDEFGHIJKLMNOPQRSTU-
VXYZ abcdefghijkimnopgrstuvwxyz_-
0123456789)
> The following special characters: ><:~!
@#S%"&*?|

Re-enter Secret

Re-enter the password to connect to Configura-
tion Hub.

13. Alternatively, if you want to use an existing Configuration Hub:

a. Select the Use Existing Configuration Hub check box. This check box is disabled if an

existing Configuration Hub is detected.

The fields for the existing Configuration Hub appear.
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Configuration Hub Installation

Use Existing Configuration Hub:

Plugin-Mame:
Server Mame:
Server Port:

Client ID:

Client Secret:
e T R A ith ick

tion HubServeris pending;

Enter the Client ID and Secret that you provided while installing Configuration Hug plugin for
Historian to register with existing Configuration Hub.

Previous

b. Provide values as described in the following table.

Field Description

Plugin Name If needed, modify the name of the Configu-
ration Hub plugin for Historian. The default
value is in the following format: Historian_-

<host name>

Server Name Enter the server name or the FQDN of the
existing Configuration Hub server, as dis-
played in the address bar of the browser
when you access Configuration Hub from
the machine where Configuration Hub is in-

stalled.

Server Port If needed, modify the port number that you
want to use for the web server. The default
value is 5000.
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Field Description

Client ID If needed, modify the username to connect
to Configuration Hub. The default value is
admin.

Client Secret Enter the password to connect to Configura-
tion Hub.

c. Select Test Connection.
The results of the connection test appear. You cannot proceed until the connection is

successful.
14. Select Next.

The default installation drive appears.

Where do you want to install Historian Web-based
Clients?

Choose an available disk.

Previous

15. If needed, change the installation drive for Web-based Clients, and then select Next.

The log files location page appears.
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Customize Log Files Locations

Choose a location.

(=g LN S Gl O ProgramData\HistorianWebBasedClientsLogs

Browse

Previous

16. If needed, change the location for log files, and then select Next.

The destination Historian server page appears.



Getting Started Guide | 1 - Getting Started Guide | 109

Provide the name of the Destination Historian Server.

You may update the Historian Server after installation is complete.

Destination Historian Server: myhistserver

Previous

17. Provide the name of the destination Historian server to which Web-based Clients are connected by

default. When you login to Configuration Hub, the default system will point to this server.

o ™
Note:
» Provide the name of either Historian single-server or mirror primary server
because the systems in Configuration Hub will be either a stand-alone system or a
horizontally scalable system.
> If you want to connect to a remote Historian server, you must disable the Enforce
Strict Client Authentication and Enforce Strict Collector Authentication options

using Historian Administrator in the remote server.
N v

18. Select Next.
The You are ready to install page appears.
19. Select Install.
The Web-based Clients installation begins.
20. When you are prompted to reboot your machine, select Yes.
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Historian Web-based Clients are installed in the following folder: <i nst al | ati on dri ve>:\ Program

Fi | es\ GE, and the following registry paths are created:

« HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE Di gi t al
« HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE

If you want to use Configuration Hub installed using other products such as iFIX, Plant Applications, and

so on, set up authentication to point to the Proficy Authentication instance.

Install Web-based Clients at a Command Prompt

1. Install the Historian server (on page 44). During the installation, in the Configure Web-based
Clients page, select the Do you wish to continue configuring web-based clients check box, and

provide the Proficy Authentication server and Configuration Hub server details.

Register with Configuration Hub

By registering, vou'll be able to work with Historian web-based clients, and you can also view Historian license
information on Configuration Hub.

B Use existing Proficy Authentication and Configuration Hub Instance

If the above box is not selected, you'll need to use the Proficy Authentication Tool from the Start
Menu after installing Proficy Authentication and Configuration Hub.

Check the "Register with Confisuration Hub” section in the ©nline Help for more information:

Mote: If you install Historian Web-based clients and Historian Server on one machine, you can skip
this step, and no additional steps are needed after installation.

Previous

2. If you want to use Web-based Clients in a cluster environment, ensure that your network is enabled

for multicast traffic, and set up high availability on each node in the cluster.


https://www.ge.com/digital/documentation/confighub/version2024/t_authentication_setup.html
https://www.ge.com/digital/documentation/historian/version2024/t_set_up_high_availability_of_wc.html
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This topic describes how to install Web-based Clients at a command prompt. You can also install Web-

based Clients using an installer (on page 93).

During the installation, you can choose to use Web-based Clients in a cluster environment, thus ensuring
high availability of connection to the Historian server using the client applications.

1. If you want to install Web-based Clients with the default values, run the following command:

install.exe /quiet Adm nCient Secret=<password> Confi gHubCl i ent Secr et =<passwor d>

2. If you want to modify the default values, run the following command:

install.exe /quiet Adm ndient Secret=<password> Confi gHubC i ent Secr et =<passwor d> <par anet er >=<val ue>

The following table describes the installation parameters.

Parameter Description Default Value

Publ i cPort Port for https protocol commu- | 443
nication used by Web-based
Clients. Ensure that the value
for this parameter matches the
one you specify while installing
the Historian server. In addi-
tion:
> If you will install Oper-
ations Hub later on the
same machine, the val-
ue that you provide for
this parameter is popu-
lated while installing Op-
erations Hub.

o

If you have already in-
stalled Operations Hub
on the same machine,
provide the same value
that you provided while
installing Operations
Hub.




Getting Started Guide | 1 - Getting Started Guide | 112

rian database.

Parameter Description Default Value
UAAH: t pPor t Port for http protocol commu- | 9480
nication used by the Proficy
Authentication service.
UAADat abasePor t Port for the Proficy Authentica- | 9432
tion database.
Hi st ori anHt t pPor t Port for the http protocol com- 8070
munication used by Web-based
Clients.
Hi st or i anDat abasePor t Port for the PostgreSQL Histo- | 8432

ti veNanes

EnbeddedWebSer ver Al t er na-

The fully qualified domain
names to access Historian
web applications remotely.
You can use it to access the
Web Admin console using alias
names. Enter the values sepa-

rated by commas.

For example, to access the
Web Admin console using
any of the following URLs, en-
ter Test . abc. ge. com | ocal -
host, 127. 0. 0. 1, al i asNane
o https:// Test.abc.ge-
.com /historian-visual-
ization/hwa
o https:// 127.0.0.1 /histo-
rian-visualization/hwa
o https:// aliasName /his-
torian-visualization/hwa
o https:// localhost /histo-

rian-visualization/hwa



https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
https://win7profsp1.htclab.ge.com/historian-visualization/hwa
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Parameter Description Default Value

! Important:
> Do not enter a
space between
the values.

o

If you have al-
ready installed
Operations Hub
on the same
machine, enter
the same value
that you have
provided while
installing Opera-
tions Hub.

o

If you will in-
stall Operations
Hub later on the
same machine,
the value that
you provide for
this parameter
is used while in-
stalling Opera-
tions Hub.

o

You must add
the IP address
and alias name
inthe host s
file located
atC. \ W n-
dows\ Sys-
tenB2\ dri -
vers\etc.
The IP address
that you add
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Parameter

Description

Default Value

must be a stat-

ic or fixed IP ad-

dress.

Format: <I P ad-
dress> <ali as

name>

Example:
1.2.3.4 ny-

server name

o FQDN is not
supported for
Configuration
Hub.

Adm nCientld

The client ID to connect to the
Proficy Authentication service.

Admi nd i ent Secr et

The password to connect to
the Proficy Authentication ser-

vice. The password must satis
fy the following conditions:
> Must not contain only
numbers.
> Must not begin or end
with a special character.
> Must not contain curly
braces.
If the password does not sat-
isfy these conditions, the in-
stallation may be successful,
but Web-based Clients will not
work.

Not applicable
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Parameter

Description

Default Value

4 N
Note:

The format of user-
name for Historian
Web-based Clients is
<host name>.admin,
where <host name> is
the machine on which
Web-based Clients are
installed. And, the de-
fault client ID is admin.
Both the host name
and client ID are case-

sensitive.

If, however, the Proficy
Authentication server
hostname is long, re-
sulting in a username
longer than 20 char-
acters, Windows does
not allow you to create
the user. In that case,
you can create a Profi-
cy Authentication user,
and then create the
corresponding Win-
dows user, using the
uaa_config_tool utility.

- /

UseExt er nal Uaa

Identifies whether you want to
use an external Proficy Authen-
tication service (that is, a Profi-
cy Authentication instance al-
ready installed by an external
application such as Operations
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Parameter

Description

Default Value

Hub). If you want to use exter-
nal Proficy Authentication, en-
ter 1.

Act i veUaaBaseUr |

The base URL to connect to ex-
ternal Proficy Authentication.
A value is required only if you
want to connect to an exter-
nal Proficy Authentication ser-
vice. Enter a value in the fol-
lowing format: https://<Proficy
Authentication server machine
name>:<public https port num-
ber>. By default, the port num-
ber is 443.

DoConf i gHubNeedTol nst al |

Identifies whether you want to
install Configuration Hub as
part of the web-based clients.
You can enter 1 to install, or 0
to not install Configuration Hub
as you may already have it in-
stalled.

Conf i gHubCont ai ner Por t

The web server (https) port
that you want to use for Con-
figuration Hub.

5000

Cont ai ner Por t

The port for the Configuration
Hub container.

4890

Conf i gHubAdm nPor t

The port for the administration
service for Configuration Hub.

4920

Conf i gHubl nst al | Fol der

The installation folder for Con-
figuration Hub.

C.\Program Fi |l es
(x86)\ GE\ Confi guration-
Hub

UseExt er nal Confi gHub

Identifies whether you want
to use Configuration Hub in-

0
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Parameter

Description

Default Value

stalled with iFIX or on a remote
machine. If you want to use an
external Configuration Hub, en-

ter 1.

Root Dri ve

Enter the path pointing to a re-
mote Configuration Hub. For
example E: \

Ext er nal Conf i gHubMachi neNane

Enter the server name or the
FQDN of the existing Config-
uration Hub server, as dis-
played in the address bar of
the browser when you access
Configuration Hub from the
machine where Configuration
Hub is installed.

ConfigHubd i ent| D

The username to connect to
Configuration Hub. The value
that you enter can contain:
> All English alphanumer-
ic characters (ABCDE-
FGHIJKLMNOPQRS-
TUVXYZ abcde-
fghijklmnopgrstu-
vwxyz_0123456789)
> The following special
characters: ><:~@#$
%"&*?|

admin

Confi gHubCl i ent Secr et

The password to connect to
Configuration Hub. The value
that you enter can contain:
o Must contain at least
eight characters.
= All English alphanumer-
ic characters (ABCDE-
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Parameter

Description

Default Value

FGHIJKLMNOPQRS-
TUVXYZ abcde-
fghijklmnopqgrstu-
vwxyz_0123456789)

> The following special
characters: ><:~@#$
%"&*?|

I sCl ust er Node

Indicates whether you want
to install Web-based Clients
in a cluster environment. If
you want to install Web-based
Clients in a cluster environ-
ment, enter 1. This is not ap-
plicable if you are upgrading
Web-based Clients.

Post gr esBaseDi r

The folder in the shared drive
that you want to use for His-
torian database if you want
to add the Web-based Clients

server to a cluster.

C:\ProgramData\GE\Opera-
tions Hub

Cl ust er FQDN

Enter the client access point
of the role for which you have
added the resources while set-
ting up high availability (on
page 121).

Mul ti cast Addr ess

The common IP address that
all the nodes in the cluster can
use. Enter a value between
224.0.0.0 and 239.255.255.255
(or a hostname whose IP ad-
dress falls in this range).

228.0.04

Hi st ori anCl ust er Menber shi p-

Por t

The common port number that
all the nodes in the cluster can

use. This port number, in con-

45564




Getting Started Guide | 1 - Getting Started Guide | 119

Parameter

Description

Default Value

junction with the multicast ad-
dress, is used to create the
cluster.

Hi st ori and ust er Recei ver Port

The multicast port number that
you want to use for incoming

Historian data.

4000

Dat aPat h

The path to the log files.

C.\ ProgranDat a\ Hi stori -
anWebBasedd i ent sLogs

Desti nati onHi storian

The name of the destination

Historian server.

o ™
Note:

If you want to connect
to a remote Historian
server, you must dis-
able the Enforce Strict
Client Authentication
and Enforce Strict Col-
lector Authentication
options using Histori-
an Administrator in the

remote server.

N j

To install Web-based Clients with local Proficy Authentication and local Configuration Hub, run the

following command:

Install.exe /quiet PublicPort=443 UAAHtt pPort=9480 UAADat abasePort=9432 Hi stori anHttpPort=8070

Hi st ori anDat abasePort =8432 Admi nCl i ent | d=admi n Adnmi nCl i ent Secr et =abc

Conf i gHubCont ai ner Por t =5000 Cont ai ner Port =4890 Confi gHubl nst al | Fol der="C:\ Program Fi | es

(x86)\ GE\ Confi gurati onHub"

Confi gHubd i ent | D=adnmi n Confi gHubCl i ent Secr et =xyz

Dat aPat h="C: \ Pr ogr anDat a\ H st ori anWbBasedC i ent sLogs"

To install Web-based Clients with local UAA and an external Configuration Hub, run the following

command:
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Install.exe /quiet PublicPort=443 UAAHtt pPort=9480 UAADat abasePort=9432 Hi stori anHttpPort=8070

Hi st ori anDat abasePor t =8432 Adni nCl i ent | d=adm n Adni nCl i ent Secr et =secr et 123 UseExt er nal Uaa=1
Act i veUaaBaseUr | =htt ps:// TESTHI ST4. t est. com 443

UseExt er nal Confi gHub=1 Ext er nal Confi gHubMachi neNane=t est 2019- 2 Confi gHubd i ent | D=admi n

Confi gHubd i ent Secr et =secr et 321i t ¢ Dat aPat h="E: \ Pr ogr anDat a\ Hi st ori anWbBasedC i ent sLogs"

DoConf i gHubNeedTol nst al | =0 Root Dri ve="E:\"

To install Web-based Clients with external Proficy Authentication and a local Configuration Hub, run

the following command:

Install.exe /quiet PublicPort=443 UAAHtt pPort=9480 UAADat abasePort=9432 Hi stori anHttpPort=8070
Hi st ori anDat abasePor t =8432 Adnmi nCl i ent | d=adm n Admi nC i ent Secr et =abc UseExt er nal Uaa=1
Acti veUaaBaseUr| =https://<extrenal UAA nmachi ne host nane>: 443
Conf i gHubCont ai ner Por t =5000 Cont ai ner Port =4890 Confi gHubl nst al | Fol der="C:\ Program Fi | es
(x86)\ GE\ Confi gur ati onHub"
Confi gHubd i ent | D=admi n Confi gHubd i ent Secr et =xyz

Dat aPat h="C: \ Pr ogr anDat a\ Hi st ori anWbBasedd i ent sLogs"

To install Web-based Clients in a cluster environment with local Proficy Authentication and local
Configuration Hub, run the following command:

Install.exe /quiet PublicPort=443 UAAHtt pPort=9480 UAADat abasePort=9432
Hi st ori anHt t pPort =8070 Hi st ori anDat abasePort=8432 Admi nCl i entl|d=adni n Admi nd i ent Secr et =abc
Conf i gHubCont ai ner Por t =5000
Cont ai ner Port =4890 Confi gHubl nstal | Fol der="C:\ Program Fi | es (x86)\ GE\ Confi gurati onHub"
Confi gHubd i ent | d=admi n Confi gHubCl i ent Secr et =xyz Dat aPat h="C: \ Pr ogr anDat a\ Hi st ori anWebBasedd i ent sLogs"
DestinationHi stori an=<Hi storian server host nane> |sC uster Node=1
Post gr esBaseDi r ="E: \ pgsql " Cl ust er FQDN="cl ust er . donmai n. cont'
Hi st ori anC ust er Menber shi pPort =45564 Hi st ori and ust er Recei ver Por t =4000

UAACI ust er Menber shi pPor t =45565 UAAC ust er Recei ver Port =4005 Mul ti cast Address=228.0.0. 4

Web-based Clients are installed in the following folder: <i nstal | ati on drive>:\Program Fi |l es
\ GE, and the following registry paths are created:

« HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE Di gi t al
« HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE

If you want to use Configuration Hub installed using other products such as iFIX, Plant Applications, and
so on, set up authentication to point to the Proficy Authentication instance.


https://www.ge.com/digital/documentation/confighub/version2024/t_authentication_setup.html
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Connect to a Remote Proficy Authentication Service

Provide the details of the external Proficy Authentication instance while installing Web-based Clients (on
page 93).

To host a Proficy Authentication service, you can use the same machine on which Web-based Clients are
installed or a different one. This topic describes how to connect to a Proficy Authentication service that is
set up on a machine different from the one on which you have installed Web-based Clients.

1. Access the Web Admin console.
2. Select Not Secure, and then select Certificate.
3. Select the root CA certificate in the Certificate Path section.
The Certificate Export Wizard window appears.
. Select the Base-64 encoded X.509 (.CER) format.
. Install the certificate in Trusted Root Certification Authorities store.
. Rename the certificate file from . cer to. pem
. Access Certificate Management Tool.
. Access the External Trust section and import the renamed certificate.
. Select No when prompted to restart GeOphubMasterStarter.
. Restart the Proficy Historian Tomcat service.

= O OV 00 N o o1 >

—_— )

. Reopen the browser.

Map the user groups of the remote Proficy Authentication service with the Historian Proficy

Authentication group

Set Up High Availability of Web-based Clients

1. Create a shared drive on your network that all the nodes in the cluster can access, and create a
folder in that drive.
2. On each node that you want to add to the cluster:

a. Install the Failover Clustering feature.

b. If you want to use an existing Proficy Authentication instance, ensure that all the cluster
nodes point to the same Proficy Authentication instance. Note that for all the cluster
nodes, the Proficy Authentication credentials of the node on which you installed Proficy
Authentication /ast will be considered.

In a cluster environment, multiple servers are installed, which share the same data. Each of these servers
is called a node. One of them acts as the primary node, while the others are standby nodes. If the primary
node is down, one of the standby nodes is used.


https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_mapping_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_mapping_groups.html
https://docs.microsoft.com/en-us/windows-server/failover-clustering/create-failover-cluster#install-the-failover-clustering-feature
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When you install Web-based Clients in a cluster environment, the web servers are added to the cluster.
You can then achieve high availability of connection between the Historian server and the client
applications.

For example, if Configuration Hub on the primary node is unable to connect to the Historian server, the
user session on the standby node is activated. Therefore, you will still be able to connect to the Historian
server using Configuration Hub installed on the standby node.

The following services are shared between the primary and standby nodes in a cluster:

« Historian Indexing Service
« Proficy Historian PostgreSQL Database

Historian works with Microsoft Failover Cluster Manager to ensure high availability of Web-based Clients.
Using Failover Cluster Manager, you must add these services to the cluster.

1. Access the primary node of the cluster.
2. Create a failover cluster.
3. Add a storage to the failover cluster.
4. Select Roles > Create Empty Role.
Arole is created.
5. Add a client access point to the role:
a. Select the role.
b. In the Actions section, select Add Resource > Client Access Point.
c. Follow the on-screen instructions to add a client access point to the role.
6. Add a storage to the role:


https://docs.microsoft.com/en-us/windows-server/failover-clustering/create-failover-cluster#create-the-failover-cluster
https://docs.microsoft.com/en-us/windows-server/failover-clustering/failover-cluster-csvs
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a. Select the role.
b. In the Actions section, select Add Storage.
c. Follow the on-screen instructions to add the storage that you have created in step 3. You
can use a storage only once.
7. Ensure that your network is enabled for multicast traffic. To do so, run the following command:

netsh <interface nanme> <I P address> show j oi ns

A list of IP multicast groups that have been joined through an interface appears. If you do not
specify an interface name, a list of multicast groups for all interfaces appears.

8. Install Web-based Clients (on page 94). During the installation, select the Cluster Node check
box, and provide the details.

9. Import the Proficy Authentication certificate (on page 727) into all the cluster nodes. Copy the
certificate in the following path from any node in the cluster and paste it in the same folder in all
the other nodes: C: \ Program Fi | es\ GE\ Operati ons Hub\ httpd\conf\cert.

10. Add resources to the role:
a. Select the role.

b. In the Actions section, select Add Resource > Generic Service.

The New Resource Wizard window appears.

c. In the list of resources, select Historian Indexing Service, and then follow the on-screen

instructions to add the service.

11. Perform the previous step to add the Proficy Historian PostgreSQL Database resource as well.

12. Add the following dependencies for each of these resources:

a. Double-click a resource.
The <resource name> Properties window appears.

b. Select Dependencies.

c. Select Insert, and add dependencies for each resource as described in the following table,

using the AND operation.

Resource Name Dependencies
Proficy Historian ProstgreSQL Database = IP Address
= Storage
= The network name
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Resource Name Dependencies

Historian Indexing Service = IP Address

= Storage

= The network name

= Proficy Historian ProstgreSQL Data-
base

13. Select the role, and then in the Actions section, select Start Role.
When you later install Web-based Clients and provide the cluster details, Web-based Clients will be
part of the cluster, thus achieving high availability.

1. Restart the following services on all the cluster nodes:
o Historian Indexing Service
o Proficy Historian PostgreSQL Database
2. On the machine on which you have installed the Historian server, update the URI of the following
registry key to point to the cluster FQDN: HKEY_LOCAL_MACHI NE\ SOFTWARE\ I nt el | uti on, Inc

\'i Hi stori an\ SecurityProvi der\ QAut h2.

Upgrade Web-based Clients

» When you upgrade, Web-based Clients and associated data will be lost. Therefore, back up
Web-based Clients and associated data using the uaa_confi g_t ool utility provided in the
Utilities folder of the ISO package. For information, refer to Migrate User Authentication Data

from Historian to Common Proficy Authentication Service (on page 187).

0 Tip:

After installation, uaa_confi g_t ool is available in the following folder as well:

<installation drive>\ProgramFiles\GE Digital\Hi storian Config

« You cannot upgrade Web-based Clients from a version earlier than 8.0. This is because, starting
8.0, Web-based Clients are installed separately (not as part of the Historian server installation).
Therefore, you must do either of the following:

o Install Web-based Clients on a new machine.
> Uninstall the Historian server (remember to back up the Proficy Authentication using the
UAA_config_tool utility), and then install Web-based Clients.
« If the machine name has changed, you must uninstall and reinstall Web-based Clients.
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- If you want to use a different Proficy Authentication server from the previous one, you must
manually migrate the Proficy Authentication data to new Proficy Authentication server using the
uaa_config_tool utility.

- If you want to switch from using a local Proficy Authentication to using an external Proficy
Authentication (or vice versa), you must manually change the Proficy Authentication details.

1. Install Web-based Clients (on page 93).

Web-based Clients will be upgraded to the latest version.
2. Clear the browser cache.

You can now access Web-based Clients.

Configure Web-based Clients

You can configure the following settings for Web-based Clients:

« Reconfigure Proficy Authentication to point to a different Proficy Authentication server.
- Reconfigure the same Proficy Authentication instance to resolve any issues with login.
« Re-register Configuration Hub to resolve any issues.

- Unregister Configuration Hub, and register another one.

To perform these tasks, Historian provides a utility called Web Based Clients Configuration. It is installed

during Web-based Clients installation.
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o5 Wb Based Clients Configuration - u x
Prohcy Authenbcation Configusation Coniiig Hub Corfiguration
) : PhugreM ame: Historian_Entempize WIN10TECH
Serves Name: |
Public hitps poet PYe) ' Server Name
Aucerin Cliert 1D [odmn ' NGINX Port 5000
Adrmin Chent Secret Chent I0: admin
Chent Secret
Test
Un Regiter Tt
Conligure Ewt
Logging Cleat Log
|

To run this utility, run the Web_Cl i ent s_Confi gurati on_Tool . exe file. By default, it is located in the
following folder: C: \ Program Fil es\GE Digital \H storian Config

Remote Management Agents

Install Remote Management Agent Using the Installer

Ensure that all the collectors that you want to manage remotely are in the running state.

If the collectors that you have installed are earlier than version 9.0, you must install Remote Management
Agent on each machine on which the collectors that you want to manage are installed. For collectors
version 9.0 or later, Remote Management Agent are automatically installed when you install collectors.

This topic describes how to install Remote Management Agent using the installer. You can also install
them at a command prompt (on page 129).
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1. Runthe I nst al | Launcher . exe file.
2. Select Install Remote Management Agents.
The welcome page appears.
3. Select Next.
The license agreement appears.
4. Select the Accept check box, and then select Next.

The default installation drive appears.

Where to install the Historian Remote Management Agents?

Choose an available disk.

Previous

5. If needed, modify the installation drive, and then select Next.
The destination Historian server page appears.
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Historian Server Details

Provide a valid windows user of the default Historian server to which the
Remote Collector Manager will connect.

Historian Server: myhistserver

User Mame:

Password:

Confirm Password:

Note: If you have created security groups or enabled strict client/collector authentication, provide

the destination Historian credentials.
If the password changes, you must reinstall Remote Management Agents to reset the password.

Previous

6. Enter the details of the Historian server to which Remote Management Agent will connect, and then

select Next.
The Data Directory page appears.
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Data Directory

BEIERMTude 0l o\ Proficy Historian Data

Browse

Previous

7. As needed, modify the location of the data directory, or leave the default value, and then select
Next.
The You are ready to install page appears.

8. Select Install.

» Remote Collector Management is installed on your machine.

- Afolder named Hi st ori an Renbte Managenent Agents is created inthe GE Di gi t al
folder in the installation location that you specified.

» Remote Collector Management is running, and a .shw file is created in the log folder. This file
contains the details of the collectors that are running on the machine.

« For each collector that you manage using Remote Collector Management, a new entry named
ServiceName is created in the collector registry. If the ServiceName key is not created or updated

incorrectly, refer to Troubleshooting Remote Collector Management Issues (on page ).

Install Remote Management Agent at a Command Prompt

Ensure that all the collectors that you want to manage remotely are in the running state.
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If the collectors that you have installed are earlier than version 9.0, you must install Remote Management
Agent on each machine on which the collectors that you want to manage are installed. For collectors
version 9.0 or later, Remote Management Agent are automatically installed when you install collectors.

This topic describes how to install Remote Management Agent at a command prompt. You can also

install them using the installer (on page 726).

1. Access the command prompt, and navigate to the RMA folder in the install media.
2. Run the following command, replacing the values in angular brackets with the appropriate values:

Hi storianRVA Install.exe -s RootDrive=<installation drive> DestinationServer Nane=<Desti nation Hi storian server

name> User Nanel=<W ndows user name> Passwor d=<W ndows passwor d> DataPat h="C:\ Proficy Historian Data\LogFiles"

Hi storianRVA Install.exe -s RootDrive=C:\ UserNamel=Adni ni strator Password=Adm nPassword

Desti nat i onSer ver Name=VVH STWEBAUTO Dat aPat h="C: \ Profi cy Hi storian Data\LogFiles"

* Remote Collector Management is installed on your machine.

- Afolder named Hi st ori an Renpte Managenent Agents is created inthe GE Di gi t al
folder in the installation location that you specified.

» Remote Collector Management is running, and a .shw file is created in the log folder. This file
contains the details of the collectors that are running on the machine.

« For each collector that you manage using Remote Collector Management, a new entry named
ServiceName is created in the collector registry. If the ServiceName key is not created or updated

incorrectly, refer to Troubleshooting Remote Collector Management Issues (on page ).

Install the OPC UA HDA Server

Install Historian (on page 43).

Note:

You can install Historian and the OPC UA HDA server on the same machine or on different

machines.

1. Run the Historian installer.

2. Select Install Historian OPC UA HDA Server.
The welcome page appears.

3. Select Next.

The license agreement appears.
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Read and accept the license agreement to continue.

GE DIGITAL MASTER FRAMEWORK

SOFTWARE AMD SUPPORT AGREEMENT

Customer and GE Digital (*GED"} acknowladge that this Agreement shall povern Customer's use of the GE
Offerings. GED and Customer may be referred to individually as a “Party” and collectively as the “Parties”
This Agreement includes the Software Terms and Support Services Terms (*Product Terms™} provided
however that this Agreement shall not govern Professional Services and Cloud Terms. This Agreement, along
with all applicable schedules, exhibits, and addenda incorporated into each, and any Ordering Documents
[as defined below} entered by GED and Customer, form the GE Digital Master Framework Software
[*Agreement” or “EULA" between GED and Customer. Any authorization by Customer to furnish the GE
Offerings or order placed by Customer for GE Offerings is deemed acceptance of this Agreement.

1 Scope

1 Scope of Master Framework. This Agreement governs the Software and Software Support
Offerings identified under a proposal, statement of work, quote, activation schedule, or any other written
agreament executed by the Parties, (*Ordering Documents™). “Offerings” include the following products and
services made available or provided to Customer by or for GED or its Affiliate: computer software (either by
means of digital download or on physical media) excluding Third Party Products and Services under Section
24 ("Software”) and Appendix 1; and support programs (*Support Services") and Appendix 1. (.

2 Affiliates. Subject to GED's compliance requirements and to the written agreement of the Parties

Accept

Previous

4. Select the Accept check box, and then select Next.
The Where to install the Historian OPC UA HDA Server page appears, asking you to select the
installation drive.

5. Select the installation drive, and then select Next. You can retain the default one, or choose a
different one.
The OPC UA HDA Server Attributes page appears.
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OPC UA HDA Server Attributes.

Historian OPCUA HDA Server :
Port Mumber : 43010

URI: opc.tep:/fsitahiststnd:48010

Previous

6. Provide values as described in the following table, and then select Next.

Field Description

Historian OPCUA HDA Server Enter the host name or the IP address of the
machine on which you want to install the OPC
UA HDA server. By default, the local host name

appears.

Port Number Enter the port number that you want the OPC
UA HDA server to use.

URI The URI to access the OPC UA HDA server.
This field is disabled and populated with a
value in the following format: opc.tcp://<host
name>:<port number>, where <host name> and
<port number> are the values that you have en-

tered in the preceding fields.
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The Historian Server Details page appears.

Historian Server Details.

Historian Server Name : myhistserver
Historian Server User Mame :

Historian Server Password :

Previous MNext

7. Provide values as described in the following table, and then select Next.

Field

Description

Historian Server Name

Enter the name of the Historian server that you
want to connect to the OPC UA HDA server.

Historian Server User Name

Enter the username of the Historian server.

Historian Server Password

Enter the password of the Historian server.

The You are ready to install page appears.
8. Select Install.

The Historian OPC UA HDA server is installed. Reboot the machine when prompted to do so.

« If you have installed the OPC UA HDA server on a remote machine, enable the firewall.

« Install an OPC UA client.
« Configure the OPC UA HDA server.
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The Excel Add-In for Historian

Install the Historian Excel Add-in Using the Installer

Install one of the following 32-bit or 64-bit Microsoft® Excel® applications:

* Microsoft® Excel® 2019
* Microsoft® Excel® 2016
* Microsoft® Excel® 2013
* Microsoft® Excel® 2010

You can install Excel Add-In separately or during Client Tools installation. This topic describes how to
install Excel Add-In separately using the installer. You can also install it at a command prompt (on page
134). However, if installing via a command prompt, do not install the Excel Add-In on the machine that

you have installed the Historian Administrator or data archiver.

1. Runthe | nst al | Launcher . exe file.
2. Select Install Excel Add-in for Historian.
The installer runs through the installation steps.

- ™
Note:
If using certain versions of Windows (like Windows 10 or Windows 2019), you may receive
an error message, stating that some of the DLL files are not registered. You can ignore

these messages.
- J

3. When prompted to reboot your system, select Yes.

Excel Add-In is installed.

Activate Excel Add-In (on page 736).

Install the Historian Excel Add-in at a Command Prompt

1. Install one of the following 32-bit or 64-bit Microsoft® Excel® applications:
> Microsoft® Excel® 2019
> Microsoft® Excel® 2016
> Microsoft® Excel® 2013
> Microsoft® Excel® 2010
2. Install Excel Add-in using the installer (on page 134) on your machine:
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a. Open the Command Prompt as an Administrator. (From the Start menu, right-click the

Command Prompt app, and select Run as Administrator.)

b. On the Historian install media, navigate to the Excel folder.
c. Run the following command line: setup.exe -r.
d. When the install runs, select the Excel option and leave the other options greyed out as they

cannot be removed.

When you run this install, a template file named setup.iss is created at C: \ W ndows. This

file stores the installation options that you have provided during the installation.
After completing the installation, you can then use this . i ss file to install Excel Add-in at a
command prompt on other machines.

On the other Client machine where you want to install the Excel Add-in, place a copy of the
setup.iss on the local directory and open a Command Prompt (Run as Administrator). Run

the silent install with following command:

setup. exe /s

If your iss file is not called setup.iss or is in different directory than setup.exe you need to
add the flag: /f1. For example:

setup.exe /s /sns /f1"C: \ Tenp\setup.iss

Wait for few minutes (probably 3-5 minutes) for the install to complete.

You can install Excel Add-In separately or during Client Tools installation. However, do not install Excel

Add-In on the machine on which you have installed Historian Administrator or data archiver.

1. Copy the set up. i ss file to each machine on which you want to install Excel Add-in at a command

prompt.

2. In the folder that contains the set up. i ss file, run the following command: set up. exe /s /sns

The installer runs through the installation steps.

-~

N

~

Note:

If using certain versions of Windows (like Windows 10 or Windows 2019), you may receive
an error message, stating that some of the DLL files are not registered. You can ignore

these messages.

3. When prompted to reboot your system, select Yes.

Excel Add-In is installed.
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Activate Excel Add-In (on page 736).

Activate Excel Add-In

Install Excel Add-In (on page 134).

1. Open a new Microsoft Excel worksheet.

2. Select File > Options.
The Excel Options window appears.

3. Select Add-Ins.

4. In the Manage box, select Excel Add-ins, and then select Go.
The Add-Ins window appears.

Add-Ins |9 e

Add-Ins available:

|| Analysis ToolPak af boooox
| Analysis ToolPak - VBA
|| Euro Currency Tools ’. PR TP

|| Proficy Historian Add-In

Ed|Proficy_Historian_Helper :
|| Solver Add-in = Sl

Proficy_Historian_Helper

5. Select the Proficy Historian Add-In and Proficy_Historian_Helper check boxes, and then select OK.
If the Proficy Historian Add-In and Proficy_Historian_Helper check boxes do not appear, select
Browse to locate the Hi st ori an. x| a file for the check boxes to appear. This file is created if
you have installed Microsoft Excel after installing Excel Add-In. By default, the Hi st ori an. xl a
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file is located inthe C: \ Program Fi |l es\ Profi cy\H storian or C.\ProgramFiles
(x86)\ Proficy\ Hi storian folder.
Excel Add-In is now ready to use and the Proficy Historian menu is now available in the Microsoft

Excel toolbar.

Q = Bookl xlsx - Excel
FILE HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Proficy Historian
: 3 BEES =) ; (T 1 € Help
5} ‘ﬂ’ ) =G Ao 9 ?J ’p ; O
sy . : = e 7 ¥ About

Tags Current Raw Alarms  Calculated Filtered Edit = Administration Options

Values Data & Events Data Data Query v
| Search Edit Admin Options & Help

Software Requirements

The following components are required to use Excel Add-in for Operations Hub:

Component Version Description

Operations Hub 2.0 and above. If you have purchased the stan-
dard or enterprise license of His-
torian, you receive a no-cost li-
cense for Operations Hub, which

enables you to:

* Access to the Historian
Analysis run-time applica-
tion, which is an in-built
HTMLS5 application in Op-
erations Hub.

« Perform advanced trend
analysis, including insert-
ing annotations.

« Define an asset model in-

cluding tag mapping.

Microsoft Excel 2016 and 2019 (32 bit or 64 bit)

Historian REST APIs Historian REST APlIs are required
to integrate between Historian
and Operations Hub. Historian
REST APIs are installed automat-




Getting Started Guide | 1 - Getting Started Guide | 138

Component

Version

Description

ically when you install Histori-

an Web-based Clients (on page

94).

Install Excel Add-In for Operations Hub

Install the Historian server (on page 43) and other software requirements (on page 137).

1. Runthe | nst al | Launcher . exe file.

2. Select Install Excel Add-in for Operations Hub.

The welcome page appears.

3. Select Next.

4. Read and accept the license agreement, and then select Next.

5. Select the available disk to install the Excel Add-in for Operations Hub, and then select Next.

Note:

We recommend that you select the drive where Microsoft Excel is installed.

6. Provide the details of Operations Hub, and then select Next.
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Provide the Operations Hub details:

Operations Hub UAA Server(url):

Previous

The You are ready to install page appears.
7. Select Install.
Excel Add-In for Operations Hub is installed.

Copy/export the issuer certificate (on page 739), and then install/import it (on page 740).
Copy or Export the Issuer Certificate on Server

Install Excel Add-In for Operations Hub (on page 138).

This topic describes how to copy or export the issuer certificate on Server. If this is not done, you will get

an error while querying data as shown in the image below.
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Excel Add-in for Operations Hub =

Failed to read objects-by-types. Check the log for details.
The request was aborted: Could not create S5L/TLS secure
channel.

1. Navigate to the machine where Operations Hub is installed.
2. Select Site Information (Not secure).
3. Select Certificate (invalid).
The Certificate window appears.
. Select Certificate Path.
. Select the Root CA certificate.
. Select Details.

N oo o b

. Select Copy to file.
The Certificate Export Wizard window appears.
8. Select DER encoded binary X.509(.CER) format and select Next.
9. Select Browse to save the certificate file at desired location.

10. Complete the certificate export.

Install or import the certificate (on page 740).

Install/Import the Issuer Certificate

Copy or export the issuer certificate (on page 739) on the machine on which Excel Add-In for Operations
Hub is installed.

1. Right-click the certificate, and then select Install Certificate.
The Certificate Import Wizard page appears
2. Select Local Machine, and then, select Next.
3. Select Place all certificates in the following store.
4. Select Trusted Root certification Authorities, and then select OK.
5. Select Next, and then select Finish.
The certificate is imported.

Configure the Operations Hub server (on page 141).
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Connect to Operations Hub

To query a model defined in Operations Hub, you must first connect to the Operations Hub server. You will

then receive a token from the server, which will be used for authentication.

1. Select Configuration menu in Admin.
The Operations Hub Configuration window appears.
2. Provide values as described in the following table.

Field Details

Operations Hub Server The Operations Hub server name to which you
want to connect and get the data.

Operations Hub Proficy Authentication Server | The URL of the Proficy Authentication service

(url) of Operations Hub.

Example: https://<ophubservername>/uaa

[ Note: )

The Token Status field indicates the status of the connection with Operations Hub server.
N J

3. Select Connect.
The login page appears.
4. Provide the User Identifier and Password to connect to Operations Hub.
5. Select Open UaaAuthSchemeHandler.
Operations Hub Server to which you are connected and the status of the token appears.
6. Select Save to save the Operations Hub server details. The configuration will be retained and used

when you open excel add-in again.

Install the Historian ETL Tools

« If you want to use the Historian Extract, Transform, and Load (ETL) tools to transfer data from a Pl
Historian server, install the Pl SDK package.

- If you want to use the ETL tools to transfer data from an eDNA server, copy the following eDNA
binariestothe <i nstal | ati on drive>\Program Files\GE Digital\H storian ETL
eDNA Extract folder:
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o EzDnaApi . dl |
o EZDNAApi Net . dlI |

By default, these files are available in the following folder on the machine on which the eDNA

server is installed: C: \ Progr am Fi | es(x86) \ eDNA
Installing ETL installs the following tools:

» The Extract tool
» The Transform tool
» The Load tool

This topic describes how to install ETL to extract, transform, and load data from an onsite Historian
machine to the destination Historian server. You must install Historian ETL on both the onsite Historian
machine and the destination Historian server (that is, the source and destination machines for data

transfer).

1. Runthe I nst al | Launcher . exe file.
2. Select Install Historian ETL Tools.
The welcome page appears.
3. Select Next.
The license agreement appears.
4. Select the Accept check box, and then select Next.

The default installation drive appears.
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Where to install the Historian ETL Tools?

Choose an available disk.

Prerequisite :
Touse H an ETL Pl Extract, Please install Pl SDK
To use Historian ETL eDNA Extract, Please copy eDNA binaries to Historian ETL eDNA folder

Previous

5. If required, modify the installation drive for Historian ETL, and then select Next.
A message appears, stating that you are ready to install ETL.
6. Select Install.

The Historian ETL tools are installed on your machine.

« The following folders are created in the <i nstal | ati on dri ve>/ Program Fi | es/ GE
Di gi t al folder:

oHi storian ETL eDNA Extract
oHi storian ETL Extract
°oHi storian ETL Load
°oHi storian ETL ODBC Extract
oH storian ETL Pl Extract
oHi storian ETL Transform

» The following services are installed:
o Historian ETL eDNA Extract
o Historian ETL Extract
o Historian ETL ODBC Extract_x64
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o Historian ETL ODBC Extract_x86

o Historian ETL Load

o Historian ETL PI Extract

- The following registry paths are created:

o HKEY_LOCAL_MACHI NE\ SOFTWARE\ WOW5432Node\ GE Digital \ Hi storian ETL
eDNA Extract

o HKEY_LOCAL_MACHI NE\ SOFTWARE\ WOW6432Node\ GE Di gi tal \ Hi storian ETL
CDBC Extract

o HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE Digital \Hi storian ETL Extract

o HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE Digital \Hi storian ETL ODBC Extract

o HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE Digital\ Hi storian ETL Pl Extract

o HKEY_LOCAL_MACHI NE\ SOFTWARE\ GE Digital\Hi storian ETL Load

1. If you want to extract data from an eDNA server, copy the Cust ondna. i ni file in the eDNA server
into the C: \ W ndows folder on the machine on which you have installed ETL.

2. Extract data from an eDNA server (on page ), ODBC data source (on page ), Proficy
Historian (on page ), or Pl Historian (on page ).

About Installing Help

Historian documentation is available both online and offline. This topic describes how to install the offline
Help documentation. Online Help is available here: https://www.ge.com/digital/documentation/historian/

You can install Help using a GUI-based installer or at the command prompt.

Install Standalone Help Using the Installer

This topic describes how to install Help using the installer. You can also install Help at a command
prompt (on page 145).

1. Runthe I nst al | Launcher . exe file.

2. Select Install Standalone Help.
The welcome page appears.

3. Select Next.
The license agreement appears.

4. Select the Accept check box to accept the license agreement, and select Next.

5. If needed, change the installation drive, and then select Next.

6. If needed, change the port number for the NodeJS server to run. This step is required if the default
port number is not available.
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7. Select Next.
8. Select Install.

The Help is installed.
9. Select Next.

The standalone Help is installed in the following folder: <i nst al | ati on drive>:\Program Fi |l es
\Proficy\Proficy Historian\ProficyDoc.You can access the Help from any of the Historian
applications or by accessing the i ndex. ht i file.

Install Help at a Command Prompt

This topic describes how to install Help at a command prompt. You can also install Help using the
installer (on page 144).

1. Navigate to the Hel p folder.
2. If you want to use the default installation drive (C:/) and port number (7070), run the following

command:

Hel p_I nstall.exe -s

Otherwise, run the following command:

Hel p_l nstal | .exe -s RootDrive=<installation drive> PortNunber=<port nunber>

The Help is installed. You can access the Help from any of the Historian applications or by accessing
thei ndex. ht m file. By default, this file is available in the C: \ Program Fi |l es (x86)\ CGE Digit al
\ Hi storian Hel p folder.

Configuring Certificate-based Security to use MTLS

Overview of the Certificate-based Security

Historian uses the Mutual Transport Layer Security (MTLS) protocol along with certificate-based security
to strengthen the authentication mechanism and build trusted connections among the core Historian

services, and also collectors.

Note:

MTLS Security and MTLS Data Encryption are not applicable to the File collector.

The core Historian services include:
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« Data Archiver

+ Client Manager

- Configuration Manager
« Diagnostic Manager

When you install Historian, you are provided with the Enable Certificate-based Security check box

to enable Certificate-based Security and generate root certificate with a password for Server and the

core services. By selecting this option, the installer will generate the root certificates, machine specific
certificates, and the core services certificates inthe <l nstal | directory>\Program Fil es

\ Proficy\Proficy Historian\MILSfolder, and add it to Trusted Root Certification Authorities in the

machine.

Historian Server Certificate-based Security

Enable Certificate-based Security

Historian implements certificate-based security to strengthen the authentication mechanism
among its core Historian server services. By default, this is enabled for all Historian server
installation types. You can disable by unselecting the above option.

If you are installing Historian Single Server or Mirror Primary Server, the security settings will be
automatically configured by the installer. If you are installing Historian Distributed/Mirror Mode,

the security settings must be manually configured after installation.

For detailed instructions, refer the enline help section: Overview of the Certificate-based Security
in Historian.

Previous

cup

Warning:
If you do not select the Enable Certificate-based Security check box during installation, you
must generate the root certificates manually, as described in the Manually Install Certificates for

Historian section. However, this is not recommended.
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Certificate

Applicability

ica_key.cer and ica_key.pfx

Root certificates.

ClientManager.cer, and ClientManager.pfx

Historian Core Services specific certifi-

ConfigManager.cer, and ConfigManager.pfx

cates.

DataArchiver.cer, and DataArchiver.pfx

DiagnosticManager.cer, and DiagnosticManag-

er.pfx

<Machine name>.cer, and <Machine name>.pfx

Machine specific certificates.

If you want to connect a distributed/mirror node to a Historian primary mirror server, or you want to

connect your collectors to a remote Historian server, you need the server specific root certificates

(ica_key.cer and ica_key.pfx) on the client machine to establish a successful handshake. To establish a

successful handshake, you must copy the root certificates from the server machine and place them in the

machines where the mirror nodes or collectors are installed. For more information, see the table below.

After installation, based on the install type, you must perform the following configuration:

Installation Type Description

Configurations

Historian setup.

Historian Single Serv- | This is for a stand-alone Historian | Collectors and server are installed on the
er system, which contains only one | same machine

Historian server. This type of sys-
tem is suitable for a small-scale

You do not have to perform any additional
configurations.

To use MTLS for collectors, you must en-
able the MTLS security for the collector in-
stance as needed. For more information, re-
fer to Enable MTLS Security for Collectors.

Collectors and server are installed on dif-
ferent machines (Collectors trying to con-
nect to a remote Historian)

1. On the server machine, from the
<Install directory>\Pro-

gram Fil es\Proficy\Profi -

cy Historian\ MILS folder, copy
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Installation Type Description Configurations

the following root certificate files:
ica_key.cer and ica_key.pfx, and
then place them in the <I nst al |
directory>\Program Fi |l es
\Proficy\Proficy H stori-
an\ MTLS folder on the collector ma-
chine. For more information, refer

to Copy server root certificate to the
client machine.

2. On the collector machine, add the
copied certificates to the Trusted
Root Certification Authorities folder.
For more information on how to add
a certificate to the Trusted Root Cer-
tification Authorities folder, refer to
Adding a Certificate to the Trusted
Root Certification Authorities Folder.

3. Generate MTLS certificate (client
certificate) on the collector machine.
For more information on how to gen-
erate MTLS certificate (client certifi-
cate), refer to Generate MTLS certifi-
cate.

4. To use MTLS for collectors, you
must enable the MTLS security for
the collector instance as needed.
For more information, refer to Enable
MTLS Security for Collectors.

Historian Mirror Pri- | This is for a horizontally scalable | Collectors and Historian primary mirror
mary Server Historian system, which contains | server are installed on the same machine
multiple Historian servers, all of

. You do not have to perform any additional
which are connected to one an-

fi ions.
other. This will be the primary configurations

node(s). able the MTLS security for the collector in-
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Installation Type

Description

Configurations

stance as needed, for more information, re-
fer to Enable MTLS Security for Collectors.

Collectors and Historian primary mirror
server are installed on different machines
(Collectors trying to connect to a remote

Historian primary mirror server)

1. On the mirror server machine, from
the<lnstall directory>\Pro-
gram Fi |l es\ Proficy\Profi -
cy Historian\ MILS folder, copy
the following root certificate files:
ica_key.cer and ica_key.pfx, and
then place them in the <I nst al |
directory>\Program Fil es
\Proficy\Proficy H stori-
an\ MTLS folder on the collector ma-
chine. For more information,refer to
Copy server root certificate to the
client machine.

2. On the collector machine, add the
copied certificates to the Trusted
Root Certification Authorities folder.
For more information on how to add
a certificate to the Trusted Root Cer-
tification Authorities folder, refer to
Adding a Certificate to the Trusted
Root Certification Authorities Folder.

3. Generate MTLS certificate (client
certificate) on the collector machine.
For more information on how to gen-
erate MTLS certificate (client certifi-
cate), refer to Generate MTLS certifi-
cate.

4. To use MTLS for collectors, you

must enable the MTLS security for
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Installation Type

Description

Configurations

the collector instance as needed, for
more information, refer to Enable
MTLS Security for Collectors.

Historian Distrib-
uted/Mirror Node

This is for a horizontally scalable
Historian system. Installing this
server will allow you to add this
node to a primary server.

Configuration on the distributed/ mirror

node machine(s)

1. On the Historian mirror primary serv-

er machine, from the <l nst al |
directory>\ProgramFiles
\Proficy\Proficy Histori -
an\ MTLS folder, copy the following
root certificate files: ica_key.cer and
ica_key.pfx, and then place them in
the<install directory>\Pro-
gram Fil es\Proficy\Proficy
Hi st ori an\ MTLS folder on the dis-
tributed/mirror node machine(s). For
more information, refer to Copy serv-
er root certificate to the client ma-
chine.

. On the distributed/mirror node ma-

chine(s), add the copied certificates
to the Trusted Root Certification Au-
thorities folder. For more information
on how to add a certificate to the
Trusted Root Certification Authori-
ties folder, refer to Adding a Certifi-
cate to the Trusted Root Certification
Authorities Folder.

. Generate MTLS certificate (client

certificate) on the distributed/mirror
node machine(s). For more informa-
tion on how to generate MTLS certifi-
cate (client certificate), refer to Gen-
erate MTLS certificate.
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Installation Type Description Configurations

Collectors and distributed/mirror node are

installed on the same machine

You do not have to perform any additional
configurations.

To use MTLS for collectors, you must en-

able the MTLS security for the collector in-
stance as needed, for more information, re-
fer to Enable MTLS Security for Collectors.

Collectors and distributed/mirror node are
installed on different machines (Collec-
tors trying to connect to a remote distrib-
uted/mirror node)

1. On the Historian mirror primary serv-
er machine, from the <I nst al |
directory>Program Files
\Proficy\Proficy H stori-
an\ MILS folder, copy the follow-
ing root certificate files: ica_key.cer,
ica_key.pfx, and then place them in
the<lnstal |l directory>\Pro-
gram Fil es\Proficy\Proficy
Hi st ori an\ MTLS folder on the dis-
tributed/mirror node machine(s). For
more information, refer to Copy serv-
er root certificate to the client ma-
chine.

2. On the distributed/mirror node ma-
chine(s), add the copied certificates
to the Trusted Root Certification Au-
thorities folder. For more information
on how to add a certificate to the

Trusted Root Certification Authori-

ties folder, refer to Adding a Certifi-
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Installation Type Description Configurations

cate to the Trusted Root Certification
Authorities Folder.

3. On the Historian distributed/mirror
node machine, from the <I nst al |
directory>\ProgramFiles
\Proficy\Proficy H stori-
an\ MILS folder, copy the follow-
ing root certificate files: ica_key.cer,
ica_key.pfx, and then place them in
the<install directory>\Pro-
gram Fil es\Proficy\Proficy
Hi st ori an\ MTLS folder on the col-
lector machine. For more informa-
tion, refer to Copy server root certifi-
cate to the client machine.

4. On the collector machine, add the
copied certificates to the Trusted
Root Certification Authorities folder.
For more information on how to add
a certificate to the Trusted Root Cer-
tification Authorities folder, refer to
Adding a Certificate to the Trusted
Root Certification Authorities Folder.

5. Generate MTLS certificate (client
certificate) on the collector. For
more information on how to gener-
ate MTLS certificate (client certifi-
cate), refer to Generate MTLS certifi-
cate.

6. To use MTLS for collectors, you
must enable the MTLS security for
the collector instance as needed, for
more information, refer to Enable
MTLS Security for Collectors.




Getting Started Guide | 1 - Getting Started Guide | 153

Note:
If you are using a cluster node setup, you can follow the configurations similar to the Historian
Single Server installation type on all the nodes.

Certificate-based Security Specifc Configurations

Copy Server root certificate to the Client Machine

If you want to connect a distributed/mirror node to a Historian primary mirror server, or you want to
connect your collectors to a remote Historian server, you need the server specific root certificates
(ica_key.cer and ica_key.pfx) on the client machine to establish a successful handshake. To establish a
successful handshake, you must copy the root certificates from the server machine and place them on

the machines where the mirror nodes or collectors are installed.

1. On the server machine, fromthe <I nstal | directory>\Program Fi | es\ Proficy\Proficy
Hi st ori an\ MTLS folder, copy the following root certificate files: ica_key.cer and ica_key.pfx.

2. On the client machine (remote mirror nodes or collectors) place them in the <I nst al |
di rectory>\Program Fi | es\ Proficy\Proficy Historian\MILS folder.

3. Add the certificate to the Trusted Root Certification Authorities folder.

Adding a Certificate to the Trusted Root Certification Authorities Folder

If you want to connect a distributed/mirror node to a Historian primary mirror server, or you want to
connect your collectors to a remote Historian server, the root certificate needs to be added to the Trusted
Root Certification Authorities folder on the local machine (that is distributed/mirror node or collector

machine).

On the primary server machine, fromthe <l nstal | di rectory>\Program Fi | es\ Proficy
\ Proficy Historian\MILS folder, copy the following root certificate files: ica_key.cer and ica_key.pfx,
and then place theminthe <l nstal |l directory>\Program Fil es\Proficy\Proficy

Hi st ori an\ MILS folder on the local machine (that is distributed/mirror node or collector machine).
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1. Double-click the i ca_key. cer file. The certificate dialog appears as shown in the following image.

T oh Certificate w
7] CreateRootCertificate.exe General Detals Certification Path
(] MTLSCertificatesinstall exe

] L
e ¥3f Certificate Information

[ legacy.dil

[ libcrypto-3-x64,dil This CA Root certificate i not trusted. To enable trust,
3 libssl 3o ol install this certificate in the Trusted Root Certification

o R e Autharities store.

|1 openssl.cnf

:3.1'- ica_key.pfx

gl ica_ley.cer

Issued tor  Hstonan EProficy SCEDg il 2GE

Issued by: Hstoran@Proficy BCEDIgE @GE

Valid from 12/15/2022 te 12f12/2032

Install Cerfificate...

per Shatement

51
£l

o ]

2. Select Install Certificate to launch the Certificate Import Wizard.

3. Click Next to continue. The Certificate Import Wizard window appears as shown in the following
image.
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&+ Certificate import Wizared

Welcome to the Certificate Import Wizard

This mizard helps you copy certificates, cersficate trust ists, and certficate revocaton
ksts from your dk % a Certficate store.

. R

A certificate, which & ssued by a cerSfication authory, B 8 corirmaton of your dentity
and contans nformation used to protect data or to establsh secure network
connections. A certficate store s the system area where certificates are kept.

i

Store Locaton

O

| ONext | Cancel

4. Select Local Machine and click Next to continue. The following screen appears.
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€& &8 Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
{®) Place all certificates in the following store
Certificate store:

| Browse...

Select Certificate Store X

Select the cerfificate store you want to use.

...... ": Personal A
-
i+ Enterprise Trust
Lo Intermediate Certification Authorities
LT Trusted Publishers

T intreted Cerlificatea hd

p E _ Cancel

<

[]show physical stores

I e

5. Select Place all certificates in the following store, and click Browse to display the list of stores
from where Trusted Root Certification Authorities can be selected.

6. Select the Trusted Root Certification Authorities, and click OK. The following dialog box appears.



Getting Started Guide | 1 - Getting Started Guide | 157

€« £* Certificate Import Wizard

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can spedify a location for
the certificate.

() Automatically select the certificate store based on the type of certificate
(®) Place all certificates in the following store

Certificate store:
[Trusted Root Certification Authorities J Browse...

Mext Cancel

7. Click Next to continue. The Completing the Certificate Import Wizard window appears.
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X oR
& £F Cenificate Import Wizard Gereral Detals Certification Path

s g . :";—,.g; Certificate Information
Completing the Certificate Import Wizard

This CA Root certificate is not trusted. To enable trust,
1 install this certificate in the Trusted Reot Certification
The eertsfcate wil be mportad after you disk Finish, i Autherities store.

‘fow have spedified the folowng seifings:

| T TS Trusted Root Certication Autharities
| Content Certificate

BGE
o The import was successful.

BGE

Instal Certificate... Issuer Statament

8. Click Finish to add the certificate to the Trusted Root Certification Authorities.

Generate MTLS Certificate

If you want to connect a distributed/mirror node to a Historian primary mirror server, or if you want to
connect your collectors to a remote historian server, you must generate the client certificates (MTLS
Certificate) specific to the distributed/mirror node or collector machine. This will create the needed

machine specific certificates and registries. You can also generate core services certificates if needed.
You must install the distributed/mirror node, or in the case of collectors, you must install collectors.

To generate client certificates (MTLS certificates), run the MrLscerti fi cat esl nstal | . exe utility from the
command prompt with Administrator privileges.
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1. Launch from the command prompt with Administrator privileges in the following format: c:

\ Program Fi |l es\ Proficy\Proficy Historian\ MILS\MILSCertificateslnstall.exe [Password]

[Certificate Validity] [Create only client Certificate] [Renpte Historian Machi ne Nane]

For example,

C:\Program Fil es\ Proficy\Proficy H storian\MILS\MILSCertificateslnstall.exe P@5WRD 3650 1 DenpServer Name

The MTLSCertificateslInstall.exe utility takes the following arguments:

Argument

Description

Password

Specifies the word or phrase that you use to
protect your certificate. The Password ar-
gument is mandatory, whereas Number of
Days is optional. An example Passphrase is:
P@55wO0rd.

o ™
Note:

The same Password used for creating
the root certificate needs to be used
here. This is so that the Password will
be same while passing the argument
between executables. The MTLSCer-
tificatelnstall.exe utility uses this pass-
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Argument

Description

,', word to open the root certificate private
key (ica_key.pfx) and sign the core ser-
vices certificates.

NumberOfDays

Optional. Specifies the Number of Days for the
root certificate to be valid. After the specified

days, the certificate validity expires.

If you do not pass any value for Number of
Days, the setting defaults to 365 days. For ex-
ample, if the Number of Days is 3650, the cer-
tificate is valid for 10 years from the generated
date.

CreateOnlyClientCert

Specifies that only client certificates with a
root certificate password must be created. You
must enter 1 to install only the client certifi-
cates.

RemoteHistorianMachineName

Specifies the remote Historian server to which
you want to connect to.

The client certificates are created and added to the Trusted Root Certification Authorities Folder.

For example, if the machine name is Node1, the certificates are created as Node1.cer and

Node1.pfx.

2. After the required certificates are generated, restart the machine. Without valid certificates, core

services cannot establish connections to each other.

Generate Root Certificates for Proficy Historian Server Manually (Not

recommended)

This topic describes how to install root certificates and the certificates for core services, for use with the

MTLS feature for Proficy Historian.

Note:

This topic is applicable if you did not enable certificate-based security during the installation

of Historian server. If you enabled certificate-based security during the installation, the root
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certificate and core services certificates are generated by default and stored at <I nst al |
di rectory>\Program Fi | es\ Proficy\Proficy Historian\MILS folder.

MTLS Binaries

To support MTLS, the Historian install media includes the following files. These files are located in the
MTLS folder in the Proficy Historian install folder:

« CreateRootCertificate.exe

» MTLSCertificateslnstall.exe
« openssl.exe

* legacy.dll

« libcrypto-3-x64.dl|

« libssl-3-x64.dll

« openssl.cnf

CreateRootCertificate.exe and MTLSCertificatesInstall.exe are the two command-line utilities for
generating the certificates. The other binaries are the dependent components.

Location of MTLS Binaries

The following figure shows an example of the binaries folder for MTLS feature, when Proficy Historian
2024 is installed in “C" drive:

This PC » Windows (C)) » Program Files » Proficy » Proficy Historian » MTLS

Mame Date modified Type Size

[¥] CreateRootCertificate.exe 12/15/2022 11:41 AM

[E7] MTLSCertificatesinstall exe 12/15
[ openssl.exce
2 legacy.dil
| liberypto-3-x64.dil
| libssl-3-x64.dl1

|| epenssl.onf 3152022 %20 PM

To generate root certificate, use the creat eRoot Cer ti fi cat e. exe utility (in the MTLS folder in the Historian

install folder) from a command prompt with Administrator privileges, as described in the following steps.

1. Right-click the Command Prompt, and select Run as Administrator.
2. Navigate to the MTLS folder in the Historian installed path. For example:

cd C\Program Fil es\Proficy\Proficy Historian\MILS
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3. Run the creat eRoot Certi fi cat e. exe command using the following arguments:

Argument Description

EnableMTLS Specifies whether MTLS is enabled. If you do
not specify a value, MTLS feature is enabled by
default (and set to 1 by default):

o 0 — MTLS feature is disabled

o 1 — MTLS feature is enabled

For example, if you want to disable the certifi-
cate-based security, simply pass “0” to the tool.

Password Specifies the word or phrase that you use to
protect your certificate. The Password ar-
gument is mandatory, whereas Number of
Days is optional. An example Passphrase is:
P@55wO0rd.

The Number of Days Optional. Specifies the Number of Days for the
root certificate to be valid. After the specified
days, the certificate validity expires.

If you do not pass any value for Number of
Days, the setting defaults to 365 days. For ex-
ample, if the Number of Days is 3650, the cer-
tificate is valid for 10 years from the generated
date.

-~

Note:

If you fail to pass any values to this command-line, the command will fail to create the root

certificate.

The following is an example of the command-line. In this example, MTLS is enabled, the
passphrase is P@55w0rd, and the certificate will be valid for 3650 days (10 years):

-

C:\ Program Fi | es\ Proficy\Proficy Hi storian\MILS CreateRoot Certificate.exe 1 P@5w0rd 3650
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4. After executing Cr eat eRoot Cer ti fi cat e. exe, locate the root keys generated in the same MTLS
folder:
- ica_key.pfx — Password protected certificate that contains the private key to sign the core
services certificates.
- ica_key.cer — Root certificate contains the public and different attributes of the certificate.

The following figure shows examples of the root certificates.

ThisPC » Windows (C:) » ProgramFiles » Proficy » Proficy Historian » MTLS
A
Mame Date modified Type Sire

[E] CresteRastCedtificate sce
[3:] MTLSCentificatesinstall.exe
[57] opensslexe

[ legacy.an

[ liberypto-3-x6d.di

120 libss]-3-x64.d1

| ' opensslanf
_T,. ica_key.pfx
[l ica_key.cer

Application

Application exten,.,

After generating the root certificate, this certificate needs to be added to the “Trusted Root

Certification Authorities” certificate store on the Local Machine.

Installing Certificates for Core Services

For generating certificates for core service, run the MrLSCer ti fi cat esl nst al | . exe utility from the

command prompt with Administrator privileges.

1. Launch from the command prompt with Administrator privileges. For example:

C:\ Program Fi |l es\ Proficy\Proficy Historian\ MILS\MILSCertificateslnstall.exe P@5w0rd 3650

The MTLSCertificateslnstall.exe utility takes the following arguments:

Argument Description

Password Specifies the word or phrase that you use to
protect your certificate. The Password ar-
gument is mandatory, whereas Number of
Days is optional. An example Passphrase is:
P@55wO0rd.
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Argument

Description

(L )
Note:

The same Password used for creating
the root certificate needs to be used
here. This is so that the Password will
be same while passing the argument
between executables. The MTLSCer-
tificatelnstall.exe utility uses this pass-
word to open the root certificate private
key (ica_key.pfx) and sign the core ser-

vices certificates.
N J

The Number of Days

Optional. Specifies the Number of Days for the
root certificate to be valid. After the specified

days, the certificate validity expires.

If you do not pass any value for Number of
Days, the setting defaults to 365 days. For ex-
ample, if the Number of Days is 3650, the cer-
tificate is valid for 10 years from the generated
date.

For each service, two certificates will be generated as shown in the following figure:
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Program Files » Proficy » Proficy Historian » MTLS

Marne Date modified Type Size
(%] CreateRootCertificate.exe 12/15/2022 5:48 PM Application 168 KB
a3 [i7] MTLSCertificatesinstall.exe 12/15/2022 1:38 PM Application 212 KB
4 [ openssl.exe 3/15/2022 20 PM Application 700 KB
* % legacy.dil 3/15/2022 9:20 PM Application exten... 152 KB
* 3 libcrypto-3-x64.dll 3/15/2022 %:20 FM Application exten.., 5,008 KB
* =] libssl-3-x64.dll 3/15/2022 9:20 PM Application exten... 754 KB
-+ _] openssl.cnf 3/15/2022 %20 PM CMF File 13 KB
9_'9 ClientManager.pfx 12/15/2022 6:54 PM Personal Informati... 3 KB
4 ConfigManager.pfx 12/15/2022 6:34 PM Personal Informati... 3KB
535 DataArchiver.pfx 12/15/2022 6:54 PM Personal Informati... 3KB
:ﬁ DiagnosticManager.pfx 12/15/2022 6:34 PM Personal Informati... 3KB
35 ica_key.pfx 12/15/2022 5:50 PM Personal Informati... 3KB
L'“'J ClientManager.cer 12/15/2022 6:54 PM Security Certificate 2KB
4l ConfigManager.cer 12/15/2022 6:54 PM Security Certificate 2KB
'_ﬂJ Datadrchiver.cer 12/15/2022 6:54 PM Security Certificate 2KB
[l DiagnosticManager.cer 12/15/2022 6:54 PM Security Certificate 2 KB
5l ica_key.cer 12/15/2022 5:50 PM Security Certificate 2KB

2. Double-click each service .cer file as shown in the following figure, and check whether each
generated certificate has a valid root certificate chain.
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w | | Search Certs

~ n | Certificate X
MName

J ClienthManager.cer General Detais Cerfification Path

_j:!‘ ClienthManager.pfx Certification path
5] ConfigManager.cer [ _.;].Illistaria.l';“@.l?'mﬁq.f@GEDigiH BGE
J‘ ConfigManager.pfx &l
;] Datadrchiver.cer

;I' Datadrchiver.pfx

2 DiagnosticManager.cer
:__1 DiagnosticManager.pfx
Tl ica_key.cer

_'3‘.-L ica_key.pfx

Certificate status:
E'I'his CErH‘ﬁ‘E‘;{E is O,

[oc 1]

3. After all required certificates are generated, restart the core Historian services. Without valid

certificates, core services cannot establish connections to each other.

Upgrade Scenarios when Working with Historian Server Certificates

Be aware of the following when upgrading your Historian:

- By default, certificate-based security is enabled. Your configuration for certificates is automatic,
unless you are installing or upgrading a distributed/mirror node. If you do not configure your
certificates in this scenario, your Historian services may not start when you run it for the first time.

« You will need to regenerate the certificates if you uninstall the existing version and reinstall any
version that supports certificate-based security.

« You will need to regenerate the certificates for Historian in-place upgrades that support certificate-
based security.

« You will NOT need to regenerate the certificates for SIM over SIM upgrades that support the MTLS
feature.
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Troubleshooting Historian Server Certificates

Be aware of the following when working with certificates in Historian:

» When you install Historian, you are presented with three install types: Historian Single Server,
Historian Mirror Primary Server, and Historian Distributed/Mirror Node. The MTLS protocol and
certificate-based security is enabled by default for all install types. If you are installing a Historian
Single Server or the Historian Mirror Primary Server, the security settings will be automatically
configured by the installer. However, if you are installing a Historian Distributed/Mirror Node, you
must configure the security settings manually after installation, for more information, refer to
Overview of certificate-based security.

« You will need to follow the same procedure for installing certificates when certificates expire in the
future.

« Prior to adding any new root certificate to the Trusted Root Certification Authorities folder, it is a
better practice to remove an existing root certificate from the store first.

« After the root certificates are added to the Trusted Root Certification Authorities folder, all core
services need to be restarted.

« If the MTLS authentication fails due to a mismatch in certificates, improperly generated
certificates, expired certificates, or any issue related certificates, it will not cause the core Historian
Services to stop. These services will be in running state, but the trusted connections among these
services will fail. In this scenario, sometimes client tools will not be able to connect to the services.
Sometimes client tools connect to Client Manager but cannot do any operations on Historian
server. They simply show the “Not Connected” error.

- After trusted connections among core Historian services succeed, they will be in the same trusted
state until these services are stopped or restarted.

« It is strongly recommended to provide same expiration date (in the Number of days field) for the
root and all other core services certificates.

- If you forget to install the certificates, some of your core Historian services may not start after you
complete your Historian install or upgrade.

« If you do not provide the same root certificate password while creating other services certificates,
the MTLSCertificatesInstaller.exe tool returns a "Wrong Password" error.
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- To see any specific errors that may be caused by certificate-based security, you need to enable
full debugging by adding the “FF” hexadecimal value to the DEBUGMODE registry as shown in the

following figure.

B Registry Editor

File Edit View Favorites Help

Computer\HKEY_LOCAL_MACHINE\SOFTWARE\Intellution, Inc.\iHistorian'Services

v || SOFTWARE A || Name Type Data

iy a5) (Defaut) REG_SZ (value not set)
ﬁi‘;‘;‘l‘::’(‘n’:\[j:‘edge L 25) BUFFERPATH REG_SZ C:\Proficy Historian Data\BufferFiles
50 %4 DEBUGMODE REG_DWORD 0000000 (255)
o 1) DisableMTLSTrust REG_SZ 0
£ KeylDHashMDS REG_BINARY 52 ¢397 Se ff a7 3e 18 8 5 5b 57 a8 0b 7c e8

Classes
ab] LOGFILEPATH REG_SZ C\Proficy Historian Data\LogFiles

Clients
Conexant
CrowdStrike
CvsM
d0738469-13a6- 5add-5fc5- 6671998673
DefaultUserEnvironment
DELL
dotnet
GE
GE Digital
GE Fanuc Software, Inc.
GEDigital
Gemalto Sentinel
GitForWindows
Google
Hewlett-Packard
HP
Inno Setup MSis
Intel
~ | Intellution, Inc.
~ iHistorian
CollectorServiceFxtensions
SecurityProviders
Servers
v Services
ClientManager
Confighlanager
Datafrchiver
DiagnosticManager

Using Proficy Authentication or LDAP Groups

About Proficy Authentication

In Historian, user authentication is handled using Proficy Authentication, which provides user account and
authentication (UAA) service. Proficy Authentication provides identity-based security for applications and

APIs. It supports open standards for authentication and authorization, including Oauth?2.

When a user is created, modified, or deleted in Historian, the associated user account is being created,

modified, or deleted in the Proficy Authentication instance, respectively.

Note:

This is done in the back-end automatically. Therefore, most users will not require knowledge on

UAA to perform basic user management, except when additional configuration is required.
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To use Proficy Authentication, you can choose between the following options while installing Web-based
Clients:

- Use a local Proficy Authentication service: Use this option if you want to create a local Proficy
Authentication instance. This is the default option. You can create this while installing Web-based
Clients.

- Using an existing Proficy Authentication service: Use this option if you are currently using a
Proficy Authentication service on a remote machine. You can install this service using Historian
Web-based Clients, or you can use any other UAA service (such as Proficy Authentication installed
using Operations Hub). You can then manage these users in Web-based Clients. The users in the
remote Proficy Authentication service can then use Web-based Clients.

You can use Proficy Authentication plugin in Configuration Hub to manage groups, manage users, and
map LDAP groups, and SAML groups with the Proficy Authentication groups.

For more information, refer to Proficy Authentication in Configuration Hub at https://www.ge.com/digital/
documentation/confighub/.

- Manage Identity Providers
o Add LDAP identity provider
o Modify LDAP identity provider
> Enable SAML
o Add SAML identity provider
> Modify SAML identity provider
o Delete Identity Provider
» Manage Groups
> Overview of Historian groups in Proficy Authentication.
o Create groups
o Map groups
> Modify groups
o Add or remove users in a group
o Add or remove sub-groups in a group
o Delete group
» Manage Users
o Create users
o Add LDAP or LDAPS users
o Add or remove groups for a user


https://www.ge.com/digital/documentation/confighub/
https://www.ge.com/digital/documentation/confighub/
https://www.ge.com/digital/documentation/confighub/version2024/t_uaa_add_ldap.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_modify_identity_provider.html
https://www.ge.com/digital/documentation/confighub/version2024/c_proficyauth_saml_setup.html
https://www.ge.com/digital/documentation/confighub/version2024/t_uaa_add_saml.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_modify_saml.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_delete_identity_provider.html
https://www.ge.com/digital/documentation/confighub/version2024/r_proficyauth_historian_groups_in_uaa.html
https://www.ge.com/digital/documentation/confighub/version2024/t_uaa_create_uaa_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_mapping_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_modify_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_add_remove_users_to_group.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_add_remove_subgroups_to_group.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_delete_group.html
https://www.ge.com/digital/documentation/confighub/version2024/t_uaa_create_uaa_users.html
https://www.ge.com/digital/documentation/confighub/version2024/t_uaa_users_add_ldap_saml.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_modify_users.html
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o Reset user password

o Delete user

About Proficy Authentication Groups

A Proficy Authentication group is created for a specific type of users who will likely perform the same type
of activities.

If you have groups in a remote Proficy Authentication service, you can use them with Historian using the
Proficy Authentication LDAP Integration tool. This section describes how to map the groups in the remote
Proficy Authentication service with Historian counterparts. By default, Historian contains the following
Proficy Authentication groups:

- historian_visualization.admin: Provides access to Trend Client and the Web Admin console.

« historian_visualization.user: Allows access to Trend Client.

« historian_rest_api.read: Provides read access to public REST API.

« historian_rest_api.write: Provides write access to public REST API.

« historian_rest_api.admin: Provides read/write access to public REST API.

« historian_enterprise.admin: Provides read/write access to Configuration Hub APIs.

- historian_enterprise.user: Provides access to view Configuration Hub APIs.

- ih_archive_admins: Provides the ability to create, modify, and remove archives.

« ih_audited_writers: Allows data writes and to produce a message each time a data value is added
or changed.

« ih_collector_admins: Allows the ability to add collector instances and change their destination.

- ih_readers: Provides access to the ability to read data and system statistics. Also allowed access
to Historian Administrator.

- ih_security_admins: Provides access to Historian power security users. Security administrators
have rights to all Historian functions.

- ih_tag_admins: Provides access to allow the ability to create, modify, and remove tags. Tag-level
security can override rights given to other Historian security groups. Tag admins can also browse
collectors.

- ih_unaudited_logins: Allow connenctions to the Data Archiver without creating login successful
audit messages.

- ih_unaudited_writers: Provides the ability to write data without creating any messages. Tag,
archive, and collector changes log messages regardless of whether the user is a member of the

ih_audited_writers group.


https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_reset_password.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_delete_user.html
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(L N
Note:
Instead of mapping the groups, you can choose to map individual users with Historian users. For
instructions, refer to Managing Proficy Authentication Users Using the Configuration Tool (on

page 223).
_ J

Workflow

1. Provide the details of the remote Proficy Authentication service while installing Web-based Clients
(on page 93).

2. Connect to the remote Proficy Authentication service (on page 121).

3. Map the Proficy Authentication groups with that of the Historian Proficy Authentication instance.
You can map the groups in LDAP and LDAPS (LDAP via SSL).

Configurations Checklist to use Proficy Authentication Security Groups

In Configuration Hub, the Global Security section in the system DETAILS section enables you to specify
the authorization for Historian security groups. To use Proficy Authentication security groups, you must

perform the configurations listed in this topic.

This topic intends to be a checklist for you to perform the configurations that are needed to use Proficy

Authentication security groups for authorization.

1. Access Configuration Hub using ch_admin as the username.

DETAILS

2. In the NAVIGATION pane, expand Proficy Authentication, and then select Security.

3. Add the same Windows Login user (For example, if you logged in as Administrator, use
Administrator), and then map the user with all admin groups. For more information on adding users
and mapping the users to groups, refer to Create groups, Add or remove users in a group and Map
groups. For more information on Historian security groups, refer to Overview of Historian groups in
Proficy Authentication.

4. In the Users tab, from the list of users, select the predefined user, that is <hostname>.admin, and

then map it to ih_security_admins. For more information, refer to Map groups.


https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_mapping_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/t_uaa_add_ldap.html
https://www.ge.com/digital/documentation/confighub/version2024/t_uaa_create_uaa_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_add_remove_users_to_group.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_mapping_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_mapping_groups.html
https://www.ge.com/digital/documentation/confighub/version2024/r_proficyauth_historian_groups_in_uaa.html
https://www.ge.com/digital/documentation/confighub/version2024/r_proficyauth_historian_groups_in_uaa.html
https://www.ge.com/digital/documentation/confighub/version2024/t_proficyauth_mapping_groups.html
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5. Add the users defined in Proficy Authentication using the same password to Local users & Group.
This will enable you to access thick clients (VB admin, iHSQL). For more information on how to add
a user to Local users & Group, refer to Adding Users to Windows Security Group.

Alternatively, you can add the users by adding registry entries.
a. In the HKEY_LOCAL__MACHI NE\ SOFTWARE\ Wow6432Node\ I nt el 1 ution, |nc.
\'i Hi storian\ Servers and HKEY_LOCAL_MACHI NE\ SOFTWARE\ I ntel | uti on, Inc.
\'i Hi storian\ Server s registry paths, add the following registries.

Name Type Data

UAA REG_SZ https://hostname.do-
main:433/uaa/oauth/token

For example,

https://testmachine.ge-
.com:443/uaa/oauth/token.

UseUaaAuthentication REG_DWORD 0x00000001.

b. Save the registries.
6. Now, you can Access Configuration Hub (on page ) using the predefined username, that is,
<hostname>.admin and password.
7. In the NAVIGATION pane, in the Configuration Hub plugin for Historian, access Systems, and then
select the system as needed.

The system appears in the main section. The system details appear in the DETAILS section.

8. In the GLOBAL SECURITY section, select Use Proficy Authentication.
9. On the top-right corner, select Save.

10. Restart all the services, including the Remote Collector Management (RCM) service.

Now you can use the Proficy Authentication security groups for authorization.

To know if your configurations were saved, check the following:


unique_43
unique_43
unique_43
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« The CollectorManager.shw status must be Connected.

» The DataArchiver.shw security settings must be as shown below.

Security Settings

Security Group Source : Proficy Authentication
Security Provider : OAuth2

URT : https://hostname:domain:443/uaa/checkutoken

UAA : https: /Inostname:domain: 443!uaaloauthitoken
Use Cclient windows User for Logon : TRUE

Use ADSI calls : FALSE
strict client Authenticatifpn : TRUE
Strict Collector Authentication : TRUE
Allow Anonymous WCF Clients : FALSE
Anonymous User Name : Guest

Using Server Certificates

To use server certificates with Historian, use the Certificate Management tool. This tool supports the
following combination of files to import the certificate chain and the private key:

- A PEM file that contains the certificate chain and the private key.
» A PEM file that contains the certificate chain, and another PEM file for the private key.
« A PFX file that has the certificate chain and the private key.

For instructions on using the Certificate Management tool, refer to https://www.ge.com/digital/

documentation/opshub/windows/windows/c_about_certificate_management.html.

Change the Log Levels of Proficy Authentication

1. Access the | og4j . properti es file in the following folder: C: \ Pr ogr am Fi | es\ GE
\ Oper ati ons Hub\ uaa-tontat\ webapps\ uaa\ VEB- | NF\ cl asses
2. For each module, select one of the following log levels depending on your requirement:
o TRACE
o DEBUG
> INFO
> WARN
> ERROR
o FATAL
o OFF

3. If you want to disable Tomcat logging:


https://www.ge.com/digital/documentation/opshub/windows/windows/c_about_certificate_management.html
https://www.ge.com/digital/documentation/opshub/windows/windows/c_about_certificate_management.html
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a. Stop the Proficy Authentication Tomcat Web Server service.

b. Inthe C:\ Program Fi | es\ GE\ Qper ati ons Hub\ uaa-t ontat\ bi n folder, rename the
t ontat 8w. exe file UaaTontat . exe, and run this application as an administrator.

c. Select Logging.

d. Remove the auto keyword from the Redirect Stdout and Redirect Stderr labels.

e. Start the Proficy Authentication Tomcat Web Server service.

4. If you want to change the Tomcat log level:
a. Stop the Proficy Authentication Tomcat Web Server service.

b. Access the cont ext . xm file located in the C: \ Program Fi | es\ GE\ Oper ati ons Hub
\uaa-tontat\ conf.

c. In the Context tag, add: swal | owQut put ="t r ue”

d. Access the | oggi ng. properti es file in the same folder, and set the
2localhost.org.apache.juli.AsyncFileHandler.level to one of the following values, which are
in the order of less verbose to more verbose:

= SEVERE

= WARNING
= INFO

= CONFIG

= FINE

= FINER

= FINEST

= ALL

e. Start the Proficy Authentication Tomcat Web Server service.

Migrating Historian Data

Migrating the Alarms and Events Data

If you have upgraded Historian, you must migrate the alarms and events data as well. Only then you can
retrieve the data.

The steps to migrate depend on the Microsoft SQL version in which the alarms and events data is stored:
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« If using Microsoft SQL 2008 or later, you can install Historian and its components, install a
supported version of Microsoft SQL, and then migrate the data.
- If using a version earlier than Microsoft SQL 2008, you must first migrate the data to Microsoft SQL

2008, and then migrate it to a supported version of Microsoft SQL.
To migrate data, you can choose one of the following options:

- Before upgrading to the latest version of Historian: In this case, you can use Historian
Administrator of the older version of Historian to migrate the data.
- After upgrading to the latest version of Historian: In this case, you can use the Proficy Alarm

Database Migration tool, which is provided with Historian.

This section describes how to migrate data using the migration tool.

Workflow for Migrating Alarms and Events Data

If the alarms and events data is currently in Microsoft SQL 2008 or later:

1. Install the following components on the target machine in the given sequence:
a. Historian (on page 43)
b. Alarms and Events (on page 79)
c. Collectors (on page 81)
d. Client Tools (on page 89)
e. Standalone Help (on page 144)

2. Back up the alarms and events data (on page 176).

3. Install Microsoft SQL on the target machine. Refer to Software Requirements (on page 317) for a
list of supported versions.

4. Restore the data that you have backed up to Microsoft SQL.

5. As needed, perform calculations on the migrated data. Ideally, you must create an archive already
to store the calculated data. For unsolicited calculation tags, migration of data will cause the
calculation to be triggered automatically for the time associated with the migrated data points.
Archives will potentially grow beyond the configured default size. To avoid this issue, adjust the
value for the Dat al sReadOnl yAft er field on the Security section of the Data Store Maintenance page
of Historian Administrator (or the Act i veHour s property) so that the value is large enough to contain

the calculated data. By default, this value is 1 month.

If the alarms and events data is currently in a version earlier than Microsoft SQL 2008:
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. Using Microsoft SQL Server Management Studio, back up the alarms and events data. If the

database is large, consider taking a partial backup instead of a full backup.

2. Install Microsoft SQL Server 2008 on the target machine.

3. Restore the data that you have backed up in step 1.

4. In Microsoft SQL Server Management Studio, under Databases, right-click the database that you

have restored, and then select Properties > Options.

5. In the Compatibility level field, select SQL Server 2008.
6. Install the following components on the target machine in the given sequence:

a. Historian (on page 43)

b. Alarms and Events (on page 79)
c. Collectors (on page 81)

d. Client Tools (on page 89)

e. Standalone Help (on page 144)

7. Back up the alarms and events data (on page 176) that you have restored in step 3.

8. Install a supported version of Microsoft SQL on the target machine. Refer to Software

Requirements (on page 31) for a list of supported versions.

9. Restore the data that you have backed up in step 7 to Microsoft SQL.

. As needed, perform calculations on the migrated data. Ideally, you must create an archive already

to store the calculated data. For unsolicited calculation tags, migration of data will cause the
calculation to be triggered automatically for the time associated with the migrated data points.
Archives will potentially grow beyond the configured default size. To avoid this issue, adjust the

value for the Dat al sReadOnl yAft er field on the Security section of the Data Store Maintenance page
of Historian Administrator (or the Act i veHour s property) so that the value is large enough to contain

the calculated data. By default, this value is 1 month.

Back Up the Alarms and Events Data

Install the following components in the given sequence:

1.

Historian (on page 43)

2. Alarms and Events (on page 79)

3.

Collectors (on page 81)

4. Client Tools (on page 89)

5. Standalone Help (on page 144)

If, however, the alarms and events data is currently in a version earlier than Microsoft SQL 2008, you must

first migrate the data to Microsoft SQL 2008, and change the compatibility level to SQL Server 2008.
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1. Gotothe<Hi storian installation fol der>\Proficy DataBase folder, and open the
Proficy. Hi storian. AandE. M gr ati on. exe file.

The Backup Existing Alarms and Events window appears.

2. In the Time Range section, in the From and To fields, select the start time and end time of the
backup duration.

We recommend that you select small duration if you have many alarms. If you want to migrate the
alarms in blocks of time, choose the oldest alarms first.

3. In the Database Name field, enter the name of the database that you want to back up. Typically, this
will be the same as the Microsoft SQL server you are using.

4. Depending on whether you want to use Windows credentials or Microsoft SQL credentials, select
either Use Windows Authentication or Use SQL Authentication, respectively.

5. In the User Id and Password fields, enter the login credentials. Provide the username of a user who
has the permission to connect and back up alarms.

6. In Backup Folder Path field, provide the absolute path, including the file name, to store the backed
up alarms (for example, c: \ t enp\ Mar ch2010. bak). You can enter the path of a local file or a
remote one, depending on whether the Microsoft SQL server is installed on the local machine or a
remote machine.

7. Select Test Connection to check if the source database is active and the information is accurate.
The Begin Backup button is activated.

8. Select Begin Backup.

The alarms and evens data is backed up. The count of the rows that are backed up appears.

Install a supported version of Microsoft SQL, and restore the data (on page 7177) that you have backed
up. Refer to Software Requirements (on page 317) for a list of supported versions.

Restore the Alarms and Events Data

Install Microsoft SQL. Refer to Software Requirements (on page 317) for a list of supported versions.

1. Gotothe<Hi storian installation fol der>\Proficy DataBase folder, and open the
Proficy. Hi storian. AandE. M gr ati on. exe file.

The Backup Existing Alarms and Events window appears.

2. Select Migrate Alarms and Events Backup.

3. In the Backup Folder Path field, provide the absolute path of the file (including the file name) in
which you want to restore the data (for example, c:\temp\March2010.bak). You can enter the path
of a local file or a remote one, depending on whether the Microsoft SQL server is installed on the
local machine or a remote machine.

4. In the Database Name field, enter the name of the database that you want to back up. Typically, this

value is the same as the Microsoft SQL server you are using.
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5. Depending on whether you want to use Windows credentials or Microsoft SQL credentials, select
either Use Windows Authentication or Use SQL Authentication, respectively.

6. In the User Id and Password fields, enter the login credentials. Provide the username of a user who
has the permission to connect and back up alarms.

7. Select Test Connection to check if the source database is active and the information is accurate.
The Begin Migrator button is activated.

8. Select Begin Migrator.
The alarms and evens data is restored. The count of the rows that are restored appears.

Using the Migration Tool

The IHA Migration Tool (M gr at el HA. exe for 32 bit or MigratelHA_x64.exe for 64 bit) allows you to
migrate data up to 30 years old if the data is already stored in | HA files from any version of Historian. Use
the Migration Tool to move data from one archiver to another when you cannot simply restore the | HAin

Historian Administrator.

The Migration Tool opens an | HA file as a binary data file and reads the raw samples from it. Those
raw samples are then written to a destination archiver, in a similar way to how an OPC collector or File
collector would write data. Any errors returned from the data archiver are reported in the main window

and repeated in the log file.

e N

Note:

« You can migrate UserDefined types, MultiField tags, and Array tags.

» When you are migrating the data stores, the source data store is created in the destination.

« Using this Migration Tool, you can upgrade from two previous versions of Historian to the
latest version.

- The performance of this tool is impacted with the addition of Client Manager and

Configuration Manager. For best performance, use this on a Single Server install only.

- J

Migrating Historical Data

You need to run this tool as an administrator to migrate and create the log files in the C: \ directory.

To migrate historical data stored in | HA files from any version of Historian:
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1. In the Hi st or i an folder, double-click the Migration Tool executable (M gr at el HA. exe for 32-bit
or M gr at el HA_x64. exe for 64-bit) to open the IHA Migration Utility.

The icon for the executable looks as follows: |!|

2. Select Configure Options from the Options menu.

3. Enter or modify any specific configuration information.
When choosing an | HCfile, do not specify one currently in use by the Data Archiver. (For more
information, see Configuring Migration Options (on page 179).)

4. Select File > Migrate Historical Data .
The Select Historical Data File(s) window appears.

5. Select a historical file and select Open.
Refer to the IHA Migration Utility main page for information on the progress of the migration and
any encountered errors.

. I
Note:
The IHA Migration Utility page only displays the most recent lines of the log file. For the full
set of logged messages, refer to the log file, typically located in C: \ | HAM gr at i on. Log.
/

6. Optionally, perform these steps:

a. You can upgrade the older version's archive files to the latest version by selecting the bulk
upgrade option.
Stop the Data Archiver service and select File > Bulk Upgrade Historical Data.

If you do a bulk upgrade of historical data immediately after you install the latest version on
Historian, then save on upgrading while the system reboots.

b. To clear the log messages displayed in the page, select File > Clear Display.

c. To view the logs saved in the | HAM gr at i on. | og file, select File > View Log File > ..

Configuring Migration Options

1. In the Migration tool (M gr at el HA. exe for 32 bit or M gr at el HA x64. exe for 64-bit), select
Options > Configure Options.
The Migration Options window appears showing the default server information and the default
migration options.
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Migration Options %
Sorvel Ophons
sevee [T - " ¥ Theoltie Oufput
Usernams: | W Migate Messages
Password | Log Fie Ful Hame:  |c \IHAMigrsbon Log
Corfig Fle | J

Tags To Migrate Time To Migrate
& Migrate Al Tage % Use IHA TmeFrame  © Uze Below TmeFrame
" Migrate only tags that east in destination

: Start Date/T ime [ 6/ 62m3 =] [ 23409PM =
" Migste usng tag mask: |
" Migrate only tags that esast in source confi fle EndDeta/Fimn [6 623 =] [23409PM ==

oK | Cancel

2. Enter options the following options.

Related reference

Server Pane (on page 180)

Options Pane (on page 181)

Tags to Migrate Pane (on page 181)

Time to Migrate Pane (on page 181)

Server Pane

Field

Description

Server

The default server (set during installation). If you do not want to write data to

the default server, enter the desired server in this field.

Username and Pass-

word

If you have created and established Security Groups in your Historian Securi-
ty Environment, you may need to enter the user name and password here. By
default, if you do not supply any information, the current logged in user will be

used in security checking.
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Options Pane

It is always advisable to take a copy of the configuration file and work on the copy rather than working on

the original file.

Tags to Migrate Pane

Option Description

Migrate All Tags Select this option to migrate all the tags from the selected archiver.

Migrate only tags that Select this option to migrate all the tags that exists in the source destination.

exist in destination

Migrate using tag mask | Select this option to migrate tags with the mask specified. You can specify an

exact tag name to migrate that tag only.

Migrate only tags that | To migrate the tags that are present only with the source config file.
exist in source config
file

Time to Migrate Pane

Option Description

Use IHA TimeFrame Select this option to migrate all the tags which has the IHA time frame.

Use Below TimeFrame | Select this option to migrate all the tags in the specified time frame. You need

to specify the Start Date/Time and End Date/Time if you select this option.

Data Migration Scenarios
You can migrate tags and their data on the same Historian Server or between servers. When migrating

your data, consider the following guidelines:

» Get new collection working first

When the data is collected from the collectors or the APl programs, then you should consider
adding the tag definitions into the destination server and directing data to be written there before

you start migration, because migration may take several hours or days.

- Migrate data from oldest to newest
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It is advisable to migrate the oldest data first and then the newest, to make the optimal use of

archive space.

« Pay attention to TagID

Every tag in Historian 4.5 and above has a property called TagID, that uniquely identifies it and
allows data retrieval to locate the data. Even if you have a tag of with the same name in another
archiver, that tag has a different TagID and is considered as a different tag. You can see the TagID
of a tag in the Excel Tag Export. Preserve that number when moving a tag from one system to

another.

The following are commonly used scenarios while migrating data on the same Historian server or

between servers.

- Migrating a Tag and its data from one data store into another data store.
- Merging a Historian Server into an existing data store on another machine. .

Migrating a Tag and its Data

If you want to separate a single large user data store of tag into multiple smaller data stores on the same
machine, and if your software license allows it, then you should assign the tag to the new data store and

then migrate the data.

Consider when data is collected for the year 2009 in Tag1. The collected data is archived in the default
User data store. If you want to move Tag1 residing in the User data store to another data store, (for
example, the mot or data store), then you must create the Mt or data store if it does not already exist and if

your license allows it.

The next step is to change the data store of the tag. You can change the data store of the tag either using
Historian Administrator or using Excel Tag Import. The new incoming data gets collected in the Motor
data store. If you do a raw data query, you will get only the latest data and the previous data will not be
available. To get the old data, you must migrate the data residing in the user data store to the mt or data

store.

To migrate a tag and its data from one data store to another data store on the same server:

1. Usei har chi vebackup -c¢ to make a backup of the . i hc file.
The backup of the Config file is automatically created in the Ar chi ves folder.
2. In Historian Administrator, back up each archive from oldest to newest.
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3. Launch the Migration Tool (M gr at el HA. exe for 32-bit or M gr at el HA_x64. exe for 64-bit)
using Administrator privileges.

4. Select Options > Configure Options.

5. In the Server pane, enter the Server name.

6. In the Options pane, enter the IHC File path in the Config File path field, using the browse button.
This is the path to the | HC backup that you made in step 1.

7. In the Tags to Migrate pane, select the Migrate Using Tag Mask option and enter the Tag Name
you moved to the new data store.

8. In the Time to Migrate pane, ensure the Use IHA TimeFrame option is selected.

9. Select File > Migrate Historical Data.

10. Select the archive file that you backed up in Step 2 and monitor the progress of the migration.

When the migration is complete, query the data to see the migrated data can be queried. Repeat

with the remaining archives from oldest to newest.

As needed, perform calculations on the migrated data. Ideally, you must create an archive already to store
the calculated data. For unsolicited calculation tags, migration of data will cause the calculation to be
triggered automatically for the time associated with the migrated data points. Archives will potentially
grow beyond the configured default size. To avoid this issue, adjust the value for the Dat al sReadOnl yAf t er
field on the Security section of the Data Store Maintenance page of Historian Administrator (or the

Acti veHour s property) so that the value is large enough to contain the calculated data. By default, this

value is T month.

Merging a Historian Server

A typical scenario is to merge a Historian Server into an existing data store on another machine.

If your system architecture has evolved from multiple smaller servers into fewer large archives, you can
eliminate the smaller machines while preserving all your tag configuration and collected data.

Consider the following example. You have two machines, Machine A and Machine B. Machine A is running
current or any earlier version of Historian and has 100 tags and 10 archive files. The data of these tags
are collected from the collector and is being queried by users. Machine B is running the current version of
Historian.
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-

Note:

- This example does not include Alarm migration. If Machine A was being used to store
alarms, then you need to migrate those before eliminating Machine A.

« You cannot migrate tags with Enumerated Data Sets. If you want to migrate data for
Enumerated Data Sets, then you must create the Enumerated Data Sets in Historian
Administrator or Microsoft Excel and then migrate the tags.

» To migrate tags which are condition based triggers, then you must create the condition-
based triggers for that tag in Historian Administrator or Microsoft Excel and then migrate

the tags.

J

You can migrate data only if the file format of the archive files format is . | HA. If the back-up archive is in

. zi p format, extract the zi p files and copy all the . | HA files separately in a folder.

1. Before migrating, copy the . | HC and all the . | HA files from Machine A to Machine B.

N
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. Launch the Migration Tool (M gr at el HA. exe for 32-bit or M gr at el HA x64. exe for 64-bit) with

Administrator privileges.

. Select Options > Configure Options.

. In the Server pane, enter the Server name.

. In the Tags to Migrate pane, ensure that the Migrate All Tags option is selected

. In the Options pane, enter the IHC File path in the Config File path field, using the browse button.

The path you enter is the path to the .IHC file brought over from Machine A.

7. In the Time to Migrate pane, ensure the Use IHA TimeFrame option is selected.

8. Ensure Throttle Output is selected.

9. To migrate the data, select File > Migrate Historical Data and select the archive file that has the

10.
11.

oldest data.

The tags and data are migrated to the default data store in time slices. The MigratelHA window
displays the progress and any Tag Add or Data Add errors are displayed in the log file. You can
estimate the remaining time by watching the progress.

Repeat the previous steps for each of the remaining archives, from oldest to newest data.

Add the collector to the Historian Server on Machine B.

See the Adding a Data Collector to an Historian Server topic in Data Collectors - General.
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Migration Tool Command-Line Syntax

Command Syntax

» For 32-bit:

Mgratel HA. exe "<IHA file nanme with full path>" "<IHC filenane with full path>"

 For 64-bit:

M gratel HA x64. exe "<IHA file name with full path>" "<IHC filename with full path>"

Command-line Options

Option Description

/ NOTHROTTLE This does not throttle any part of the migration process, but may impact resources
on the server. Optionally, you can remove this switch as required. By default, throt-

tling is rated at 5000 events per second.

/ NOVESSAGES This does not migrate messages into the newly created archive. Using this switch
may or may not reduce the size of your archives, depending on the number of mes-
sages stored in the archive. By default, messages are migrated if this switch is not

used.
/ EXI STI NGTAGS This will migrate data for only those tags that exist in the destination archiver.
/b This option of the st art . exe file allows the IHA Migration tool to start without

opening a new window for each instance.

If you are migrating a pre 4.5 IHA file you will need to have the IHC file for that IHA
and specify the IHC file in the Options window or on the command line. Otherwise,

you will get a warning message.

/ wai t This option of the st ar t . exe file allows each instance of the IHA Migration tool

to complete the migration before starting the next migration in the sequence.

/ NO HC This option skips verifying for IHC file and proceed with the migration. IHC file is
not required, if batch command have /NOIHC option.
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Notes

« If you are migrating from a command line, provide IHC file, else, use /NOIHC option to omit the IHC
file.

« If you do not have the IHC or you are not sure you have the correct IHC then you should use the
pre-4.5 version of MigratelHA to migrate the IHA. Otherwise, the data will not migrate correctly.

* You should keep a copy of the original IHA file.

 The IHC must contain all the tags that are in the IHA file, so use the most current IHC you have.

* You must use double quotes when you enter the IHA and IHC file even if you do not have spaces in
your file path or file name.

« Migrating an IHA will upgrade it to 4.5 format.

« If you are migrating a 4.5 IHA you should provide the IHC file in the Options window but if you do
not have the IHC you can safely continue past the warning message.

Creating a Batch File to Migrate Multiple IHA Files

The IHA Migration utility migrates only one archive at a time by design. However, if you need to add more
than one archive at a time, you can create a batch file to automate multiple archive merges.

When creating a batch file you need to provide the batch file with a logical name and save the batch
(. bat) file in a location that can be easily accessed using the command prompt.

Note:

When migrating any archive, you should start with the archive with the oldest data first, followed

by newer data, in sequence, to minimize the amount of disk space used in the Data Archiver.

For example:

cd c:\Program Fil es\ Hi storian
start /b /wait mgrateiha / NOTHROTTLE / NOVESSAGES
“c:\Historian Data\Backups\server_Archi ve001.i ha"

"c:\Historian Data\Backups\server_Config.ihc".

Interoperability of Historian Versions

Interoperability guidelines for Historian versions include:
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« Historian Collectors below v6.0 can write to Historian v7.0 Archivers; however, since the earlier
collector versions cannot automatically connect to a mirror, users need to point those collectors to
the mirror system.

« Historian Clients below v6.0 can retrieve data from Historian v7.0 Archivers.

« Historian v7.0 or later Clients can retrieve data from a single Historian Data Archiver below v6.0.

« Historian v7.0 or later Collectors can write to a single Historian Data Archiver below v6.0.

« An SDK program built on an Historian v7.0 or later node does not run on an Historian below v6.0.

+ An SDK program that you created in Historian below v7.0 must be rebuilt on a computer with
Historian v7.0 or later if you want to run it on that version.

- It is recommended that you use consistent versions of client and server applications. If you do
use different client and server versions of the Historian, regularly back up all archives and tag
configurations.

- N
Note:
To determine the version of the server, client, and SDK, select the About link in Historian
Administrator. The version of the Historian installer can be seen in the Control Panel / Uninstall
programs; this version is different from the Historian core version seen in Historian Administrator

About link.
o J

Migrate User Authentication Data from Historian to Common Proficy
Authentication Service

Starting Historian 8.0 version, you can use the common Proficy Authentication service.

Note:

You can either choose the common Proficy Authentication deployed by any other products such

as, Operations Hub, Plant Apps; or the common Proficy Authentication deployed by Historian.

To use the common Proficy Authentication service, you must migrate the Proficy Authentication data
should from Historian to the new local or external Proficy Authentication.

To enable this migration of data the uaa_confi g_t ool isintroduced.
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e N

Note:

» While migrating Proficy Authentication details, we are setting default password as user123
for all the users. You should change it using Proficy Authentication config tool once
migration is done.

- While setting up new password, it may ask you to enter the port number. By default, the
port number is 443. If you have provided a different value in the Public https port field in
the TCP port assignments page while installing Web-based Clients, you must provide that
value.

« Using this tool, you can back up the Proficy Authentication data only for Historian 7.2 or

earlier. And, you can migrate the data to Historian 8.0 or later.

! Important:
Back up the data before upgrading to the latest version of Web-based Clients.

- J

It includes the following tasks:

1. Back up Historian Proficy Authentication data.
2. Migrate the data to an existing common Proficy Authentication service.

1. Open Command Prompt.

2. Mount the ISO and navigate to the Utilities folder where the uaa_confi g_t ool . exe file is located.
After installation, uaa_config_tool is available in the following folder as well: <i nst al | ati on
drive of Historian> ProgramFiles\GE Digital\Historian Config

! Important:
You should back up the data before upgrading to 8.0 (Web-based Clients)

3. Enter the following command to take a back up of the data:
C.\ uaa_config_tool.exe backup_data -d "<destination fol der>"

<destination fol der> is the location where you want to save the back up files. Note that you must

enter the value in quotes.
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Note:
You may be prompted to enter the password twice for Historian Database and Proficy
Authentication. Enter the password as GEIP123User

Back up is generated and the data is saved in the destination folder.
4. Copy the backup files to the machine where Web-based Clients are installed.
5. Enter the following command to migrate the data:
uaa_config_tool.exe mgrate _data -h <host-addr> -m <portnun> -u <username> -s <secret> -

"<l ocation path of backup files>"

Exanuﬂe:uaa_config_tool.exe mgrate_data -h vmhi stwi n2016 -m 443 -u adnmin -s gowt 43df -1

"c:\ myuaabackupfil es"

o ™
Note:
While migrating Proficy Authentication details, it may ask for port number at migrating
historian database. The default value is 8432. If, however, you have provided a different
value in the Historian database port field in the TCP port assignments page while

installing Web-based Clients, provide that value.

Value Description

<host-addr> Address of the host or destination where you want to

migrate the data.

<portnum> Port number of the destination.

<username> Username

<secret> Client Secret

<location path of backup files> Source location where the data is backed up.

- The data is migrated to the destination that is, common Proficy Authentication service.

- The unt | og file is generated containing the details about backup and migration for users and
groups.

« The User _mi gration_report is generated which contains the migration status of the user data.
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Note:
Creation and migration of users and groups can fail of the user or group already exists in the
destination.

If user migration fails, you can change the username in the backup file and repeat Step 5.

Implementing Historian Security

Implementing Historian Security

Historian is a high performance data archiving system designed to collect, store, and retrieve time-based
information efficiently. By default, access to these Historian archives, tags, and data files is available to
any valid operating system user account. In this default environment, all users are allowed to read, write,
change, and delete archives, tags, or data files in Historian Administrator, SDK, migration tools, and Excel
Add-In. However, you may want to make these features and data available only to authorized personnel.
You can do this by creating and defining Historian security groups in your Windows Security.

Historian includes an Electronic Signature and Electronic Records security feature. This option provides
installations related to the FDA's 21 CFR Part 11 regulation or any site interested in added security or
tracking the ability to require a signature and password every time a change in data or configuration is
requested. For more information on the Electronic Signature and Electronic Records feature, refer to
Historian in a Regulated Environment (on page ).

To ensure a secure environment when using Historian security, do not create any local user accounts

unless Historian is set up on a standalone machine.

Whether or not you use Historian security, make sure that you disable Guest accounts on your computer

to limit access to valid Windows user accounts.

To run Proficy Authentication commands, refer to Managing Proficy Authentication Users Using the
Configuration Tool (on page 223).

About Protecting Your Process

If you want to restrict access to Historian archives, files, and tags, or protect your data files from
unauthorized changes, you can enable Historian security. Using security is optional and is disabled by

default. By enabling security, you can restrict access to:

 Modifying data using Excel Add-In
- Updating security for individual tags or groups of tags


unique_102
unique_102
unique_102
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« Creating, modifying, and removing tags
- Tag protection (adding, modifying, removing, and so on) can be applied at a global level to all tags

or at the individual tag level.

Refer to Implementing Tag Level Security for more information.

 Reading data in the iFIX Chart object, Excel Add-In, and Migration Utilities
- Writing data

- Starting and stopping collectors

« Creating and deleting collectors

- Creating, modifying, and deleting archives

Historian uses the operating system security groups to create a security structure. You can enable
security for a particular set of functions by adding specific Historian Security Groups to your groups. You
can also add security groups to your domain controller.

By defining one or all of the groups, you begin to set up a security structure. Refer to the Historian Security

Groups section for more information on the Historian Security Groups available.

Strict Authentication

With Historian's strict user account authentication features, Enforce Strict dient Authentication and
Enforce Strict Collector Authentication,you can control access to the Historian server and safeguard

user account credentials.

With strict authentication enabled, only known user accounts configured on the Data Archiver server
computer will be able to access a Historian server. Similarly, enabling strict collector authentication

enforces the same requirement for incoming collector connections.

For an account to be known at the Data Archiver, it has to exist on that archiver as a local account or exist
on a Domain Controller available to the data archiver. Historian will access the local accounts or Domain
Controller via Microsoft's Security Support Provider Interface (SSPI) and this involves having a Kerberos

server setup optionally to assist in account validation.

By default, strict client and collector authentication is enabled on new installations to maximize security.
When upgrading from a previous version of Historian, strict client and collector authentication is disabled
to allow compatibility with older clients or collectors that cannot be upgraded concurrently.

It is recommended that all clients and collectors receive timely upgrade to the latest version, which
permits enabling both strict client and collector authentication on the server for the highest security
configuration.
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By treating clients and collectors separately, it is possible to accommodate new and legacy authentication

during the upgrade process. However, upgrading all clients and collectors to the latest version

immediately will achieve a high level of security. The two options, Enforce Strict Client Authentication

and Enforce Strict Collector Authentication, permit flexibility during the upgrade process by selectively

accommodating legacy clients and collectors.

Local and Domain Security Groups:

You can choose local or domain security groups to access Historian. To do so, in Historian Administrator

> Data Stores > Security, select Use Local or Use Domain. The following table provides recommended

group to use based on the machine configuration and the security group of the logged-in user.

. . . Security Group of .
Machine Configuration Recommended Security Group
the Logged-In User

Workgroup Local Local

Domain Local Domain
For domain machines, we recom-
mend that you log in with a do-
main-level user and create se-
curity groups in the domain con-
troller machine.

Domain Domain Domain

Strict Authentication Options:

This table provides guidelines about the different combinations of strict client and collector

authentication options and their use:

Strict Client Au-
thentication

Strict Collector
Authentication

Comment

Enabled

Enabled

Use this for highest available security. You will need to install
SIMs, if available on all pre-6.0 collectors and clients. Clients
can refer to any program that connects to the Data Archiver.
This includes Historian Administrator, Microsoft Excel, any
OLE DB program, user written programs, or any other Proficy

software.
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Strict Client Au- Strict Collector
L L Comment
thentication Authentication
Enabled Disabled Use this if you are unable to upgrade collectors to the latest
version if there is no SIM update for your collector.
Disabled Enabled Use this if you have to support legacy clients and you are un-
able to install the SIM update on all clients.
Disabled Disabled Use this for maximum compatibility with existing systems.

Trusted Connections in Distributed Historian Service Environment:
This trusted connection works only in the Domain environment and it is enabled by default.

Note:

If you are adding a mirror copy to an existing node, make sure that both the nodes are in the same

domain.

If you want to work in the workgroup setup, contact Online technical support &

GlobalCare:www.digitalsupport.ge.com.

Disabling Strict Client and Collector Authentication

To permit older versions of clients and collectors to access a Historian 7.0 (or later) server, disable strict
client and collector authentication.

1. Open the page and select DataStore Maintenance Security.
2. In the Global Security section:
o Select the Disabled option button for Enforce Strict Client Authentication.

> Select the Disabled option button for Enforce Strict Collector Authentication.

Security Strategy Guidelines

When you begin to implement security, you should first define a clear strategy. Consider the following
when beginning to set up your security strategy:

- If you disabled the Guest account, a user must provide a valid username and password even if no
groups are created.

« Protection is only provided for the functional areas for which you have built the associated
Historian Security Groups.


http://digitalsupport.ge.com/
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- If you only choose to define some of the security groups, all users still have all access to any
uncreated groups. All users are still assumed to be a member of a group unless that group has
been created, with the exception of iH Audited Writers group. You must add the iH Audited Writers
group to the Windows security groups so that a user can become a member of this group.

For example, if you elect to define the iH Security Admins group and iH Archive Admins group, both
the members associated with those defined groups and all other valid users still have access to
such functions as creating and modifying tags until you create the iH Tag Admins security group.

« If you implement any Historian Security groups, you must first add and define the iH Security
Admins group.

Note:

If you do not create and define the iH Security Admins group, all valid users are assumed to be

members of this group. This membership overrides any other security group that you set.

See also Historian Security Groups (on page 195).

Setting Historian Login Security

Use Historian Login Security settings if you want to validate users at the Data Archiver, instead of at the
client. By applying these settings, users and applications are forced to provide a user name and password
at connect time so that the archiver can validate them. For example, users in the security group such asi h
Security Adnins will be checked by the Archiver.

For Historian Login Security settings, you can view and set the property from the HistorianSDKsample

server properties. The current setting is shown in the data archiver SHWfile.
Historian Login Security property is available only in Historian SDK.

To set login security using the Historian SDK:

1. Run the SDK sample.

2. Connect to a server.

3. Select the server in the list box.
The Server Properties window appears.

4. On the right side of the window, locate the AllowClientValidation setting. By default, this value is
set to TRUE. Select to set to FALSE, and select OK.
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Historian Security Groups

Historian provides the following security groups:
iH Security Admins

Historian power security users. Security Administrators have rights to all Historian
functions. This group also has the ability to change tag level security, archive security, and
modify the Electronic Records and Signatures option. This is the only Historian security
group that overrides tag level security.

iH Collector Admins

Allowed to start and stop collectors, browse collectors, configure collectors, and add new
collectors.

iH Tag Admins
Allowed to create, modify, and remove tags. Tag level security can override rights given to

other Historian security groups. Tag Admins can also browse collectors.

iH Tag Admins are not responsible for setting Tag Level Security. This task can only be
performed by an iH Security Admins. For more information on setting Tag Level Security,

refer to the Implementing Tag Level Security section.
iH Archive Admins

Allowed to create, modify, remove, backup, and restore archives.
iH UnAudited Writers

Allowed to write data without creating any messages.

iH UnAudited Logins

Allowed to connect the DataArchiver without creating login successful audit messages.
iH Audited Writers
Allowed to write data and to produce a message each time a data value is added or
changed.
Tag, archive, and collector changes log messages regardless of whether the user is a
member of the iH Audited Writers Group.
iH Readers

Allowed to read data and system statistics. Also allowed access to Historian Administrator.

Use this table to identify the types of user groups you need to create and define in your security system.
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Function

iH Se-
curity
Admins

iH Un-
Audited
Writers

iH Un-
Audit-
ed Login

iH Au-
dited
Writers

iH Read-

ers

iH
Archive
Admins

iH Tag
Admins

iH Col-
lector
Admins

Create
Tags:

o Ex-
cel
Addt
In

» SDK

* His-
to-
ri-
an
Ad-
mins

* File
col-
lec-
tor

Remove

Tags:

* His-
to-
ri-
an
Ad-
mins

» SDK

Modify
Tags:
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Function

iH Se-
curity

Admins

iH Un-
Audited
Writers

iH Un-
Audit-
ed Login

iH Au-
dited
Writers

iH Read-

ers

iH
Archive
Admins

iH Tag
Admins

iH Col-
lector
Admins

o Ex-
cel
Addt

» SDK

* His-
to-
ri-
an
Ad-
mins

- File
col-
lec-

tor

Modify
Archive

Security:

» SDK
* His-
to-
ri-
an
Ad-

ming

Backup
Archive:

» SDK
* His-
to-

ri-
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Function

iH Se-
curity
Admins

iH Un-
Audited
Writers

iH Un-
Audit-
ed Login

iH Au-
dited
Writers

iH Read-

ers

iH
Archive

Admins

iH Tag
Admins

iH Col-
lector
Admins

an
Ad-

ming

Restore
Backup:

- SDK
* His-
to-
ri-
an
Ad-

ming

Create
Archive:

- SDK

* His-
to-
ri-
an
Ad-

ming

Start/
Stop Col-
lector:

» SDK
* His-
to-

ri-

an
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Function

iH Se-
curity
Admins

iH Un-
Audited
Writers

iH Un-
Audit-
ed Login

iH Au-
dited
Writers

iH Read-

ers

iH
Archive

Admins

iH Tag
Admins

iH Col-
lector
Admins

Ad-

min

trol
(iFIX

* Mis-

sion

Cont

Browse

Collector:

* His-
to-
ri-
an
Ad-

min$

Read Da-
ta:

Ob-
ject
o Ex-
cel
Addt
In
» SDK

» Chart

Write Da-
ta (UnAu-
dited):
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Function

iH Se-
curity
Admins

iH Un-
Audited
Writers

iH Un-
Audit-
ed Login

iH Au-
dited
Writers

iH Read-

ers

iH
Archive

Admins

iH Tag
Admins

iH Col-
lector
Admins

o Ex-

cel

In
» SDK

Addr

Write Da-
ta (Audit-
ed):

e Ex-
cel

In
» SDK

Addr

Modify
Data:

. EX'
cel

In
« SDK|

Addr

Update
Security
for Tag:

o Ex-
cel
Addt
In

» SDK

* His-

to-
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iH Se- iH Un- iH Un- iH Au- iH iH Col-

. . . . . iH Read- . iH Tag

Function curity Audited Audit- dited Archive lector
ers Admins
Admins | Writers | ed Login | Writers Admins Admins

ri-

an

Ad-

mins
Migrate:

o Mi-
X

gra-

tion

Tools
Login
Connec-
) X X X X X X X
tion Mes-
sages
Recalcu-

X X X X

late Data

Configure Internet Protocol Security (IPSEC)

Historian supports encryption based on Internet Protocol Security to secure traffic between various
Historian components and collectors without the need to use VPN or other security protocols.

1. Run wf . nsc.
The Windows Defender Firewall with Advanced Security window appears.
2. Create a security method:

a. Select Actions > Properties.
The Windows Defender Firewall with Advanced Security on Local Computer window

appears.
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Windows Defender Firewall with Advanced Security on Local Com... X

Domain Profile  Private Profile  Public Profile  |Psec Settings

Specify behavior for when a computer is connected to its corporate
domain.
State

i F Firewall state: On (recommended) v

Inbound connections: Block (default) e
Outbound connections: Allow (default) v

Protected network connections: Customize...

Settings

7— 1 Specify settings that control Windows

¥— | Defender Firewall behavior. Customize...

Logging

| Specify logging settings for _
Q troubleshooting. Customize....

oK Cancel Apply

b. Select IPsec Settings > Customize.
The IPsec Defaults window appears.
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Customize IPsec Defaults X

IPsec will use these settings to establish secured connections when
there are active connection securty rules.

When you use the default options, any settings in a GPO with a higher
precedence are used.

Key exchange (Main Mode)
(O) Default (recommended)
(® Advanced Customize...

Data protection (Quick Mode)
(@ Default frecommended)
() Advanced

Authentication method
(@ Default

(O) Computer and user (Kerberos V5)
(O) Computer (Kerberos V5)

() User (Kerberos V5)

() Advanced

oK Cancel

c¢. Under Key exchange (Main Mode), select Advanced > Customize.
The Customize Advanced Key Exchange Settings window appears.
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Customize Advanced Key Exchange Settings X

Secunty methods

Use the following security methods for key exchange.
Those higher in the list are tried first.

Security methods:

Integrity Encryption Key exchange algonthm

SHA-1 AES-CBC 128  Diffie-Hellman Group 2 (defaul) -
SHA-1 3DES Diffie-Heliman Group 2

Key lifetimes Key exchange options
Specify when a new key is generated. If you select [] Use Diffie-Hellman for enhanced
both options, a new key is generated when the first security.
threshold is reached.
Compatible with Windows Vista
and later.
Minutes: 480 =
Sessions: 0=
0K Cancel
d. Select Add.

The Add Security Method window appears.

e. Select the algorithms that you want to use for each purpose. The following image shows an
example.
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Add Security Method X
Integrity algorithm:
SHA-384 v

@ Compatible with Windows Vista SP1 and later.

Encryption algorithm:
AES-CBC 256 v

Stronger than AES-192. higher resources usage.
Compatible only with Windows Vista and later.

Key exchange algonthm:
Elliptic Curve Diffie-Hellman P-384 v

Strongest security, highest resources usage.
Compatible only with Windows Vista and later.

OK Cancel

! Important:
You must provide the same values for all the machines for which you want to
configure IP security.

The security method that you have added appears in the list.
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Customize Advanced Key Exchange Settings

Security methods
Use the following security methods for key exchange.
Those higher in the list are tried first.
Security methods:
Integnity Encryption Key exchange algonthm

SHA-1 AES-CBC 128  Diffie-Hellman Group 2 (defautt)
SHA-1 3DES Diffie-Hellman Group 2

SHA-384 AES-CBC 256 Elliptic Curve Diffie-Hellman P-384 -

Add... Edit... Remove

Key lifetimes Key exchange options

Specify when a new key is generated. i you select [] Use Diffie-Heliman for enhanced
both options, a new key is generated when the first security.
threshold is reached.
Compatible with Windows Vista
and later.

Minutes: 480 2
Sessions:

L=
a0

[ ok ][ conce

f. Move the security method that you have added to the top of the list. We recommend that
you remove the other methods.

g. Select OK.
3. Add integrity and encryption algorithms:

a. In the Customize IPsec Defaults window, under Data protection (Quick Mode), select
Advanced > Customize.

The Customize Data Protection Settings window appears.
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Customize Data Protection Settings X
Data protection settings are used by connection security rules to protect network traffic.
[ Reguire encryption for all connection securty rules that use these settings
Data integrty Data integrity and encryption
Protect data from modfication on the network with these Protect data from modiication and preserve confidentiaity on the
integrty algorthms. Those higher in the kst ane tned first network with these integrty and encryption algorthma. Those
higher in the list ane tried first
Diata infegrity algorthms Data integrty and encryption algorthms
Protocol Integrity Kay Lifetime (mnutes®B) Protocol Integrty Encryption  Kay Lfetime (mi
ESP SHAA 60/100.000 ESP SHAA AESCBC 60/100,000
AH SHA-1 60/100,000 ESP SHAA 3DES 60/100,000
[k ]/ conce

b. Select the Require encryption for all connection and security rules that use these settings

check box.

c. Under Data integrity and encryption, select Add.
The Add Integrity and Encryption Algorithms window appears.
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Add Integrity and Encryption Algorithms

Protocol

(® ESP (recommended)

ESP protocol provides privacy and integrity for the packet
payload. ESP is compatible with Network Address
Translation (NAT).

(O ESP and AH

Adding the AH protocol provides additional integrity for the IP
header. This option is not compatible with NAT.

Algorithms
Encryption algorithm: AES-CBC 128 v

@ Faster and stronger than 3DES. Compatible only with
Windows Vista and later.

Integrity algorithm: SHA-1 e

@ Stronger than MD5, uses slightly more resources.

Key lifetimes
Minutes: 60 =
KB: 1,00,000 -2

OK Cancel

d. Under Protocol, ensure that ESP is selected.

e. Select the algorithms that you want to use for each purpose, and then select OK.
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The algorithms that you have selected appear in the list.

f. Move the algorithms to the top of the list. We recommend that you remove the remaining
items in the list.

g. Select OK.

4. Create a first authentication method:

a. In the Customize IPsec Defaults window, under Authentication Method, select Advanced >
Customize.

The Customize Advanced Authentication Methods window appears.

Customize Advanced Authentication Methods

First authentication Second authentication

Specify computer authentication methods to use during IPsec Specify user authentication methods or a health cedificate to use
negotiations. Those higher in the list are tried first. during IPsec negotiations. Those higher in the list are tried first.
First authentication methods: Second authentication methods:

Method Additional Information Method
Computer (Kerberos ...

Additional Information

Add... Add...
] First authentication is optional [J Second authentication is optional

A second authentication cannot be specified when a preshared
key is in the first authentication methods list.

==

b. Under First authentication methods, select Add.
The Add First Authentication Method window appears.
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Add First Authentication Method
Select the credential to use for first authentication:

(® Computer (Kerberos V5)

(C) Computer (NTLMv2)
() Computer certificate from this certification authority (CA):

Signing algorithm: RSA (default)

Certificate storetype:  Root CA (default)

(O) Preshared key (not recommended):

Preshared key authentication is less secure than other
authentication methods. Preshared keys are stored in plaintext.
When preshared key authentication is used, Second
Authentication cannot be used.

OK Cancel

c. Provide the CA certificate that you want to use, and then select OK.
The certificate that you have provided appears in the list.
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d. Move the certificate to the top of the list. We recommend that you remove the remaining

items in the list.
e. Select OK.

5. Create a connection security rule:

For Windows x86, run the following set of commands to create a rule:

netsh advfirewal |

consec

add rul e name=""<rul e nane>"" endpoi nt 1=any endpoi nt 2=any protocol =tcp port l=any port2=2010

acti on=r equesti nrequest out

For other versions, perform the following steps:

a. In the Windows Defender Firewall with Advanced Security window, select Connection

Security Rules.

b. Select Actions > New Rule.
The New Connection Security Rule Wizard window appears.

Rule Type

Steps:
# Rule Type
p Requirements
Authentication Method
p Profile

& Name

9 New Connection Security Rule Wizard
y

Select the type of connection security rule to create.

What type of connection security nule would you like to create?

(® Isolation
Restrict connections based on authentication criteria, such as domain membership or
health status.

() Authentication exemption
Do not authenticate connections from the specified computers.

() Serverto-server
Authenticate connection between the specified computers.

) Tunnel
Authenticate connections between two computers.

() Custom

Custom rule.

Note: Connection security rules specify how and when authentication occurs, but they do not
allow connections. To allow a connection, create an inbound or outbound rule
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c. Select Custom, and then select Next.

d. Both for Endpoint 1 and Endpoint 2, select Any IP Address, and then select Next.

e. Select Require authentication for inbound and outbound connections, and then select Next.
f. Select Default, and then select Next.

g. Enter values as described in the following table, and then select Next.

Field Description
Protocol type Select TCP.
Endpoint 1 port Select All Ports.
Endpoint 2 port Select Specific Ports, and then enter 2010.

h. Select when to apply the rule, and then select Next.

. Enter a name and description for the rule, and then select Finish.

The rule appears in the Connection Security Rules window.
j. Ensure that the rule is enabled.

6. If using Microsoft Windows Server 2019, 2016, 2012 R2 and/or Windows 8, 8.1, open up port
number 5000:

a. In the Windows Defender Firewall with Advanced Security window, select Inbound Rules.

b. Select Actions > New Rule.
The New Inbound Rule Wizard window appears.
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i
Rule Type
Select the type of firewall rule to create.

Steps:
Rule Type
Program
@ Action
@ Profile

# MName

® Program

) Port

) Predefined:

(C) Custom

What type of rule would you like to create?

Rule that controls connections for a program.

Rule that controls connections for a TCP or UDP port.

T
-30:200

@Firewall AP dll,
Rule that controls connections for a Windows experience.

Custom nule.

Bac Mext = Cancel
c. Select Custom, and then select Next.
d. Select All programs, and then select Next.
e. Enter values as described in the following table, and then select Next.
Field Description

Protocol type
Protocol number
Local port

Remote port

Select UDP.
Leave the default value as is.

Select Specific Ports, and then enter 5000.

Leave the default value as is.

f. Both for the local and remote IP addresses, set the scope to Any IP address, and then select

Next.

g. Select Allow the connection, and then select Next.
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h. Select when to apply the rule, and then select Next.

i. Enter a name and description for the rule, and then select Finish.
The rule appears in the Inbound Rules window.

j- Ensure that the rule is enabled.

IPSEC is now configured on the machine.
7. Repeat all the steps above on all the machines that host the Historian server and/or its
components/clients.

8. To verify that the IPSEC cryptography is used:
a. Ensure that the Historian server is running.

b. Ensure that the collectors are connected to the Historian server, and that the collectors are

running.
c. Specify the tags for data collection. You can do so using Configuration Hub (on page )
or Historian Administrator (on page ).

d. Verify that the collector is collected data.

e. On each machine on which you configured IPSEC, run wf . nsc.

The Windows Defender Firewall with Advanced Security window appears.

f. Select Monitoring > Security Associations > Main Mode.
The Main Mode section displays the connection that you have created.

Security Setup Example

The following example takes you through the process of establishing your security needs and defining

and setting up the levels of security.

For this example, assume the following user needs in a plant of 14 users:

User Needs Added to Security Group
USERT Power user. Needs total access to security. iH Security Admins
USER2 - Read/Write Data (no messages). « iH UnAudited Writers
- Create, modify, and delete tags. « iH Tag Admins
USER3



unique_109
unique_109
unique_109
unique_110
unique_110
unique_110
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User Needs Added to Security Group
USER5 - Backup, restore, and create archives. * iH Archive Admins
« Connect to Data Archiver without creating login * iH UnAudited Logins
USER6 .
successful audit messages
USER8
USER4 « iRead/Write Data (no messages). « iH UnAudited Writers
- iCreate, modify, and delete tags. « iH Tag Admins
USER7 « iStart/Stop Collectors. « iH Collector Admins
- iBackup, restore, and create archives. « iH Archive Admins
USER9-14 Read Data. iH Readers

1. Establish the needs of your users. For this example, assume the user needs in a plant of 14 users,

as described in the previous table.
2. Add and define the iH Security Admins Group.
Once you determine that you want to establish a security structure, you must create and define

the iH Security Admins group. This group of users is typically the "power users" of the Historian.

Security Administrator rights allow them to manage configuration and give them free rein to the

entire system. For this example, only USER1 would be added to the iH Security Admins group.

3. Establish and create any other Historian Security Groups as needed.

-~

N

_ I
Note:
Any user with Windows administrative permissions can add or remove Windows groups
and users. As such, an administrator on a Windows computer, can add himself to any
Historian security group.
J

Set up the functional security groups as needed. For this example, Write, Tag, Archive, and

Collector security is required, so the groups associated with those functions should be added and
defined. There is no need for Audited Writers and all valid users can read data, so neither the iH

Audited Writers Group nor the iH Readers Group need to be added.

. Define any individual Tag Level security.

In addition to defining iH Tag Admins that have the power to create, modify, and remove tags, you
can also define individual tag level security to restrict access to sensitive tags. You can grant read,
write, or administrative privileges per tag. For more information on setting Tag Level security, refer
to the Implementing Tag Level Security section.
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Setting Up Historian Security Groups

This section describes how to add the Historian Security Groups to your local and domain Windows

security systems.

You can choose whether Historian uses LOCAL or DOMAIN security by selecting an option on the Security
section of the Data Store Maintenance page in Historian Administrator. If you select the local security
option, the groups are defined as local groups on the Historian server. If you select the Domain security
option, the groups are defined as global groups in the primary domain controller of the Historian server.
With domain security, Historian locates the Primary Domain Controller (PDC), if available, or a Backup
Domain Controller (BDC) in order to establish groups. If the PDC and all BDCs are unavailable, the system
locks all users out until rights can be established with a valid PDC or BDC.

Note:

If you change this setting, you must stop and re-start the Historian server for this change to take

effect.

Creating a Local Group on Windows

1. Do a Windows search and open Computer Management.
The Computer Management console appears.
2. In the left-side pane, expand System Tools, and then expand Local Users and Groups.
3. Select Groups in the system tree.
The list of all the available groups appear.
4. In the right-side pane, select Groups > More Actions, and then select New Group.
The New Group window appears.
5. Enter the Historian Security Group name in the Group Name field.
For a list of available Historian Security Groups and their functions, see Historian Security Groups

(on page 195).

Note:

You must enter the Historian Security Group name exactly as it appears. The security

groups are case sensitive.

6. Optionally, enter a description of the Historian Security Group in the Description field.
7. Select Create.
8. Select Close.
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Adding Users to Windows Security Group

Add your users to the Windows system.

1. Do a Windows search and open Computer Management.
The Computer Management console appears.

2. In the left-side pane, expand System Tools, and then expand Local Users and Groups.

3. Select Groups in the system tree.
The list of all the available groups appear.

4. Select the group to which you want to add users.

5. In the right-side pane, select the user > More Actions, and then select Properties.
The user Properties window appears.

6. Select Add.

7. Select the users or groups to add from the listed users or enter the names of the users or groups
you want to add in the bottom field.

8. Select Add.

Note:

To validate the user or group names that you are adding, select Check Names.

9. When you have added all users to the group, select OK.

Adding a Local or a Domain User

1. Verify object type is Users or Groups.
2. If you want to add a local user, verify the From This Location setting is your local machine. (Select
Locations to specify the local machine, if required.). If you want to add a domain user:
a. Select Locations to specify the domain, if required.
b. Select Entire Directory or the specific domain underneath Entire Directory.
c. Select OK.
3. Select Advanced.
The Advanced window appears.
4. Select Find Now.
5. From the list of users, select the users or groups to add or enter the names of the users or groups
you want to add in the bottom field.
6. In the Advanced window, select OK.
7. In the Select Users window, select OK.
8. In the Group Properties window, select OK.
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Active Directory Setup - an Overview

Historian Active Directory setup supports integration with complex models that include the following

complexities:

« Users and administrators may belong to different domains within a forest.
« Domains may have sub-domains (multi-level) that need to inherit or refine on inherited permissions

« Group names may be longer than average to cater for group differentiation

The Active Directory setup supports authentication and authorization of users as members of groups
from trusted or sub-domains (including assigning appropriate Historian access rights in line with

Historian security roles/groups access).

The following figure provides an overview of the Active Directory setup with examples:

Us.com

Users: USUserl, USUser2 USGroupUserl
Groups: USGroupl

USGroupl = USGrouplserl

// \x, Europe.us.com
/ \F Users: Europellserl, Europelserl? EuropaGrouplUserl
= Groups: EuropeGroupl
Europe. EuropeGroupl = EuropeGroupUserl
US.com
// \u—v
\ India.Europe.us.com

- [FRSEEHE Users: [ndialLlserl, Indla-U5er12,IndIaGraupUserl
us Groups: IndiaGroupl, Historian security groups
o Szl IndiaGroupl =* IndiaGroupUserl

A Forest which itself is a
Domain Controller (DG R
(bc) Historian
Server

Domain Controller (DC)

Configuring the Domain Users for active directory setup
To configure the domain (single\multi) environment in Historian Administrator:
Historian Security Groups should be created on the machine where the Domain controller of the Historian

Server is installed. The India.Europe.US.com domain controllers must contain the following Historian

groups:
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* iH Security Admins

« iH Collector Admins

« iH Tag Admins

« iH Archive Admins

« iH UnAudited Writers
* iH UnAudited Logins
« iH Readers

* iH Audited Writers

Note:

Historian Security Groups should be of type Domain-Local only.

1. On the Data Stores section, under Security > Global Security, select the Use domain option.

e z Abouk
Proficy” Historian _ .
cy DasSloe Maitensnce  2Main  Plags T Collectors @ DataStores € Messages  PHalo

BnRename Data Stose ) Add Data Store B Add Hew Archivels) R Aschive It
Data Stores Security Options
|Uses | Archive Detais | Data Siore Detais | Data Store Options | Giobal Options [ Securty || Alrms |
Archives .
Hare ot Tine Global 5 ecuity
User_ConfigServerd_Aschev... 3/19/2018 50000 Securiy Groups  UseLocal
User_Configbervest_Archev.. /1842018 5:00:00 . : .
User_ConligServe_Auchev.. 9/17/2018 50000 . Enfowce Stict Clant Aulbwriiostion. (¥ Enebled ¢ Dissbled
Uesi_ConbgSerceE_fschee.. 3A6/2018 500000 .. Erdoece Stact Collecior Authentication (= r
User_ConfigSenved_ fuchiv.. /15201850000 . ' e R
User_CorlgSenet_dschre 91 4/2018 50000
User_ConhgServeds_Archee.. 912208 500000 ., Electronie Signatures # Aeconds
User_ConfigServert_frchev... 971242018 5:00:00 .
e s Require Pont Vedlicstion C Enabied (& Disabled

Weshcation Message

o Ase Attemphing 1o Perfaim An Audited Acton. Please Conlim o Useimame and | -~

Pastveed 1o Corlinus

2. Stop the Historian Services.
3. Add the Registry Entries for ClientManager, ConfigManager and DataArchiver as shown below.
Registry path: \HKEY_LOCAL_MACHINE\SOFTWARE\Intellution, Inc.\iHistorian\Services\
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v HKEY_LOCAL MACHINE ~

MName Type Data
EEEDE[;DSDDDDD ab| (Default) REG_SZ (value not set)
HARDWARE 24 ClientTCPPort REG_DWORD (0x000036b0 (14000)
SAM FirewallPermissi... REG DWORD 000000001 (1)
SECURITY REG_QWORD 000000000 (0) I

~ | SOFTWARE

, {899E3936- 7F63-4843-85B4-CT1208FCDDFS}
AdoptOpenlDK

Aladdin Knowledge Systems
Classes

Clients

CrowdStrike

CVsM
DefaultUserEnvironment

GE

GE Digital

GE Fanuc Software, Inc.
Gemalto Sentinel

Google
Intel
v Intellution, Inc.
v iHistorian
) CollectorServiceExtensions
SecurityProviders
Servers

v Services
ClientManager

ConfighManager

DataArchiver

DiagnosticManager

4. Start the Historian Services. The new registry entries will now be read by the corresponding
Historian service.

Accessing Historian Server using Domain Users - Examples

Example 1: European domain user trying to connect to Historian Server installed in India.Europe.US.com
Domain Controller (DC).

1. Create a user EuropeUser1 in Europe.US.com DC.
2. Add the user (i.e. EuropeUser1) from Europe.US.com to “iH Security Admin” group in
India.Europe.US.com DC.

3. Log in to Historian Client using EuropeUser1 as shown below.
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Proficy Historian Administrator .

Proficy” Historian

Administrator Login

Server :l J

UserName |Europellserl

Passzd W

Domain

oK Help Cancel

4. EuropeUser1 is added to iH Security Admin. The user will get full access to Historian Server.

Example 2: US domain user trying to connect to Historian Server (which is installed in

India.Europe.US.com Domain Controller (DC).

a. Create a user USUser1 in US.com DC.
b. Add the user (i.e. USUser1) from US.com to “iH Readers” group in India.Europe.US.com DC

c. Log in to Historian Client using USUser1 as shown below.



Getting Started Guide | 1 - Getting Started Guide | 222

Proficy” Historian

Proficy Historian Administrator

Adrinistrator Login

Server [CONFIGSERVERG ~ .|
UserName |USUser
PESSWDId SEREE00 R 3
Domain |us.com|
0K Help Cancel

5. USUser1 is added to iH Readers. The user will get only data read access to Historian Server.

Adding Nested Domain Groups to Historian Security Groups

The following procedure describes, a European domain group user trying to connect to Historian server,

installed in India.Europe.US.com Domain Controller.

Create a user EuropeGroupUser1 in Europe.US.com DC.

Create a group EuropeGroup1.

1.
2.
3. Add the EuropGroupUser1 to EuropeGroup1.
4,

Add the group (i.e. EuropeGroup1) from Europe.US.com to “iH Security Admin” group in

India.Europe.US.com DC

[¢)]

. Log in to Historian Client using EuropeGroupUser1.

6. If a new user gets added to EuropeGroup1, then the user gets automatically synced with Historian

Security Groups.

Note:

As EuropeGroupUser1 is added to iH Security Admin, user will get full access to Historian

Server.

US domain group user trying to connect to Historian Server installed in India.Europe.US.com

Domain Controller.
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. Create a user USGroupUser1 in US.com DC (if not exist).

. Create a group USGroup1.

. Add the USGroupUser1 to USGroup1.

. Add the group (i.e. USGroup1) from US.com to “iH Security Admin” group in

o O T o

India.Europe.US.com DC
. Login to Historian Client using USGroupUser1.

—~ O

. If a new user gets added to USGroup1, then it gets automatically synced with Historian

Security Groups.

Note:

As USGroupUser1 is added to iH Readers, user will get data read access to Historian

Server

Managing Proficy Authentication Users Using the Configuration Tool

Use the Proficy Authentication Config tool to perform the following tasks:

« Add a local Proficy Authentication user.

Note:

Here a local Proficy Authentication user means a user defined by Proficy Authentication,

not by an external identity provider such as LDAP.

» Remove a local Proficy Authentication user.
* Reset the password for a local Proficy Authentication user.
- Add a local Proficy Authentication user to an existing group.

Since OAuth2 scopes are implemented as Proficy Authentication groups, this means the same as
adding a scope to a user.

- Remove a local Proficy Authentication user from an existing group.

A user who performs these functions acts as the admin client and needs to know the secret of the admin

client. The tool does provide a way for the user to cache the secret safely to be used later.

By default, this tool is available in the following folder: C: \ Program Fi | es\ GE Di gi tal \ Hi stori an
Confi g. Run the tool from a Windows command prompt window.

Syntax
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The tool’s syntax follows this format:

uaa_config_tool verb [options]
where verb is one of the following:

* add_user

* renpve_user

* set _user_password

* add_user _to_group

* renove_user _from group

* cl ear_secret

Run the tool without a verb or any other options to view the help page.

The uaa_config_tool utility prompts for a port number. This is the port number that you have specified in
the Public HTTS Port field in the TCP PORT ASSIGNMENTS page. By default, it is set to 443. If you have
changed the public HTTPS port number, enter the number. Otherwise, enter 443.

Options can be specified in the form of single dash followed by a short name, or double dash followed by
a long name, followed by the value of the option, if any. For example, you can specify the user name Al i ce
by either

-u Alice

or

--UserNane Alice

Table 6. Options

Short name Long name Remark

-t --Tar get URL of the Proficy Authentication instance that the command
should be performed on. Typically, the URLishtt ps:// | o-
cal host : 443/ uaa, which is the default value. This option
is optional and is only needed when the user wants to run the
command against a remote Proficy Authentication instance

(which is not recommended due to security concerns).

) --dientld ID of the client that the user is acting as. By default, it is ad-

ni n. This option is optional and is only needed when the ad-




Table 6. Options (continued)
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min has set up the Proficy Authentication to delegate certain
operations to others.

-s --dient Secret

This is the secret used to authenticate the user for acting as
the admin client (or an alternative client givenina--dientid
option). If the user has elected to cache the secret previous-
ly, then this option can be omitted. Otherwise, it has to be pro-
vided.

The password must satisfy the following conditions:

« Must not contain only numbers.
« Must not begin or end with a special character.
 Must not contain curly braces.

-C - - CacheSecr et

This option is not followed by a value and is optional. If spec-
ified, the tool will cache the client secret so when the next
time this tool is invoked the secret does not have to be spec-
ified. Note that the secret is encrypted and only the current
Windows logon user can access and decrypt.

-u - - User Nanme

Name of the user that the tool is being invoked for. For exam-
ple, the user that is being added or removed.

-p - - User Passwor d

The password for the user being added or whose password
is being reset. The option is only needed for the add_user and

set _user_password commands.

-g --Goup

Name of the Proficy Authentication group (scope) that the
user is being added to or removed from. The option is only
needed for the add_user_to_group and renove_user from -

gr oup commands.

Examples

+ To add a user named alice with the password Pa55word and the admin client secret myclientsecret

(this is the admin client secret that you entered while installing Web-based Clients):

uaa_config_tool add_user -u alice -p Pa55word -s nyclientsecret -c

If the Proficy Authentication server is on a remote machine named webhost.lab:
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uaa_config_tool add_user -u alice -p Pa55word -s nyclientsecret -t https://webhost.|ab: 443/ uaa -c

« To provide user privileges to access the Web Admin console and Trend Client:

uaa_config_tool add_user_to_group -u alice -g historian_visualization.user -t https://webhost.|ab: 443/ uaa

« To provide admin privileges to access the Web Admin console and Trend Client:

uaa_config_tool add_user_to_group -u alice -g historian_visualization.admin -t https://webhost. | ab: 443/ uaa

- To provide Configuration Hub privileges, add alice to the group historian_enterprise.admin, using

the previously cached admin secret:

uaa_config_tool add_user_to_group -u Alice -g historian_enterprise.admn -t https://webhost.|ab: 443/ uaa

- To remove alice from a remote instance of Proficy Authentication as an alternative client (that is,

other than adni n) user adni n:

uaa_config_tool renpve_user -u alice -t https://webhost.|ab: 443/ uaa -n useradmin -s MyQt her NonSecr et

* To clear any cached client secret:

uaa_config_tool clear_secret

(o

Note:
If the Windows logon account is not shared, it is not necessary to clear cached secret,
since the cache is encrypted and only the same Windows user account can decrypt.

When there are Historian security groups on the local historian machine or on the domain
server:
1. Create a new user account on the local Historian machine or on the domain server
with same login name and password as the local Proficy Authentication user.
2. Add the new user to the appropriate Historian Security group on the local historian

machine or on the domain server.

-

Create a Proficy Authentication Reader Client

To fetch Historian data, previously, you had to manually add each user to iH security groups. Only then
the users could fetch the data. Now, this process has been simplified. All you must do is create a Proficy
Authentication client. The Proficy Authentication client will be automatically added to the iH Readers
security group on the server side. Therefore, you can use the client to fetch Historian data using REST
APls.
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1. Access the Proficy Authentication Config tool, which is located in the following folder by default:
C\Programfiles\GE Digital\H storian Config\uaa_config_tool
2. Access Command Prompt as an administrator, and then run the following command:

uaa_config_tool add_historian_reader_client -u <client name> -p <client password>

-n <usernane> -s <password> -t https://<Proficy Authentication UR >: 443/ uaa

To create a client named client1:

uaa_config_tool add_historian_reader_client -u clientl -p passwordl23

-n userl -s userpasswordl23 -t https://Proficy Authenticati on UR 2010: 443/ uaa

The Proficy Authentication reader client is created. However, if it already exists, a message
appears, stating the same.

About Accessing Cross-Domain Historian

You can now access Historian across various domains regardless of the domain to which your user
account belongs. To do so:

« Ensure that all the domain controllers across various domains trust one another.

- Create iH security groups on each leaf node that contains the Historian server that you want to
access.

- Ensure that you are part of at least one iH security group. You can be part of an iH security group
directly, or you can be part of a universal domain group, which must be part of the iH security

group.

About Domain Security Groups

When you configure Historian to use domain security groups, the data archiver attempts to locate the
groups on the primary domain controller (PDC) or one of the backup domain controllers (BDC). When
using a PDC, if a primary or backup domain controller cannot be located when the Historian Data Archiver
service starts, access to Historian is denied to all users.

For troubleshooting, .shw file of the data archiver lists all PDCs and BDCs available at the time of archiver

startup. Use this list to verify that the Historian server has visibility into the appropriate domain.

When using a PDC, after the list of Domain Controllers has been established, the Historian Server will

use that list to query for Security Group Membership on an as needed basis. If at any time a request for
Group Membership information is made and the Primary Domain Controller is not available, Historian
selects the first Backup Domain Controller and attempts the same request. If a Backup Domain Controller
successfully responds to the request, the process of querying for Group Membership can stop. Otherwise,
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Historian will attempt to query Group Membership information from the next available Backup Domain

Controller. If no Backup Domain Controller successfully responds, access to the system is denied.

Changing security group configuration from Local to Domain or vice versa requires that the Historian Data
Archiver service be restarted for the change to take effect.

Establishing Your Security Rights

Your security identity is established upon connecting to the server. This occurs through the following
steps:

1. Specifying a user name and password of an account.
Upon connection, the system checks to see if you have a valid Windows 2003 account. If you have
supplied a username and password (through the Excel Add-In for example), security checks that
user. If username and password are not supplied and you are on a Windows 2003 or Windows
2008 machine or higher, security checks the currently logged in user.

o ™
Note:
If you do not pass a domain name the account will be checked locally in the same way a
mapped drive attempt happens. You have to specify a username and password that exists

on the server.
o J

2. Determining group membership of that account.
Once the account is validated, the server determines group membership. For more information on
the process and hierarchy of the groups, refer to the Security Checking Process diagram below.

3. Caching membership profile.
Once the group and tag membership are determined, it is cached for the connection and not looked
up again. If users are added to or deleted from a group, the cache is not updated.
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Note:

The cache information is per connection, and not per IP address. In other words, it is
cached per application and not per system.

Figure 1. Security Checking Process
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* When security groups are defined in Proficy Authentication, the user
must belong to the appropriate group. Not being a part of a specific

group does not, by default, grant full access.
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Implementing Tag-level Security

In addition to defining the iH Tag Admins who have the power to create, modify, and remove tags, you can

also define individual tag level security to protect sensitive tags.

Set tag level security in Historian Administrator. You need the Historian Security Groups to implement tag-
level security. You can use a Windows pre-defined group (power users, for example) or create your own
separate group specifically for this function. For more information on creating and adding groups, refer to
Setting Up Historian Security Groups (on page 276).

Users must have iH Security Admins rights to set individual tag level security, browse, or query tags in
Historian Administrator.

(L N
Note:

Tag security is not enforced in the Trend Client when it comes to browsing the full list of tags.
Security, however, is enforced when it comes to trending data for tags for which you have
permission. For example, if you are logged into the Trend Client as a user that is a member of the
User Group assigned to a tag's security Read Group, you will still be able to browse all Historian
tags. However, you are only allowed to trend the tags for which the user is a member of the User
Group assigned to the tag's security Read Group,

1. Access Configuration Hub (on page ).

2. In the NAVIGATION section, under the Configuration Hub plugin for Historian, select Tags.
A list of all the tags appears.

3. Select the row containing the tag whose security you want to define.
The tag details appear in the DETAILS section.

4. Enter values as described in the following table.

Field Description

Read Group The Windows security group that can retrieve the tag data and plotitin a

trend chart.

For example, if you select a group with power users, in addition to mem-
bers of the iH Security Admins group, only a member of the power users
group will be able to read data for that tag. Even a member of the iH
Readers group will not be able to access data for that tag, unless they
are also defined as a member of the power users group.
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Field Description

Write Group The Windows security group that can write tag data (for example, using
the Excel Add-in for Historian).

Administer Group The Windows security group that can create, modify, and delete the tag.

- M
Note:
o If you are using domain groups (instead of local groups), the Read Group, Write
Group, and Administer Group fields contain only the groups whose names begin
with iH<space> (case-sensitive). Therefore, ensure that the group that you want to
use begins with iH<space>. For more information on the security groups, refer to
Historian security groups (on page 7195).
> If you are using Proficy Authentication, any custom groups that you created must be
defined in Proficy Authentication and added to the group whose names begin with
ih_<group_name>. For more information on the Proficy Authentication groups, refer

to about Proficy Authentication groups (on page 770).
- J

Implementing Data Store-level Security

In addition to defining the iH Tag Admins who have the power to create, modify, and remove tags, the
individual tag-level security, you can also define individual data store-level security to protect sensitive
tags.

Note:

The security settings defined at the tag level, if any, take the precedence over those at the data

store-level.

You need the Historian Security Groups to implement data store-level security. You can use a Windows
pre-defined group (power users, for example) or create your own separate group specifically for this
function. For more information on creating and adding groups, refer to Setting Up Historian Security
Groups (on page 216).

Users must have iH Security Admins rights to set individual data store level security.

1. Access Configuration Hub (on page ).
2. In the NAVIGATION section, under the Configuration Hub plugin for Historian, select Data Stores.
A list of all the data stores appears.
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3. Select the row containing the data store whose security you want to define.

The data store details appear in the DETAILS section.

4. In the SECURITY section, enter values as described in the following table.

Field

Description

Read Group

The Windows security group that can retrieve the tag data and plotitin a
trend chart for the selected data store.

For example, if you select a group with power users, in addition to mem-
bers of the iH Security Admins group, only a member of the power users
group will be able to read data of the tags for that data store. Even a
member of the iH Readers group will not be able to access data of the
tags for the selected data store, unless they are also defined as a mem-
ber of the power users group.

Write Group

The Windows security group that can write tag data for the selected da-
ta store (for example, using the Excel Add-in for Historian).

Administer Group

The Windows security group that can create, modify, and delete the tags
for the selected data store.

Note:

When it comes to the group security, the security settings applied at the tag level, if any,

take the precedence over those at the data store level.

-~

Note:

o |f you are using domain groups (instead of local groups), the Read Group, Write

Group, and Administer Group fields contain only the groups whose names begin

with iH<space> (case-sensitive). Therefore, ensure that the group that you want to

use begins with iH<space>. For more information on the security groups, refer to

Historian security groups (on page 7195).

o If you are using Proficy Authentication, any custom groups that you created must be

defined in Proficy Authentication and added to the group whose names begin with

ih_<group_name>. For more information on the Proficy Authentication groups, refer

to about Proficy Authentication groups (on page 170).

For more information on System Global security settings, refer to access system (on page

).
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Uninstalling Historian

Uninstalling Historian

Uninstalling Historian removes all saved Favorites from your Trend Client and all Users and Scopes you
created. To keep these and other configurations on an upgrade, do not uninstall Historian unless you are
changing server roles as previously described. If you must uninstall Historian on an upgrade, you can

Export your favorites and save your data and tag configuration files for future use.

For information on uninstalling OPC Data Collectors, refer to the Modifying and Uninstalling OPC Collectors

section of the Historian Data Collectors manual.

» When you want to uninstall Web-based Clients:

o If you select the Purge database during uninstall check box, the entire database will be
purged, and you must recreate the Proficy Authentication details, favourites, and so on.
Therefore, if you want to retain Proficy Authentication details, do not select that check box.

o If you have installed Operations Hub on the same machine, and if there is a shared Proficy

Authentication package between Operations Hub and Web-based Clients, in some cases,
a message appears, asking you to first uninstall Operations Hub before uninstalling Web-
based Clients. You can, however, uninstall Web-based Clients first; the shared Proficy
Authentication package will not be deleted in that case.

» Configuration Hub will not be uninstalled because it is a common component. If needed, you

can uninstall it separately.

- If you uninstall Historian after installing the Excel Add-In as described, ensure that you clear the
Historian check box in the Microsoft Excel Add-Ins window. If you do not clear this option, you will

receive an error each time you open Microsoft Excel.

1. To uninstall Historian from your computer:
a. Double-click the Programs / Uninstall a Program link in the Control Panel.
b. Select Historian and select Uninstall.

Note:

Historian archives are not removed by default. If you need to remove them, delete

the folder manually.
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A progress bar appears, showing that the software is being uninstalled. This may take some
time.

To abort the uninstall, select Cancel.

2. To remove all related software from your computer:
a. Double-click the Programs / Uninstall a Program link in the Control Panel.
b. Select Proficy Common Licensing, and select Uninstall.

Troubleshooting

Managing Historian Log Files

Use the Historian LogTool to view, generate, or compress log files to use for troubleshooting.
Logt ool . exe is located in the historian installation directory, for example: C:\ Progr am Fi | es\ Prof i cy
\ Proficy Historian\X64.

1. Go to your installation directory and execute the Logt ool . exe file.
The LogTool appears, displaying the View Log section.
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% Proficy Historian - LogTool

View Log |Generate Logs | Gather Logs |

This kab allows you ko view the log Fies of the installed Historian components.

Log File Path |c:1ﬁ~:&v|-ﬁmimuatatmﬁes
Irstalled Components: Avalable Loghles:

CalculationColectar Dot adirchiver-01.Jog
Datafwchiver-02 Jog
FileColiactor Dt adirchiver-03.Jog
SmulationColector Datafnchiver-04.Jog
Datafechiver-05.4og

Datakd‘h’et-[li-.E

Diatadirchiver-08.Jog
Diatadirchiver-09.Jog
Datadnchiver-1.5hwe
Dt afinchiver-2.shw
Dataiinchiver.shw

2. Select a component from the left panel to see the available log files, and select View Log.
3. Select Generate Logs to enable or disable the debug logging mode for Historian components:

This tool will enable/Disable the debug mode for Historian components. However, leaving the
debug mode enabled for longer time consume the disk space

1.Select the component
2.Choose enable/disable option

3.Select apply
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& Proficy Historian - LogTool

‘Wiewlog GenerateLogs | Gather Logs |

“Enable/Disable Debug Mode -
This tab allows you bo enabledisable the debug logaing mode for Histarian Components,
WARMING: leaving debug mode enabled For hours or days will cansume disk space,

To enablefdisable the debug made:

#1 Select the component

#7 Choose enablefdisable option

#3 Click Apply.
~Historian Composnents

[ |Dakadrchiver
[ |CalculationColleckor

i ation oo o]
(¥ Enable " Disable

Apply

a. Select a Historian Component and select Enable or Disable.

Note:

Leaving debug mode enabled for a component consumes disk space.

b. Select Apply.
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4. Select Gather Logs and select Zip the log files to compress the log files and select Open zip file

location to view the zip files.

% Proficy Historian - LogTool

View Log I Generate Logs Gather Logs

This tab allows you ta zip all the Historian logs.

The zip file will be in the logfiles directory.

Zip the log Files |

Open zip file location I

Troubleshooting the Historian Server

iFIX-Related Files in C Drive Even if iFIX is not Installed
Description

If you install only Historian without installing iFIX, you may find some iFIX-related files in the
C drive.

Workaround
You can ignore/delete them. If, however, you plan to install iFIX later, you must reinstall
Historian Client Tools after installing iFIX.
Error Message when Upgrading the Historian Server on a Passive Node in a Cluster
Description

If you are upgrading the Historian server on a passive node, an error message may appear
behind the installer screen, stating that the Archives directory is not created.

Error Message
Unable to create Archives directory.

Workaround
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You can ignore this message, or you can make the node active before upgrading the
Historian server.
Historian Server Rejects Collector or Client User Credentials
Description

If a client or collector is attempting to connect to the Historian server with strict
authentication enabled on a Kerberos configuration, the server rejects valid credentials and
does not allow the connection.

Workaround

Ensure that the server time and the domain controller time match with each other.

Historian Resource in a Cluster Environment is not Online
Workaround

Ensure that the cluster feature is included in your license.

Historian Resource Runs for a Long Duration and Fails Over
Workaround
Debug the log messages of the Data Archiver and the Clusters before taking appropriate
actions.
While Label Error
Description

If the PFX file that you want to use with Historian does not contain a full-chained certificate,

a while label error message appears.

Workaround

1. Create a PEM file from the PFX file by copying the content from all the certificates
(such as root, intermittent, and leaf certificates) to the PEM file. It results in a full-
chained certificate.

2. Get a KEY file from the vendor. Or, use a KEY file extracted from the PFX file using
the Certificate Management tool. To do so, import the PFX file. The certificate
and the KEY file will then be available in the <Oper ati ons Hub installation
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| ocati on>\ ht t pd\ conf\ cert folder. You can then use the ser ver . key file in
the folder.

3. Using the Certificate Management tool, import the PEM and KEY files to the
machines on which the Historian server, the Operations Hub server, and clients are
installed.

Troubleshooting Web-based Clients

Unable to Access Configuration Hub After Upgrading Web-based Clients
Description
After you upgrade Web-based Clients, you cannot access Configuration Hub.
Workaround

Clear your browser cache.

Error Occurs When You Try to Access Web-based Clients
Description

If you have logged in to Operations Hub, and then if you try to access Web-based Clients,
and vice versa, an error occurs. This is because the user credentials of the first application
to which you have logged in are used to log in to the other one as well.

Workaround

Try one of the following steps:

- Add the scopes of each application user to the other application.

- If you log in to Web-based Clients first, on the login page of Operations Hub, re-
log in with the Operations Hub user. If you log in to Operations Hub first, log out of
Operations Hub, log in to Web-based Clients, and then log in to Operations Hub, using

the credentials of the respective users for each application.

Unable to Access Web-based Clients
Description

When you upgrade Historian, after installing Web-based Clients, a message asking you to
restart the machine does not appear. Because of this, sometimes, you cannot access Web-
based Components such as Configuration Hub, Trend Client, the Web Admin console, and
REST APIs.

Workaround
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Restart the machine, or start the following services:

« Proficy Historian PostgreSQL Database

« Proficy Historian Tomcat Server

* Proficy Operations Hub Httpd Reverse Proxy
« Proficy Authentication PostgreSQL Database
« Proficy Authentication Tomcat Web Server

Certificate Issues When Trying to Log in
Workaround

Connect to a Remote Proficy Authentication Service (on page 121)

Web-based Clients are not connected to the Historian server

Workaround

« Ensure that the Enforce Strict Client Authentication and Enforce Strict Collector
Authentication options are disabled in the Data Stores Security section in Historian
Administrator.

« Ensure that the Proficy Authentication URL used by Web-based Clients matches
the one you provided while installing the Historian server. If not, change the Proficy
Authentication server (on page 76) so that the Historian server points to the same

Proficy Authentication server as Web-based Clients.

Clients or Users Not Created
Description

Clients or users are not created because the required services were not running during the

installation of Web-based Clients.

 An error message appears when you access Web-based Clients or Trend Client.

- The visualization client is not found. The following error message appears: No client
with requested id: historian_visualization

- When you attempt to log in to Proficy Authentication, a message appears, stating that
the credentials are incorrect.

Workaround

Configure Web-based Clients (on page 125) to point to a different Configuration Hub and
Proficy Authentication instance.
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The Reverse Proxy Service Stops Working
Description

If you install iFIX on a machine that has Historian Web-based Clients, the reverse proxy

service stops working.
Workaround

Restart the reverse proxy service - Proficy Operations Hub Httpd Reverse Proxy.
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